
Duxbury Braille Translator Manual



Welcome to DBT! 

Thank you for choosing the Duxbury Braille Translator! DBT has several types of on-line help. 
This help system is the standard for Microsoft Windows XP and later. 

Before we proceed, you may wish to adjust the size of text displayed here. 

If you have a wheel mouse, click anywhere in this topic, hold down the Control key, and roll the 
mouse wheel backwards and forwards to increase or decrease the font size to an acceptable 
level. 

If you do not have a wheel mouse, the text size can be adjusted via the "Text Size" option in 
Internet Explorer's View menu. 

Note also that if you wish to print a Topic, your selected text size will be reflected in the printed 
output. 

Learn how to use this help system  

Guidelines for the Use of Braille Translators 

One of the most important, and perhaps obvious, things to watch out for when producing 
braille, is using the correct Language Translation Tables. An English document, translated using 
French braille rules would produce a very strange form of braille. 

But even an English document has its own National Braille Table. 

BANA has an excellent set of general guidelines for the use of braille translators, entitled 
"Guidelines for the Production of Braille Materials Through the Use of Braille Translation 
Software," available on its web site at: 

http://www.brailleauthority.org  

Many pointers given there are applicable generally, not only in BANA countries. 

BAUK also publishes various material relating to English/British braille. You can find more 
information on BAUK at http://www.bauk.org.uk. 

In general, whenever it is important that the braille be of high quality according to applicable 
standards -- which is in most instances, especially for educational or other public uses -- a 
qualified person should proofread or otherwise monitor the braille for translation accuracy and 
appropriate format. Without such monitoring, it is possible for many factors to adversely affect 
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the quality of automatically translated braille, especially if the content or format is at all 
complex. 

A Braillist's Pledge of Professional Ethics 

I pledge to: 

 prepare braille materials in an accurate, timely manner, without personal interjection,  

 refrain from using any information obtained in the performance of my duties in a manner that 
would be detrimental to the agency or person for whom the material was transcribed,  

 treat all material transcribed as confidential unless the material is publicly available or an 
agreement has been obtained in writing that the information may be disclosed,  

 conduct business in a professional manner with dignity, respect and courtesy,  

 accept assignments as dictated by my knowledge of the subject matter, braille skill competency 
level, and ability to complete the assignment on a mutually agreed upon date, and  

 continuously develop the highest levels of knowledge and skills through professional 
development in my chosen specialty.  

--Adopted by the National Braille Association, November 2003 

Keyboard Shortcuts 

A keyboard shortcut, also known as an accelerator, allows you to trigger an action without 
stepping through the menus with the normal menu keys. Listed below are DBT's shortcut keys: 

Function Keys 

F1 = The Help Key 

F2 = View, Six + Key Entry (Braille file only) 

F3 = File, Save As 

F4 = Layout, Left Margin, 3 

F5 = Layout, Code List 

F6 = Edit, Replace 

F8 = Layout, Styles 



F9 = Insert Code 

F10 = Activate Menu Bar 

F11 = Edit, Find Misspelling 

Alt + F2 = Layout, Character Codes, Hard Space 

Alt + F3 = View, Codes 

Alt + F4 = File, Exit 

Alt + F7 = Layout, Line Codes, Flush Right w/Leader 

Ctrl + F4 = File, Close 

Ctrl + F5 = View, Print Font (Braille File) 

Ctrl + F6 = View, Braille Font (Braille File) 

Ctrl + F7 = View, SimBraille Font (Braille File) 

Ctrl + F8 = View, Translated Line (Braille or Print File) 

Ctrl + F9 = Insert Style 

Ctrl + F11 = Document, Embosser Setup 

Ctrl + F12 = Document, Printer Setup 

Shift + F1 = Layout, Line Codes, Single Spacing 

Shift + F2 = Layout, Line Codes, Double Spacing 

Shift + F4 = Layout, Right Margin, 6 

Shift + F6 = Layout, Line Codes, Centering 

Shift + F7 = Layout, Line Codes, Flush Right 

Shift + F11 = Edit, Spell Check (Print File) ( Checks from cursor downwards) 

Character keys 

Alt + 0 = Layout, Translation Codes, Grade 0 



Alt + 1 = Layout, Translation Codes, Grade 1 

Alt + 2 = Layout, Translation Codes, Grade 2 

Alt + 3 = Layout, Translation Codes, CBC 

Alt + 4 = Layout, Translation Codes, Spanish Text 

Alt + 5 = Layout, Translation Codes, LIFG Text 

Alt + D = Document menu 

Alt + E = Edit menu 

Alt + F = File menu 

Alt + G = Global menu 

Alt + H = Help menu 

Alt + L = Layout menu 

Alt + V = View menu 

Ctrl + A = Edit, Select All 

Ctrl + B = Layout, Character Codes, Group 

Ctrl + C = Edit, Copy 

Ctrl + E = File, Emboss 

Ctrl + F = Edit, Find 

Ctrl + G = Edit, Goto (Not applicable in Coded View) 

Ctrl + H = Edit, Highlight 

Ctrl + I = Edit, Find Again 

Ctrl + K = Layout, Line Codes, Skip Line 

Ctrl + L = Layout, Line Codes, New Line 

Ctrl + M = Layout, Line Codes, New Paragraph 



Ctrl + N = File, New 

Ctrl + O = File, Open 

Ctrl + P = File, Print 

Ctrl + R = Layout, Runover Offset, 3 

Ctrl + S = File, Save 

Ctrl + T = File, Translate 

Ctrl + V = Edit, Paste 

Ctrl + X = Edit, Cut 

Ctrl + Y = Redo 

Ctrl + Z = Undo 

Other keys: 

Alt + Right Arrow = Layout, Style Level + 

Alt + Left Arrow = Layout, Style Level -  

Alt + Enter = Layout, Page Codes, New Reference Page 

Ctrl + Enter = Layout, Page Codes, New Page 

Shift + Arrow keys = Highlight text 

Ctrl +Shift + Down Arrow = Select from cursor to end of paragraph 

Installation 

If you are reading this, there is a very good chance that you have installed DBT already. 

However, you may at some later stage wish to make changes, or perhaps re-install to one or 
more additional systems. 

This section therefore provides details of the various options available to you. 

DBT supports these three types of installation: 



1. Simple Installation is nearly automatic, and is sufficient for the needs of most users.  

2. Custom Installation allows a greater degree of control over the installation, but in practice 
should be seldom needed.  

3. Network Installation allows network support personnel to easily install and maintain multiple 
DBT installations through a network.  

To get started, simply choose, from the list above, the type of installation that fits your needs, 
click the link and start reading. If you're unsure which to try, we strongly recommend Simple 
Installation. 

Related Topics: 

  End User License Agreement (EULA) The EULA is a legal agreement between you and Duxbury 

Systems, Inc.  

  Removing DBT How to use the Control Panel to Remove DBT (should that be neccesary)  

Removing DBT 

The procedure for removing DBT from your system is done via Windows' Add/Remove 
Programs accessible from the Control Panel. 

Provided you are connected to the Internet, (without firewall restrictions) the removal process 
will normally adjust your activation count, ensuring that you can activate later on another 
system. 

In the event you are NOT connected to the Internet, a text file will be placed on your desktop 
with de-activation information.  

 

This file may be e-mailed or faxed to Duxbury Systems whereupon your License count will be 
adjusted accordingly.  

Registration and Activation 

Please note that these are two distinct processes which must be done in sequence. 

We would also stress that should you wish to remove DBT from a system, perhaps to install it 
on another or to reformat the existing system, DBT should be properly de-activated as 
explained in the "Remove DBT" Topic. 

1) Registration: 
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Before you can activate DBT, you MUST Register the software. This is easiest done via DBT's 
Help: Registration form and will pre-populate the form with your License Number. If you have 
an Internet connection, you may send the form direct to Duxbury Systems. If not, you may fax 
the form to the fax number provided in the Welcome to DBT: About Duxbury Systems topic. 

Help: Registration... 

Keystroke: r (from menu) 

We cannot stress enough the importance of Registering your copy of the Duxbury Braille 
Translator. Amongst other benefits, this will ensure your eligibility to receive free updates via 
the Internet.  

If you wish to register on line now please click the Registration item in DBT's Help menu. 

If you do NOT have an Internet connection, you may use the form provided at Installation: 
Registration Form. 

 

2) Activation:  

If you have not yet activated DBT, each time you run the program, you will see an "Activate" 
button at the bottom right hand side of the initial splash screen. To begin the activation 
process, click on this button. 

Activation 

There are two places you may Activate from. The first is the initial splash screen which appears 
when you run DBT.  

The second is from the Help: About DBT... dialog. 

When you click on either "Activate" button, the following dialog will appear. Select an 
appropriate radio button. Your choice essentially depends on whether or not you have an 
Internet connection. 

The Activation Wizard will lead you through the process of activating DBT on your computer. It 
works most easily through an internet connection, but will offer you other ways to activate if 
you do not have, or cannot use, your internet connection.  

The Activation Wizard may prompt you for software registration information (your contact 
information) along the way. 
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Keyboard: e from Global menu. 

(Advanced Users - See also Editing the emb.elt file.) 

This module is purely to enable you to set up one or more embossers on your system, and to 
allow you to specify a default embosser for all new documents. If you wish to change the 
embosser or its settings for an individual document, (new or existing) you MUST do this in 
Document: Embosser Setup. 

The Global: Embosser Setup dialog is used to tell DBT about your braille embosser. You must 
normally have at least one embosser (Brailler Device) set up on your system, but you may now 
have as many devices as you like. See Additional Notes at the end of this topic for more 
information. 

Brailler Device: (Selection/List box) During the DBT installation process, you may have chosen 
to install one or more embossers. If so, they will appear in this list. If the list only contains "(No 
Target Embosser)", and you wish to set one up, tab to the "New" button, and press Enter. 

New: This button will take you to the Embosser Setup: General Tab, which is one of three tabs 
where you may begin the setup process. (If you are setting up a new embosser, may we suggest 
you click on the above link now.) 

** Modify Embosser: Before you click this button, please ensure that you have highlighted the 
embosser you wish to edit in the Braille Device selection list. This button will also take you to 
the Embosser Setup: General Tab. 

** Remove: If you wish to remove an Embosser Device, please ensure it is highlighted in the 
Brailler Device list first, before pressing the "Remove" button. [Note: You cannot remove the 
"(No Target Embosser)" entry. ] You will be asked to confirm that you wish to remove the 
selected embosser as shown below. Press the "Yes" or "No" button as appropriate. 

Note: If you remove any Brailler Device, DBT sets the Brailler Device to "(No Target Embosser)". 
In such circumstances, you will only have the Characters per line and Lines per page options 
available.  

There are however limitations in so much as you may only select between 10 and 160 
Characters per line, and between 4 and 40 Lines per page. 

 

(** The "Modify Embosser" and "Remove" buttons will be disabled if a user will be unable to 
save changes to the configuration. So, restricted users in Windows XP will find that these 
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buttons will often be disabled. In Vista, they will often be disabled if a user has not run DBT 
"As Administrator".) 

 

Desired Braille Document Formatting - This section contains 8 controls. However, it is 
important to appreciate that entries here may be constrained by settings in the Global: 
Embosser Setup - Device Settings tab. For example, if you have set up a Top Margin of 2 in 
Device Settings, you cannot have a Top Margin of less than 2 in this section. 

Characters per line: Enter your desired characters per line, excluding the binding margin. 

Lines per page: Enter your desired lines per page, excluding the top margin. 

Top margin in Lines: Enter your desired top margin in lines. 

Binding margin in characters: Enter your desired margin in characters. 

Now we have three check boxes which may or may not be grayed out. Availability of these 
items is controlled by capabilities of your selected embosser. 

Emboss in Interpoint: This will only be available if your embosser supports Interpoint (or 
double-sided) embossing. 

Banner Page: This is an additional page which is embossed at the beginning of each file your 
emboss giving basic file information. 

Interline Print: This will only be available if your embosser supports Interline Printing or if you 
are using the TranSend SE 

 

If you are satisfied with your changes, press the OK button. If you wish to abort this process and 
return to DBT, press the Cancel button. 

Please note that pressing OK is this main dialog not only confirms any changes made 
to this dialog, but also any made to the General, Devices Settings and Advanced 
dialogs. 

Take special care to ensure that you have highlighted the Brailler Device which you 
wish to be your default for any NEW documents created. 
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Additional Notes: Remember that DBT's files now contain "Sticky Document Information". In 
simple terms, when you save a file, it also saves a variety of details, such as your Brailler Device. 

Templates also contain this "Sticky Document Information". If you commonly work with two or 
more paper sizes, we recommend that you generate a template for each paper size. 

Setting Up Your Embosser. 

If you do not have a braille embosser, this section can be skipped -- but you should still visit the 
later "Global: Embosser Setup" section to set desired page sizes. 

DBT is designed to ork with recent embosser models set to their factory default settings. The 
following instructions are provided to help you work with embossers that are older or that have 
been in use for a time and may no longer be set to factory defaults. 

In general, follow the manufacturer's instructions for setting up and connecting your braille 
embosser. Make a note of all the embosser's settings, and favor the following choices when 
available: 

1) Select "USA" or "North American" code (perhaps called "language") for braille equivalence. 

2) Turn off any "grade 1" or other translation options that do not preserve a strict one-for-one 
equivalence. On some setup menus, you might do this by selecting "computer braille." 

3) Turn off any "word wrap" or "auto wraparound" option. 

4) Turn off any "auto carriage return" option. 

5) Turn off any "auto line feed" option. 

6) Set the page depth (in lines per page) and width (in cells per line) at their maximum available 
values, or at least as great as the size of the pages you wish to generate. 

7) Select 6 dots per cell. 

8) It is recommended that you set up your embosser as a normal Windows printer. This is 
usually done through the "Add Printer" facility within "Printers" in the Control Panel, or 
equivalently in Start > Settings > Printers. Generally, unless specifically instructed otherwise by 
the embosser manufacturer or dealer, you should choose the "Generic - Text only" driver. 

Note: When adding a Windows printer, you will be prompted for a name. To avoid confusion 
with normal ink printers, we suggest you use a descriptive name such as "Braille Printer". 

Braille Embosser Manufacturers: 
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Please note that you should contact your supplier or manufacturer if you require a manual or 
specific technical assistance for your braille embosser. Click here for a list of embosser 
manufacturers. 

Global: Embosser Setup: General. 

When you select "New" from the Global: Embosser Setup dialog, you will be presented with the 
following dialog. 

This dialog contains four tabs. "General", "Device Settings" "TranSend SE" and "Advanced". 

Embosser Model: This is a drop-down list containing an alphabetic listing of all supported 
makes and models of braille embosser. Note however that Generic embossers are at the top of 
the list. 

If your embosser is not listed, then select "Generic" if your embosser embosses on just one side 
of the page, or "Generic Interpoint" if it embosses on both sides of the page. 

Setup Name: You may leave this field blank, in which case, DBT will simply use the name of the 
embosser you selected above. However, you may type in a free-format name of your own 
choice. (See Additional Notes for more information) 

Configuration Location: A drop down list with two choices a) The current user, or b) All users of 
this computer. 

Network administrators should be aware that "Current User" essentially stores this 
configuration on the User's Profile. Hence care should be taken if Roving Profiles are in use. If 
you are setting up a model installation for replication throughout a network using a network 
installation image, then you should set the Configuration Location for all embossers to "All users 
of this computer". DBT's installer supports automatic migration of embosser configurations set 
this way, using a network installation image. 

 

Output Options - here you have one choice out of 3 Radio Buttons 

1. Send to Printer: If you have installed your braille embosser as a Windows Device, or to 
use Windows drivers, you should normally find it listed here. (You can use this option 
only if your braille embosser shows up among the printers in Windows' Printers Control 
Panel.)  

2. Write to Port: If your embosser is not listed above, you may select a Parallel Port (lpt#), 
or Serial Port (com#) from the list box.  
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3. Write to File: There are occasions when you may wish to braille embossing output direct 
to a file. Normally you should leave this field blank, in which case you will be prompted 
for a file name each time you emboss using this Brailler Device. Otherwise you may 
enter a path and file name as appropriate.  
You should also be aware that if you specify a file name, the file will be overwritten 
without prompting, therefore you should only specify a file name in exceptional 
circumstances.  

 

Serial: This section will be grayed out unless you have selected a Serial (com#) device. Enter the 
parameters for Baud Rate, Parity, Data Bits and Stop Bits and Handshaking as required. 

If you are using a Serial Device, please consult your manual or supplier for appropriate details. 

 

Global: Embosser Setup: Device Settings 

When you select Device Settings from the quad-pane window, the dialog may not appear as 
shown in the example below. There is a simple explanation for this. 

What appears is entirely dependent on which Brailler Device you have selected in the General 
tab. 

For many modern embossers, little or nothing appears in this panel. This simply means that DBT 
doesn't need additional information to drive your embosser correctly. 

In the example shown below, we have an Enabling Juliet Pro 60 with the “Left Margin (first 
cell):” set at 1, the "Rightmost cell placement:" set at 40 and the "Top margin setting:" set at 0. 
These are the factory default settings for the embosser that will produce a 40 character line.  

Allow escape codes - checking the "Allow escape codes" check box allows you to temporarily 
override some of your embosser settings using the settings from Document: Embosser Setup 
(Ctrl-F11). 

Interpoint Embossing is Enabled - checking the "Interpoint Embossing is Enabled" check box 
tells DBT that your using an interpoint embosser. This checkbox enables special pagination 
control for interpoint embossers. 

This dialog contains four tabs. "General", "Device Settings", “TranSend SE” and "Advanced". 

Allow escape codes - checking the "Allow escape codes" check box allows you to temporarily 
override some of your embosser settings using the settings from Document: Embosser Setup 
(Ctrl-F11). 
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Manage ET Speaks - checking the "Manage ET Speaks" check box allows you to silence the 
speaking of escape sequences. 

Leave ET Speaks On - checking the "Leave ET Speaks On" check box allows you to force speech 
at the end of a document. 

Send Seek Top of Form - checking the "Send Seek Top of Form" check box allows DBT to send 
an automatic top of form control to supported embossers. 

This dialog contains four tabs. "General", "Device Settings", “TranSend SE” and "Advanced". 

Global: Embosser Setup: Advanced. 

When you select "Advanced" from the Tri-pane window, the following dialog will appear. 

WARNING: Do not make any changes to this dialog unless you know precisely what you are 
doing! 

With the vast majority of Brailler Devices, you will not require to make any changes to this 
dialog unless specifically advised by either Duxbury Systems Inc. or your embosser 
manufacturer. 

However if you are faced with a device which is unlisted or unknown to DBT, you may find this 
useful in some areas. 

Return to Embosser Setup Topic (or continue at your peril!) 

This dialog contains four tabs. "General", "Device Settings" "TranSend SE" and "Advanced". 

Job Setup - checking the "Use custom job setup" check box allows you to enable "Job start 
codes" and "Job end codes", described below. 

Job start codes: Text that you type here will be sent to the embosser after any setup sequence 
(e.g. escape codes) that DBT normally sends when starting to emboss. The additional text that 
you add to the setup sequence may be used for any purpose. However, it is best to avoid using 
this feature to redefine the form length, the braille cell size, or the interline spacing of the 
braille. Any change to these characteristics will not be recognized by DBT, and so DBT will not 
create a document properly formatted for the page. Text that you type here may be any 
printable ASCII character (including space, but excluding less-than and greater-than), or any of 
the following special sequences:  

 <esc> Escape (ASCII 27)  

 <lf> Line Feed (ASCII 10)  
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 <ff> Form Feed (ASCII 12)  

 <cr> Carriage Return (ASCII 13)  

 <ctrl-@> NUL (ASCII 0)  

 <ctrl-A> Control-A (ASCII 1) 
...  

 <ctrl-Z> Control-Z (ASCII 26)  

 <lt> Less-than (ASCII 60)  

 <gt> Greater-than (ASCII 62)  

Job end codes: Text that you type here will be sent to the embosser before any job-ending 
sequence (e.g. escape codes) that DBT sends on its own. Text may contain the same ASCII 
printable characters and special sequences as are defined for Job start codes. Job end codes are 
often left blank even when Job start codes are used. 

A user of the Gemini embosser might enter <esc><esc>Q to enable double-sized interline print 
and/or <esc><esc>D to enable double-striking of the braille. Note that neither of these changes 
affects the form size or the layout of the braille on the form. 

 

End of line and page - These options control what device Control Codes are produced at the 
ends of lines and pages. 

End of line indicator: Normally DBT will send a CR/LF Control Code at the end of each line. 
However, if you have opted to Write to file, with a view to processing that file on a non-
Windows or non-DBT system, you may make an appropriate selection here. 

End of page indicator: As with End of line indicators, you may wish to select a more suitable 
option here. 

EOL on a full line: Check this box if you wish to add an End of Line Code even when the line 
contains as many braille cells as the embosser will support. Many embossers automatically skip 
to the beginning of the next line in this circumstance, so it can be important to leave this option 
un-checked. 

EOP on a full page: Check this box if you wish to add an End of Page Code even when all 
possible lines contain braille. Many embossers automatically skip to the top of the next page in 
this circumstance, so it can be important to leave this option un-checked. 
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Pad lines: Some devices need to see at least a few characters on each line. Checking this box 
will therefore cause spaces to be added at the end of any lines that are blank or very short.  

Prompt for new sheet: Checking this box causes DBT to pause after each page has been sent to 
the Braille Device. This can be useful if for any reason you have to feed each page of material 
manually into the device. 

 

Timing: This is a highly technical area, but basically it controls how long DBT waits after sending 
a text character or control character. It is enabled only when "Write to Port" is selected in the 
General tab. DBT normally maintains Timing values as is appropriate for the device and port you 
select; you should only change these values if you are having extreme difficulty interfacing a 
device. 

 

Global: Autosave Options 

Keystroke: a from Global menu. 

By default, Autosave is turned on in DBT and defaults to 5 minute intervals. Essentially this 
feature will save files which you have opened, and made changes to, at pre-determined 
intervals. The dialog which appears as show below is relatively simple, with just three options. 

Enable autosave: is a checkbox. If you do not wish to use the Autosave feature, uncheck this 
box. 

Path for unsaved files: By default, autosaved files will be stored in your My Documents folder, 
within a folder called "DBT Autosaves". If you wish these files to be saved elsewhere, you may 
provide an alternative path. 

Note: "DBT Autosaves" is a Hidden Folder, and cannot normally be seen within My 
Documents unless you have elected to show hidden files on your system. 

Autosave every (mm:ss): The default setting is 5 minutes, however you may enter a longer or 
shorter period as required. 

 

For details of how to use the Recovery Wizard to recover files, please see the next topic: 
Autosave Recovery Wizard 
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Windows Display Properties. 

Please also note that what follows is specifically a Windows function, and technically not part of 
the DBT application software. 

All dialog Boxes within DBT are now fully Windows compliant. That is to say that certain aspects 
may be customized to suit individual user's preferences through settings in Display Properties, 
found in the Windows Control Panel. It is not our task here to provide lessons in the use of 
Windows, however the following brief description of changing font size, may provide food for 
thought. 

In order to do this, go to the Windows Control Panel, and select "Display". (Alternatively, place 
your mouse pointer on a blank area of the Desk Top, right click, and select "Properties".) 

Now click on or navigate to the "Appearance" Tab. When this is displayed, left click on the 
"Advanced" Button. 

Click on the "Item:" List Box, and select "Message Box". You may also select Font, Size, color of 
font, and whether you want the font bold and/or Italicised. 

But please remember: 

1. This is a Windows function, and therefor technical support for this feature is not part 
of DBT's normal remit.  

2. This will affect other dialog boxes in other applications on your system.  

3. Do not make major changes at one time, for example going from Size: 8 to 32, as this 
can have unexpected results in what you see on the screen.  

Setting up your printer. 

In Windows: 

If you have a printer (for ordinary print, not for braille), it should be set up in the normal way as 
a Windows printer. This is usually done through the "Add Printer" facility within "Printers" in 
the Control Panel, or equivalently in Start > Settings > Printers, choosing the driver that 
matches the printer as supplied by Windows or the printer manufacturer. 

In DBT: 

Please click on the following link for detailed instructions on setting up your printer in DBT 

Global Menu - Printer Setup  
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Note: Remember that this topic refers to your "Ink printer"  

For information about setting up your braille embosser, see Global: Embosser Setup. 

Document and Global: Printer Setup... 

Keyboard: Ctrl + F12 for Document, or from p from Global menu. 

It must be emphasised that this option only affects new documents, or those which are pre DBT 
10.5. To make changes to the CURRENT document, you MUST use DOCUMENT: Printer Setup.  

 

When you select this option, the following dialog will be displayed. 

Before making adjustments, be aware that there are two likely situations where you may want 
to "print" a document. (As opposed to embossing it) 

The first is to obtain a copy of your text document, and the second to obtain a print copy of 
your braille document. In the case of the latter, (often used by sighted braille proof readers) 
you need to take special care when setting up the Formatted Page Size. 

Global: Default Views... 

Keystroke: d from Global menu 

Each setting in this dialog corresponds to a setting in the View menu. When a new document is 
created, by using File, New, importing a document, or translating an existing document, the 
state of the View menu is derived from the settings here. Some of these settings apply only to 
print documents or only to braille documents. Whenever you open a document that was 
previously saved in DBT, the View menu is set as it was when the document was saved. The 
settings in this dialog affect only newly-created documents. 

Any setting here can be changed for an individual document via DBT's View Menu. 

Font for Translated Braille Line: This choice of 3 radio buttons for what is displayed in a line 
displayed at the foot of the screen, and can be "Print", "Braille" or "SimBraille". You can select 
whether or not this line is displayed by default in DBT, or you can toggle it on or off within the 
program with the command Ctrl + F8. 

Show full page in print documents: Check this box if you always wish to see the whole print 
page on your screen. Please bear in mind that what you actually see is largely dependent on 
what your PC's monitor can display. 
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Show codes in print documents: Check this box if you wish to display DBT's codes by default. 
This is more useful for experienced users. 

Show translated line in print documents: Check this box if you wish to display the translated 
line at the bottom of the DBT screen. This will then display an appropriate translation of the 
print line your cursor is located on. See Important Note below. 

Default font for braille documents: This choice of 3 radio buttons what is displayed in a line 
displayed at the foot of the screen, and can be "Print", "Braille" or "SimBraille". You can select 
whether or not this line is displayed by default in DBT, or you can toggle it on or off within the 
program with the command Ctrl + F8. 

Show full page in braille documents: Check this box if you always wish to see the whole print 
page on your screen. Please bear in mind that what you actually see is largely dependent on 
what your PC's monitor can display. 

Show codes in braille documents: Check this box if you wish to display DBT's codes by default. 
This is more useful for experienced users. 

Show translated line in braille documents: Check this box if you wish to display the translated 
line at the bottom of the DBT screen. This will then display an appropriate translation of the 
braille line your cursor is located on. See Important Note below. 

Six key entry in braille documents: Check this box if you wish the default typing mode to be six-
key entry. That is, using the keys f d s and j k l as dots 1 2 3 and 4 5 6 to enter text. (Subject to 
suitable keyboard) 

Important Note: The translated line is provided primarily as a general guide for forward and 
backward translation of literary braille. It should not be assumed as definitive output. 

 

Global: Fonts... 

Keystroke: f from Global menu 

This dialog allows you to select default screen and printer font and size. 

There are 8 controls in this dialog. 

1. Print Font: A list Box which allows you to select which font you wish to use when you 
print a DBT document. Note that only fixed space fonts are listed here.  

2. Print font size for screen display: Text Box. Enter the point size you wish displayed for 
screen print matter.  
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3. Braille/SimBraille font point size for screen display: Text Box. Enter the point size you 
wish displayed when either Braille or SimBraille font are displayed on the screen  

4. Auto-determine point size for output - Check box. If this box is checked, DBT will 
automatically re-size any ink printed text or Braille. If checked, the next two items will 
not be available to you  

5. Print font point size for printed output: Text Box. Allows you specify the size of font 
used in printed DBT text documents  

6. Braille/SimBraille font point size for printed output: Text Box. Allows you to specify the 
point size of ink printed braille. Note: 24 point is close to actual size  

7. Cancel. Button. Click button or press Esc to exit this dialog without making changes.  

8. OK. Button. Click or press Enter to confirm your changes. The dialog will now close.  

 

Global: Shortcut Preferences... 

Keystroke: s from Global menu. 

This option should generally be left as shown above. 

It has been provided to resolve a specific situation relating to a particular International version 
of DBT. 

The purpose of this option is to allow for variations in the codes inserted for the various 
shortcut keystrokes listed in the dialog below: 

The defaults for English are: 

Insert for Grade 0 = (Alt + 0) which generates the code [cz] 

Insert for Flush Right with Leader = (Alt + F7) which generates the code [fr;p~".] 

Insert for Computer Braille = (Alt + 3) which generates the code [cb] 

Insert for New Line = (Enter) which generates the code [<] 

Insert for New Page = (Ctrl +Enter) which generates the code [pg] 

If you wish to find out more about what these codes do, please refer to the alphabetical listing 
of codes in DBT Codes Quick Reference and subsequent "Tell me more" buttons. 
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Global: WordPerfect Importer... 

Keystroke: w from Global menu 

The WordPerfect Importer dialog tells DBT how to import WordPerfect coded files. There are 
seven controls.  

First is a check box to optionally translate any Courier text into CBC. Use this feature with 
caution; if Courier happens to be the default base font, the entire document may come out in 
CBC instead of grade 2.  

Next is a check box to force a new braille page wherever a hard page break exists in the print. If 
you are highly concerned with paper conservation, leave this option unchecked. Otherwise, 
check the box so that your print and braille formats more closely resemble each other.  

Third is a check box to reduce three or more hard returns in the print so that only one skipped 
line appears in braille. It is not customary to have more than one blank line in braille so you will 
generally want to keep this box checked.  

Fourth is a check box to tell DBT that you wish to indicate print page breaks with a line of dots 
across the page. Be sure to use this feature when producing a braille document in Textbook 
format.  

The next control has four choices for paragraph style. DBT will automatically create a braille 
paragraph (a new line with indent to cell three) whenever it comes across the pattern you 
choose. Choices are (1) None -- DBT formats the braille the same as the print, (2) Skipped Line -- 
DBT converts [HRt][HRt] to a braille paragraph, (3) Newline Tab -- DBT converts [HRt][Tab] to a 
braille paragraph (4) Skipped Line with Tab -- DBT converts [HRt][HRt][Tab] to a braille 
paragraph.  

Next is a text box control to enter a number representing the ratio of braille cells to either 
inches or centimeters. DBT will use this number to honor WordPerfect's Tab and Indent 
commands by converting them into braille characters.  

The last control tells DBT whether the number you set in the previous control is in inches or 
centimeters. Normally you'll want to leave the last two controls at their default values of 0.25 
and Inches, respectively. 

Global: Word Importer... 

Keystroke: r from Global menu 

(For more in depth detail, please see DBT's Word Importer Explained) 
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The Word Importer dialog allows you to control specific aspects of how DBT handles the import 
of Word. All options except the last are Check Boxes. 

Transcribe Courier to CBC - (Check Box) - Any Word text which is in Courier font will 
automatically have the appropriate Computer Braille Code applied in DBT. 

Preserve hard page breaks - (Check Box) - DBT will put the New Page code in wherever Word 
has a hard page break. (NOTE: Soft page breaks are ignored) 

Preserve Skipped Lines - (Check Box) - Where there is a Hard Carriage Return on a blank line in 
Word, DBT will also insert a blank line code. (Note: Take care that what appears to be a blank 
line, is actually a blank line, and not "White Space") 

Print Page Breaks: - (List Box) -  

1. Ignore - Page breaks in the Word document will be ignored.  

2. Mark from Word document This will insert "Print Page Indicators" at the appropriate 
point in the document. Care should be used when using this option. These are usually 
only required for documents such as school exercise books, or minutes of a meeting, 
where the print page numbers are often referred to.  

3. Treat hard page breaks as print page breaks - A "Hard Page Break" is one which is 
inserted into a Word document intentionally using the Word command Ctrl + Enter.  

(Note: Many Word authors will use the Enter key to force text on to a new page. This will NOT 
cause a new page in a braille document.) 

4. Use publishers' <ipp no=#> reference page tags - Some publishers are now providing 
electronic files where the print page number is defined within HTML/XML Style tags. If 
this box is checked, DBT will insert appropriate "Print Page Indicators".  

Treat Braille & SimBraille fonts as braille - (Check Box) If you have used these two fonts in your 
Word document, they will be imported into DBT exactly as is. i.e. They will not be translated in 
any way. 

Allow embedded DBT codes, eg. [[*pg*]] - (Check Box) It is now possible to include DBT Codes 
in a Word document, provided they are enclosed as shown here. 

Unknown characters: - (List Box) - This is a List Box. Should the import process not recognize 
any special characters in Word, it will by default place an asterisk in the DBT print text 
document. If you open the List Box, the following will appear. 



The additional choices allow you to replace unknown characters with an asterisk (*), ignore 
them, or to output their value in Unicode. See Troubleshooting: Word - Missing or wrong 
characters in the on-line help files. 

Note: If you are unfamiliar with Unicode characters, and you are encountering problems, please 
contact Technical Support. You might also like to look at the Special Characters Topic. 

Ignore: - There are four check boxes here. 

1. bold - Check this if you do not wish to show bold indicators in your Word document.  

2. italics - Check this if you do not wish to show italic indicators in your Word document.  

3. underline - Check this if you do not wish to show underline indicators in your Word 
document.  

4. language switches - Word can have a nasty habit of automatically adding language 
indicators when you don't want them. Check this to have them ignored.  

 

Global: Formatted Braille Importer... 

Keystroke: b from Global menu 

See also: BRF files - Importing 

The Formatted Braille Importer dialog is used to inform DBT about the dimensions and page 
numbering conventions of the braille files you wish to import. DBT can import BRF files from 
older DBT versions, as well as PokaDot and other braille files. Note that DBT uses these settings 
for import analysis only. In other words, the incoming file will be reformatted to the dimensions 
set in the Global Embosser Setup dialog or template, using the numbering scheme set in the 
Document Menu, regardless of what numbers are filled in here. 

There are 11 Controls in this dialog. 

The Check Box, "Read formatted braille without interpretation". When this is checked, most of 
the other controls on the dialog are disabled. 

Next are two groups of Radio Buttons to tell DBT in what corners it can expect to find braille 
page numbers on even and odd pages, respectively.  

The next two radio controls work the same as the first two, but they refer to the print page, as 
used in Textbook braille format.  
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Next are two additional radio groups in which you can tell DBT to where it will find (if any) 
running headers and running footers, respectively.  

The final two groups are text controls to tell DBT the dimensions, in characters, of the 
formatted ASCII braille file. The lines per page is a maximum value (which should be set higher 
than the actual format) while the cells per line should be set for the exact width of the pages in 
your BRF, or equivalent, file. 

Note: By their nature, formatted (ASCII) braille files are stripped of all format and translation 
codes. To get the file ready for editing, DBT interprets the format and adds codes accordingly. 
Because an interpretive process can go wrong, we recommend, whenever possible, that you 
use the source TXT or WP file instead of the BRF for importing. 

 

Overview of This Edition of the Beginner's Guide 

First Document 

How to Start DBT Win 

Windows XP, Vista and later 

1. Click the Start button on the Task Bar OR: Press the Windows Start Button 

2. Choose Programs (or press p) 

3. Select the "Duxbury" Program Group 

4. Click the "DBT Win" Icon OR: Using the arrow keys, move to the "DBT Win" option and press 
the Enter key 

How to Start A New Document From Scratch 

1. Select "File: New" from the menu; OR: use the shortcut command Ctrl + n by typing the key 
marked "Ctrl" and the letter "n" at the same time. 

2. Select "Print" and "Standard Format" in the dialog box 

3. Click "OK" 

Observe: 

Shortcut Keys (in pull-down menus) 



Shortcut key commands are listed next to the corresponding menu command. For instance, 
when you select "File: New" from the menu, you can also type Ctrl + n. This option is listed 
directly to the right of the menu command. Shortcut key options are an easy, quick way to carry 
out commands which can take much longer if you use the menu. 

How to Enter New Text 

To create our first document, we are going to type a letter. Type the following, using Enter 
twice at every skipped line. Do NOT press Enter where lines end within the paragraph; just use 
the Space bar as you normally would between words, and let DBT "wrap" the lines 
automatically: 

Dear Mother,  

How are you? I'm well. I'm learning how to use the Duxbury Braille Translator. It isn't very hard! All you have to do 
is to type in the text, tell the program to translate, and emboss!  

Love,  

Misty.  

That's all - it's that simple! (Later on, we'll see that proper formatting of most kinds of 
documents requires more than just pressing Enter twice for skipped lines -- but in this case, 
that's all that's needed.) 

How to Translate A Document 

Select "File: Translate" from the menu or type Ctrl + t. 

That's all! You've translated your document! 

How to Emboss A Document 

Embossing a document is very easy. It's setting up the embosser that can be difficult. That 
subject is covered within the section entitled "Installation and Setup." Please be sure that the 
embosser setup has been completed before proceeding with this step -- or, if you do not have 
an embosser, skip this step. 

1. Type Ctrl + e OR: Select "File: Emboss." IMPORTANT: IF YOU DO NOT HAVE AN EMBOSSER 
SET UP, DO NOT USE THE "EMBOSS" COMMAND! 

2. Click "OK" or type the Enter key 

How to Close A Document 

There are three ways to close a document. Be sure to close the document, not the application. 



Take the Long Route - Use the File Menu 

1. Select "File: Close" from the menu 

2. If DBT asks whether you want to save the document, click "No." 

Take the Mouse Shortcut 

1. Click the document's "Close" button 

2. If DBT asks whether you want to save the document, click "No." 

Take the Keyboard Shortcut 

1. Type Ctrl + F4 

2. If DBT asks whether you want to save the document, click "No." 

How to Save A Document 

1. Select "File: Save" from the menu, or type Ctrl + s. 

2. Type "letter.dxp"- the extension ".dxp" tells DBT that this is going to be a DBT print 
document. 

3. Be sure to save your document in the "dbtdocs" directory. 

4. Click "Yes" or press the Enter key. 

A Note About Closing and Saving Documents: 

When you exit DBT, the application first closes any open documents. If you have made changes 
to a document and have not saved those changes, DBT will ask you if you want to save your 
changes. DBT also saves the position of your cursor. If your document is a long one, you may 
find that the next time you open the document, you can't see the beginning of it. In order to 
avoid confusion, type Ctrl + Home, to place your cursor at the beginning of the document, 
before saving. If you want to remember where you stopped working, then don't move the 
cursor to the beginning of the document before saving it. 

How to Exit DBT Win 

Take the Long Route - Use the File Menu 

· Select "File: Exit" from the menu 



Take the Mouse Shortcut 

· Click the application's "Close" button.  

Take the Keyboard Shortcut: 

· Type Alt + F4 

Using Existing Documents 

How to Open an Existing Document 

Now that we've already created a new document and closed DBT, we want to go back and 
make some changes. 

1. Open DBT again. Once you've done that, we'll open the document 

2. Select "File: Open" from the menu; OR: Type Ctrl + o 

3. Select "letter.dxp". This is the file that you already created and saved. 

4. Click "Open." You can double-click the file that you want to open in lieu of clicking the 
"Open" button. 

How To Make Changes To An Already Existing Print Document 

Notice where the cursor is located. When you save a document, the position of your cursor is 
also saved. When you open that document, you can move the cursor one of two ways: 

· Using the mouse, click on the point in the text where you want the cursor to be. 

· Using keyboard arrows, move the cursor to the point on the text where you want the cursor to 
be. 

Now we'll continue working with our letter. 

1. Insert the cursor in front of the question mark in the sentence "How are you?" 

2. Add the word "doing" 

3. The text should now say "How are you doing?" 

Cut and Paste, Copy, Insert, Highlight 



You can do all of these things just as you do in other word processing programs. 

To select text, use your mouse or use the shift key with arrows. (Incidentally, I find that using 
the keyboard instead of the mouse is much quicker and more accurate in DBT.) 

1. Select the words "I'm learning how to use the Duxbury braille Translator. " You may select 
text by using your mouse, or by using your keyboard. 

2. To cut text, select "Edit: Cut" from the menu or type Ctrl + x. Cut the words you selected. 

3. To paste text, select "Edit: Paste" from the menu or type Ctrl + v. Move the cursor and paste 
the words "I'm learning how to use the Duxbury Braille Translator. " before the words "How are 
you doing?" 

4. To copy text, select "Edit: Copy" from the menu or type Ctrl + c. Copy the words "I'm well. " 

5. Paste the words "I'm well. " before the words "I'm learning how to use the Duxbury Braille 
Translator." 

6. Save your changes. 

7. Close the document. 

8. Close DBT. 

You have just made changes to your document, saved the changes and closed both the 
document and the application that created it. 

9. Open DBT 

10. Open the document "letter.dxp" 

The text should now say, 

Dear Mother,  

I'm well. I'm learning how to use the Duxbury Braille Translator. How are you? I'm well. It isn't very hard! All you 
have to do is to type in the text, tell the program to translate, and emboss!  

Love,  

Misty.  

About Saving Documents: Save vs. Save As 



There are two ways to save a document. You have already seen the save command, which 
saves any changes to the document that you have made. The Save As command does the same 
thing, but saves the changes as a new document. 

1. Delete the fourth sentence, "I'm Well." from the document. 

2. Choose "File: Save As" from the menu or press the F3 key. 

3. Name the file "letterch.dxp" 

4. Save the document in the \dbtdocs folder 

5. Close the document 

6. Open letter.dxp 

As you can see, the changes made to "letter.dxp" have not been saved. This is because you 
selected "Save As" rather than "Save." "Save As" saves the changes you have made into an 
entirely new document. 

7. Close "letter.dxp" 

8. Open "letterch.dxp" and observe the changes. 

How to Print A Document 

The subject of setting up your printer is covered within the section entitled "Installation & 
Setup." Please be sure that the printer setup has been completed before proceeding with this 
step -- or, if you do not have a printer, skip this step. 

1. Type Ctrl + p or select "File: Print" from the menu. IMPORTANT: If you have not set up a 
printer, you will just get an error message. 

2. If you are printing the braille (dxb) document, there is a way of printing a translated line of 
print above each line of braille. In order to activate this feature, select "Interline Print" in the 
print dialog box. 

3. Set the number of copies and the print range 

4. Click "OK" 

How to Edit an Existing Braille Document 

It is possible to edit a braille document directly using 6-key chording. This means that six of the 
keys on your keyboard correspond with the six dots in a braille cell. In order to create a braille 



cell, press the keys which correspond with the dots in that cell simultaneously. Usually, the 
corresponding keys are: 

Dot 1 = f 

Dot 2 = d 

Dot 3 = s 

Dot 4 = j 

Dot 5 = k 

Dot 6 = l 

However, these corresponding keys vary from keyboard to keyboard, so trial and error may be 
required to determine the corresponding keys. In order to determine if your keyboard supports 
6-key chording, open DBT and start a new braille document. Type all of the above keys at once. 
If you get a full cell, your keyboard probably supports 6-key chording. 

The Menus 

File: New... 

Keystroke: Ctrl + n 

If you are starting a completely new document, this is where you start. When you select this 
option, the following window will be displayed. 

There are seven sections in this window. You can use the Tab key to move among them. 

Document Type: Two Radio Buttons enable you to choose between starting a new Print 
document, or a new Braille document. Use the up and/or down cursor keys to move between 
them. 

Document Settings Template: This is a List Box which allows you to select a Template for your 
new document. Use the up and down cursor keys to move to the Template which you wish to 
use. 

Mark template as default: Please note that the Templates are displayed in alphabetical order. 
However. you may highlight any template in the list which you wish to use as your default for 
new documents, and click on the button labeled "Mark template as default". (See also 
Document: Create Template) 
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Hide Template: If you do not wish to see the full list of Templates each time you open a new 
file, or import a file, you can hide them. Highlight the Template you wish to hide and click on 
the button labelled "Hide Template". You can also select a range of Templates in the same way 
as you would select contiguous or non-contiguous files in My Computer. 

Note that if you select the Default Template, it will not be hidden. You MUST select a new 
default Template first. 
(This button can also become "Show Template Always" - see Notes below.) 

Show Hidden Templates: By checking this box, you will be able to see all the available 
Templates on your system. 

OK: If you are happy with your selection, press the OK button. 

Cancel: This is a button which allows you to cancel the operation without actually opening a 
new file. Pressing the Esc key at any time has the same effect. 

You will now be taken to the main editing screen, where you may begin to enter text.  

Notes: 

If you have hidden a number of templates, and wish to unhide one or more, you must first 
check the "Show Hidden Templates" box to show all available Templates. Highlight the 
template you wish to re-display. The "Hide Template" button will now be named "Show 
Template Always" - click on the button. 

Uncheck "Show Hidden Templates" and the Template you selected above will now appear in 
the list. 

 

File: Open... 

Keystroke: Ctrl + o 

This opens the standard Windows File Open dialog window where you may select a file from 
your system or network. 

If you select a file which did not originate in DBT, for example a Word file, you will see the 
following Import File dialog appear. If the DBT can identify the type of file, it will be highlighted 
in the Import Filter Section. 

Note that you can also Select the Template which you wish to use. You may also set a default 
template if you wish. The "Set template as default," "Hide Template," and "Show Hidden 
Templates" controls work the same way as the corresponding controls in the File: New dialog. 
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File: Close. 

Keystroke: Ctrl + F4 

Unless you have changed the content of a file, it will simply be closed and disappear from the 
screen. Otherwise, the above window will appear. This contains three buttons. 

Cancel (or c): This will take you back to the editing screen.  

No (or n): Any changes you have made will be discarded. 

Yes (or y): Your document changes will be saved. If your document has not previously been 
saved, then you will be shown a second dialog to prompt you for a file name. 

 

Keystroke: Ctrl + s 

Please try to remember this keystroke and use it regularly.  

This command tells DBT to save your document into a disk file. If your document already has 
been saved, then any changes are written immediately. Otherwise, you will be prompted for a 
file name and location. 

(This Save dialog box works in exactly the same way as a Windows Save As dialog box.) 

File Name: DBT may automatically supply a file name. It does this when your DBT document has 
been created by importing a file created with another application or by translating a file 
previously created by DBT. You may change the file name. If DBT has not automatically supplied 
a file name, then you must type one. YOU DO NOT need to type the file extension. 

 

File: Save as... 

Keystroke: F3 

This is a standard Windows "Save As..." dialog.  

It allows you to save your files in an alternative format as explained below. This can be useful if 
you wish to access the files with a program or device other than DBT. 

Note: It is not advisable to simply change the file extension in the File name: text box. You 
should make your selection from the Save as type: List Box 
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Saving "Print" documents: 

This will present you with a drop down list: 

 DBT print (*.dxp) - Saves as a DBT 10.6 or later print file.  

 DBT print, v10.5 and earlier (*.dxp) - this will save your document in a pre 10.6 format. If you 
do this, please remember that any new DBT Codes used which were introduced into DBT from 
Version 10.6 or above will be ignored, and may indeed produce unexpected results if translated 
and/or embossed in earlier versions.  

 Formatted text, IBM ASCII (*.prf) - essentially saves as DOS text.  

 Formatted text, Windows ANSI (*.prf) - saves using Windows character set.  

 Duxbury coded text (*.txt) - saves as a text file containing DBT Dollar Codes  

 SGML/ICADD/HTML (*.sgm) - saves as a tagged file where DBT codes are inside < and > signs.  

Saving "Braille" documents: 

This will present you with the following drop down list: 

 DBT braille (*.dxb) - Saves as a DBT 10.6 or later braille file.  

 DBT print, v10.5 and earlier (*.dxp) - this will save your document in a pre 10.6 format. 
If you do this, please remember that any new DBT Codes used which were introduced 
into DBT from Version 10.6 or above will be ignored, and may indeed produce 
unexpected results if translated and/or embossed in earlier versions.  

 Formatted braille, USA encoding (*.brf) - essentially saves as DOS text.  

 Formatted braille, local encoding (*.brf) - saves using Windows character set.  

 Duxbury coded braille (*.bru) - saves as a text file containing DBT Dollar Codes.  

 Refreshable braille (*.lbf)  

Warning: Changing the extension to anything else can cause the file to save in an unexpected 
and inaccessible format, rendering your file impossible to open. 

 



File: Translate... 

Keystroke: Ctrl + t 

When you select Translate, your text file is translated according to your settings, and you will 
then be displayed a window showing your translated file according to your chosen default 
View. 

If by accident you attempt to translate an empty file, you will receive an error message. 

File: Print... 

Keystroke: Ctrl + p 

This option is to allow you to produce an ink-print copy of your Print or Braille document.  

(Please do not confuse Print with Emboss!)  

Print (Text Document): 

When you select Print from the original text document, you will see the following screen 
appear. This gives you the option to print just one, or more copies. You can also choose which 
pages to print: 

 All: The whole document will be printed.  

 Current Page: Only the page where the cursor is currently located will be printed.  

 Selection: Only the text highlighted on screen will be printed. The printed copy of this text may 
well be wrapped differently from what is on screen.  

 Print Page Number(s): Only the pages you specify will be printed. Specify pages by typing one or 
more page numbers as they appear on the pages of your document. You may specify a range of 
characters by using a hyphen. You may also specify one or more sets of pages by using a comma. 
For example, to print pages ix, x, 15, 16, and 17, you might type ix-x,15-17  

 Page Sequence Number(s): Only the pages you specify will be printed, but you must specify 
those pages as if your document starts at page 1 and continues with page 2, 3, etc. In other 
words, you may have to ignore the page numbers displayed on each page and simply count 
pages in the document, or look at the status line when the cursor is on each page you wish to 
specify. This option is useful when one or more page numbers are repeated (e.g. you have two 
pages that are labelled "1"). You may use the hyphen and comma characters as described 
above.  

From there, you have the option to press Cancel, or OK to proceed. 
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NOTE: The Interline Print check box is also grayed out, and cannot be accessed at this stage. 

 

Print (Braille Document): 

When you select Print from within your Braille document, the same screen appears, but with 
two subtle differences - The Interline Print Check Box is now available and "Print Page 
Number(s)" is changed to "Braille Page Number(s)". The latter change is because you may 
choose pages to emboss by following the braille page numbering, but not the print page 
reference numbers. 

Interline Print: 

This is an extremely useful facility whereby as well as printing braille dots on paper, text also 
appears above the line of braille. The printed copy will appear as follows. (N.B. Illustration was 
translated using a line length of 20 Cells) 

File: Emboss... 

Keystroke: Ctrl + E 

The Emboss option is used to produce braille on your braille embosser. 

There are eight items in this dialog. (Item 1 is a Text Box. 2 - 6 are Radio Buttons. 7 & 8 are Push 
Buttons.) 

1. Copies: Enter the number of copies you wish to emboss. The default is 1.  

2. All: The entire braille document will be embossed.  

3. Current page: Only the page your cursor is located in will be embossed.  

4. Selection: If you highlight a section of the braille document, only that section will be 
embossed.  

5. Braille page number(s): This refers to defined page numbers in your document.  

6. Page sequence numbers(s): This refers to the page sequence. For example, you might 
have pages numbered A, B, 1, 2, A1 and A2. Pages A1 and A2 would therefore be 5 & 6 
in the sequence.  

If you select either control 5 or 6 (Braille Page numbers or Page sequence numbers), then you 
must normally type Tab and enter a page range, a list of pages, or even a list of page ranges, 
into a text control you reach. Leaving the text control blank will cause DBT to emboss all pages. 
If you wish to print a range, you may enter a beginning and ending page separated with an 
unspaced dash or hyphen, e.g. 4-7. To emboss two or more non-contiguous pages, separate the 
page numbers with a comma, e.g. 8,12. If you wish to include a blank page for any reason, use 
the letter b. You can "mix" if required, e.g. 4-7,8,b,12. 



7. Cancel: If you decide you do not wish to emboss at this time, you can click on Cancel 
button, or press the Esc key.  

8. OK: When you have completed the above, and are ready to emboss, click on the OK 
button, or press Enter.  

Note the your selected embosser and paper size is also displayed at the foot of this dialog. 

Once embossing has begun the following Window will display your progress. If you wish to 
abort embossing, you can either press Esc or click on the Cancel button. If you simply wish to 
pause embossing, perhaps to answer the telephone, press the on/off line button on your 
embosser. (See your manual for details) 

Note that in some circumstances, especially where your embosser is "spooling", there may be a 
delay before the embosser stops working. DBT has no control over this. 

Notes: When you emboss, you can choose a start and end Page Sequence number to print. This 
refers to the PHYSICAL SHEET, and NOT the actual number printed in braille on the page. For 
example, let's say my first four pages have Roman numerals i - iv, and then I continue with three 
pages of Arabic numbers 1 - 3. That's seven pages - correct? If I wanted to print ONLY those first 
two pages containing Arabic numbers, I would ask it to emboss FROM: page 5, TO: page 6. 

Note also that the physical page number, line number, and column number where the cursor 
sits, is displayed in the Status Line. So if you know that the pages you want to emboss appear 
with page numbers in braille which are different from their physical order in the file, then this is 
an additional means to determine a Page Sequence range to emboss. 

Double Sided or Interpoint Printers: Users of interpoint embossers are advised to always give an 
odd number for the "From:" field (if it is specified) and even number for the "To:" field (unless it 
is left blank). This will ensure that DBT embosses the document with the proper front/back 
relationship of sheets, which is what is usually wanted 

See Also: Global: Embosser Setup... 

File: Exit. 

Keystroke: Alt + F4 

This option closes down the DBT Program. 

However, if you have any files open, which you have not saved, the following screen will appear 
which contains three buttons. Note that you will be prompted with this screen separately for 
each open unsaved file. 

1. Cancel: Returns you to DBT. DBT will not prompt to save any more documents. 
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2. No: Closes this document WITHOUT saving changes. 

3. Yes: Your document changes will be saved before the document window is closed. If your 
document has not previously been saved, then you will be shown a second dialog to prompt 
you for a file name. 

 

File: Recently Used Files 

Keystroke: Select appropriate number from list (If shown) 

Beneath the Exit item, you will see a short list containing the last five files you have used in DBT. 
You can select one of these in the menu if you want to open the file again. 

EDIT: (Menu) 

Keystroke: Alt + e 

This menu and its submenus deal with editing work to be done within a file. 

Edit: Undo 

Keystroke: Ctrl + z 

This feature, sometimes known as "Go back", allows you to "undo" various operations, such as 
a Search & Replace, as well as incorrect typing. 

It should however be noted that the feature only works during the current open session of a 
document within DBT. Once you close a document, regardless of whether or not you have 
saved it, the feature will not be available. 

You should use Undo with care, since there is a limit of 100 operations. However, "Replace All" 
does count as one. 

 

Edit: Redo 

Keystroke: Ctrl + y 

If you have used "Undo" and gone back too far, you may use Redo to step back to the point you 
wish to be at. 
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Edit: Cut. 

Keystroke: Ctrl + x 

Use Cut to move text from one location to another, even to another document in another 
application. The text gets removed from your document and placed in the clipboard. You must 
highlight text prior to using Cut. 

See also: Edit: Copy  

 

Edit: Copy. 

Keystroke: Ctrl + c 

Copy is used to place highlighted text into the clipboard so that you can duplicate it. Use Edit: 
Paste to insert the text elsewhere in DBT or another application. The text will remain 
highlighted after you have given a command, (e.g. Ctrl + c to copy) until such time as you use a 
navigation key such as one of the arrow keys. 

Note: When pasting into another application, care should be taken. Such things as DBT Codes 
will not be pasted as seen. Likewise, if you copy and paste from a document in Braille view, you 
will not necessarily see braille dots on the screen when you paste. 

See also: Edit: Cut  

 

Edit: Paste. 

Keystroke: Ctrl + v 

After using Edit: Cut or Edit: Copy to get text into the clipboard, Paste is used to insert the text 
in its new location. Paste is unavailable when the clipboard is empty; that is, when no text has 
been cut or copied from DBT or another application.  

 

Edit: Clear. 

Keystroke: Del 

Clear is used to delete the highlighted text, without placing it in the clipboard.  
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Edit: Select All. 

Keystroke: Ctrl + a 

Select All is used to highlight your entire document, including all text and codes, in one step. 
Once highlighted, you can use clipboard functions on the entire document. This can be 
especially useful for condensing several small documents into one large one. 

 

Edit: Highlight 

Keystroke: Ctrl + h 

Highlighted text can be easily moved, copied or deleted. The Highlight command turns the 
Arrows/Cursor Keys, Home, End, Page Up and Page Down keys into a highlighter while editing. 

You can get the same effect by holding down the Shift key. 

To highlight with a mouse, simply (left) click-drag over the text.  

An example of showing highlighted text follows. 

 
 

Edit: Change Case 

Keystroke: Shift + F3 

This is a "toggle" command allows you to chance the case of highlighted text into one of three 
alternative formats as shown below. 

All CAPS: 
THE QUICK BROWN FOX JUMPED OVER THE LAZY DOG 

no caps: 
the quick brown fox jumped over the lazy dog 

First Letters Of Words Capitalized: 
The Quick Brown Fox Jumped Over The Lazy Dog 

 



Edit: Insert File. 

Keystroke: None 

You may insert various types of files directly into your DBT document. These include other DBT 
files, certain types of braille graphics files (.brg, .sig and .vim), Music files (.lim, .mid and .mus), 
and Microsoft Word and Word Perfect documents. 

Other file types may imported, but you might have to experiment with a sample or test 
document. 

NOTE: Music files can currently only be imported if you have version 3 or above of the 
GOODFEEL® braille music program installed on your system. For more details, please see the 
Music Topic in the Codes Section of the on-line Help files. 

Edit: Goto... 

Keystroke: Ctrl + g 

If you wish to relocate the cursor to a specific location, such as 'Page 5, Line 3, Column 4', the 
Goto feature is a dialog with those three self explanatory controls. Page, Line and Column. 

All three values are initially set to the current location of your cursor. 

If you wish to access a particular Reference Page Number, there's a check box to make it 
possible. 

Note: If for any reason your cursor cannot be re-located where you have specified, the 
following message will appear asking if you want to go to the nearest location.  

Edit: Find... 

Keystroke: Ctrl + f 

The Find dialog can be used to search for a particular word or phrase in your document. When 
View: Codes is toggled on, you can search for codes, text, or a mixture of the two. 

The dialog contains seven controls.  

 Text to Find: allows you to type in text. For print documents, type normally from the 
keyboard. For braille documents, you can type ASCII braille equivalents or start 
chording, depending on which keyboard mode is in use.  
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 Case sensitive - is a check box to toggle case sensitivity on and off; this is unavailable 
when you are working with a braille document because braille uses capital letter 
indicators instead of distinct upper and lower case characters.  

 Backward search - is a check box to enable a backwards search. Note that the search 
begins from wherever your cursor is located, or from the end of the any highlighted 
text.  

 Find whole words only - enables you to search for only whole words. For example, if 
you wanted to search for the word "Now", check this box, otherwise words like 
"Nowhere" would also be found.  

 Find stylename - enables you to search for a Style. Be sure to enter the name of the 
style exactly as DBT defines it, including the period (full-stop) at the end of the style 
name, if appropriate.  

 Finally there is an "OK" and a "Cancel" button.  

See also: Edit: Find again. 

NOTE (1): You can copy highlighted text from your document, and paste it into the "Text to 
Find:" box. 

NOTE (2): To type a DBT code, press F9 then type the code. 

NOTE (3): You can press the F5 key to bring up the Duxbury Code List. should you require many 
popular special characters such as the Japanese ¥ (Yen) sign, or formatting codes such as Clear 
Tab Stops [ctb] 

 

Edit: Find Again. 

Keystroke: Ctrl + i (i as in India) 

Press the above keystrokes to look for the next occurrence of the text you are searching for. 

 

Edit: Replace... 

Keystroke: F6 

The Replace dialog is similar to the Edit: Find... dialog, with the addition of a replacement text 
string. 
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After starting the process, if the search string is found, you will be asked if you wish to replace 
it. The possible answers are Yes, No, All or Stop, which you can trigger with Y, N, A or S, 
respectively. Replace mode keeps going until no matching text is found, or you respond with 
either A or S when prompted. 

Note: The Replace process starts from the point at which your cursor is placed, or from the 
start of highlighted text. To move your cursor to the beginning of the document press Ctrl + 
Home, and to the end press Ctrl + End.  

If you have started your search from a point mid-document, you will receive the following 
promt when you reach the end of the document. 

Edit: Spell Check... 

Keystroke: Shift + F11 

This is DBT'S 'full-blown' spell checker. When the spell checker is launched, it will check either: 
(1) The highlighted text, if any, or (2) to the end of the document -- the top line of the dialog 
tells you which it is checking. If a misspelled word is found, it appears on the second line of the 
dialog, and is also highlighted where it appears in your document. 

There are three controls in the dialog, two of which are normally dimmed. 

First is a set of radio buttons to determine if you wish to ignore the word once, ignore for this 
entire editing session (even if the word is found in another document), add it to the dictionary 
for all future sessions, or replace it. 

If you choose to replace the word, there are two more controls. A text box lets you manually 
edit the suggested replacement or fill in your own while a list box displays suggestions for 
replacement.  

Clicking on OK or pressing Return will perform the action you request and bring up the next 
word it finds, if any. Spell check will continue until it reaches either: (1) the end of the 
highlighted text or (2) the end of the document. 

A message tells you that the spell check is complete, and your cursor returns to where it was 
when you started. 

To check spelling without launching a dialog box, see Edit: Find Misspelling. 

Spell check features are NOT available when a braille file occupies the active window. 

NOTE: To check spelling throughout the whole document, press Ctrl + Home before starting the 
Spell Check. 
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See also: Spelling Checkers 

 

Edit: Find Misspelling. 

Keystroke: F11 (or M from menu) 

Some users find full-blown spell checkers to be obtrusive and would rather deal with misspelled 
words in the normal editing screen, where it's easy to ignore the word or type in a replacement. 
The find misspelled word feature is designed for that type of user. 

This command moves the cursor to the next misspelled word and highlights it (or provides a 
message if the end of the document is reached without finding one). 

If you press the F11 key, this command will find the first misspelling from the location of the 
cursor. 

If you want more options, such as the ability to add words to the search dictionary, use the Edit: 
Spell Check... option. 

Note: if a word is highlighted as a result of the find misspelling command, that word will be the 
ONLY word checked by the full-blown spell checker dialog, making it easy to resume searching 
with Edit: Find misspelling. 

Note: Spell check features are NOT available when editing a braille document. 

 

VIEW: (Menu) 

Keystroke: Alt + v 

The View menu determines which document will appear on your screen, and how it will 
appear.  

Note that a tick or check mark may appear to the left of some items on this menu. If you are 
using a screen reader, this should be spoken.  

The bottom of the View menu is a list of all documents opened during your editing session, 
including those created by File: Translate... Choosing one of these documents will make it 
become the current document. The remaining View menu items, listed below, will affect the 
way the frontmost document appears. 
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View: Full Page. 

Keystroke: None 

The Full Page feature toggles between two different zoom levels. When using Full Page, the 
point size of the display font is adjusted so that an entire page of text can appear on-screen at 
once. 

Depending on the size of your monitor, Full Page view can be very useful when working with 
the general layout of the braille document. 

The text is normally too small for editing, but may be useful for visually seeing where the pages 
break. 

A check mark next to Full Page indicates that it is enabled. When not using Full Page, the screen 
font size is as set in Global: Fonts... 

 

View: Print Font. 

Keystroke: Ctrl + F5 

The Print font, and the other two fonts (Braille and SimBraille) listed under View, are choices for 
displaying a document. These options are normally used only for braille documents. 

The Print font shows braille in ASCII braille equivalents instead of dot patterns. 

View: Braille Font. 

Keystroke: Ctrl + F6 

By choosing the Braille Font view, your documents will appear on-screen as graphical dots. 
Unless you are viewing the codes, a braille document shown with Braille Font is WYSIWYG. In 
other words, your embosser should produce exactly what you see on-screen. 

View: SimBraille Font. 

Keystroke: Ctrl + F7 

The SimBraille font is the same as picking View:Braille Font but SimBraille adds shadow dots 
which can help sighted braille readers. 

See also: View: Print Font and View: Braille Font. 
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View: Six-Key (Braille) Entry. 

Keystroke: F2 

Six-key entry toggles your keyboard between normal and chording mode. 

The default is to allow the sdf and jkl keys to be used "Perkins Style", i.e. dots 321 and 456 
respectively. 

See also: Six-Key Entry (Customizing) 

 

View: Codes. 

Keystroke: Alt + F3 (Toggle) 

DBT normally has a WYSIWYG screen. A WYSIWYG screen doesn't always allow you to 
determine WHY a document looks the way it does. Viewing the codes can help in 
troubleshooting formatting problems. For some advanced users, especially those familiar with 
older versions of DBT, a coded view may even be preferred over WYSIWYG. 

View: Translated Line. 

Keystroke: Ctrl + F8 

When a print file is open, the translated line shows the braille equivalent of the current print 
line. The fonts used and their display sizes, are determined in the Global Menu: Default Views. 

When a braille file is active, this option will turn the bottom line of the current document 
window into a display of the print equivalent of the braille line on which the cursor rests. 

Note: the translated line is generated by a built-in braille-to-print translator, which is 
supported only for some languages. See Language Translation Tables for details. Moreover, 
the translated line is generated by translating the braille into print without regard to context. 
Therefore, the translated line is not an accurate reflection of text marked for grade 1 or other 
types of braille. 

The limitations of the translated line are especially apparent when viewing braille for a 
language where braille-to-print translation isn't supported, or where viewing mathematics 
braille. 
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View: Active Document. 

Keystroke: Type number from list, or highlight and press Enter. 

If you have 2 or more documents open, you can quickly select another document from this 
menu. 

 

LAYOUT: (Menu) 

Keystroke: Alt + l (l as in Lima) 

The Layout menu is used to handle all aspects of translation and formatting of text within your 

document. In other words, Layout is where you can access the numerous styles, translation codes, and 

format codes that make DBT so flexible. Whenever possible, and especially with major projects, we 

recommend using Styles instead of direct coding. Doing so will make it easier to manage your 

documents. For an in-depth discussion, we recommend reading Codes & Styles - Introduction. 

Layout: Apply Style... 

Keystroke: F8 

The Apply Style dialog box has only one control. You simply choose a Style name from those 
listed and press Return or click on OK. What happens depends upon whether the Style is a 
Linear Style (indicated by a period at the end of the Style name) or a nestable Style. 

If the Style is linear: (Also known as "Paragraph Style") 

A linear Style applies to the entire current paragraph. In other words, the start and end tags are 
applied at the previous forced line ending and the next forced line ending. Text does not need 
to be highlighted in order to apply a Linear Style. If text is highlighted, each paragraph within 
the selection, including paragraphs that are only partially selected, will get its own pair of start 
and end tags. If you've applied a hierarchical Linear Style, you can change the Style level after 
using Apply Style. 

If the Style is nestable: (Also known as "Character Style") 

A nestable Style can start and end anywhere in your document, paragraph or even sentence. 
Therefore, if text is highlighted, the beginning tag goes immediately before the highlight and 
the ending tag goes just after. If no text is highlighted, applying a nestable Style will result in the 
cursor resting between the start and end tags waiting for you to type in the text that falls under 
that Style definition. After typing in the text, use right arrow to move beyond the Style end tag. 
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Layout: Apply Last Style. 

Keystroke: Shift + F8 

This causes DBT to apply the Linear Style from the preceding paragraph to the one following. 

 

Layout: Style Level + 

Keystroke: Alt + Right Arrow 

Use this option to increase the current Linear Style Level by 1. 

Note: Not all Styles support different levels. 

 

Layout: Style Level - 

Keystroke: Alt + Left Arrow 

Use this option to decrease the current Linear Style Level by 1.  

Note: Not all Styles support different levels. 

 

Layout: Join Styles. 

Keystroke: j from Layout Menu 

This menu selection should be used only when you have highlighted more than one line of text. 
When you join styles, DBT combines all paragraphs selected or partially selected into a single 
linear style, with only a hard return code between each paragraph. 

This feature can be helpful for quickly cleaning up the formatting of text. For example, try 
applying the 'list.' linear style to the first of a series of paragraphs. Now select at least part of 
this paragraph and several paragraphs following. Choose Layout: Join Styles, and you have 
combined all the paragraphs into a single list. 

 

Layout: Join Lines. 

Keystroke: o (From Layout menu) 
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Like Layout: Join Styles, this menu selection is intended for use when there is a highlight 
encompassing more than one line. Joining lines works just like joining styles, and additionally 
removes all hard return codes and similar codes, replacing each with a space. Essentially, this 
can be used to re-wrap a paragraph when lines are forcibly broken at the wrong places. 

Importing Files: 

You may find that certain formats of imported files contain hard carriage returns at the end of 
each and every line. This will also cause your Braille document to contain unwanted line breaks, 
which appear as new paragraphs. If you select View Codes (Alt + F3) you will see additional Line 
Codes at the end of each line as shown below. 

This text was [l] 
typed in a word [l] 
processor and [l] 
then saved as a [l] 
text file. [l]  

If you highlight the text, and select "Join lines" from the Layout Menu (or press o) you text will 
be reformatted to remove the additional line breaks. 

This text was typed in a word processor and then saved as a text file.[l]  

Note: Take care not to highlight more than one paragraph at a time, or paragraphs will be 
merged. 

 

Layout: Translation Codes. 

Keystroke: Press t (From Layout menu) 

See Notes below for important information. 

This pull-out list has codes for marking up a file for translation. Unlike format codes, these 
codes take effect during translation so no immediate change is made to the WYSIWYG view. 
Choices include: 

Grade 0  

Grade 1  

Grade 2  

CBC (Computer Braille Code) 
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Spanish  

LIFG (Latin, Italian, French, German) 

Note 1: Two or more spaces are not preserved during translation unless a Hard Space is 
inserted. 

Note 2: Take care when applying changes mid-document. If you only want a section in another 
Grade, you must remember to change back at the appropriate point. 

See Language Translation Tables and the relevant sub-topic(s) for more specific details. 

 

Layout: Translation Codes: Grade 0. 

Keystroke: Alt + 0 (Zero) 

This menu selection will cause DBT to insert a series of codes which, when the document is 
translated, will cause the Translator to render text following in Grade 0 braille.  

Advanced users may wish to customize which codes are inserted by using the Shortcut 
Preferences dialog available through the Global menu. 

 

Layout: Translation Codes: Grade 1. 

Keystroke: Alt + 1 

This menu selection will cause DBT to insert a series of codes which, when the document is 
translated, will cause the Translator to render text following in Grade 1 braille.  

Note: The Braille rules applied will vary depending on the language used. 

See Language: Translation Tables and the relevant sub-topic(s) for more specific details. 

 

Layout: Translation Codes: Grade 2. 

Keystroke: Alt + 2 

This menu selection will cause DBT to insert a series of codes which, when the document is 
translated, will cause the Translator to render text following in Grade 2 braille. 
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Note: The Braille rules applied will vary depending on the language used.  

See Language: Translation Tables and the relevant sub-topic(s) for more specific details. 

 

Layout: Translation Codes: CBC. 

Keystroke: Alt + 3 

This menu selection will insert a series of codes which, when the document is translated, will 
cause the Translator to use Computer Braille Code. 

If you only with to wish to apply Computer Braille to a section of text, and not the whole 
document, use the compinline or compdisplay. Styles (See Layout: Apply Style for more details) 

Note 1: When DBT is set up for British Braille, the use of this code will invoke BCB (British 
Computer Braille) as determined by the BAUK.  

Note 2: When DBT is set up for French Braille, the use of this code will invoke French Computer 
Braille 

Note 3: In some other cases, the choice of language may affect whether or not Computer 
Braille can be used, or indeed which version. See Language: Translation Tables and the relevant 
sub-topic(s) for more specific details. 

 

Layout: Translation Codes: Spanish. 

Keystroke: Alt + 4 

This menu selection will insert codes to force Grade 1 mode. Any accented letters in the text 
will be rendered in a form appropriate for Spanish text appearing "in an English context". 

Note: The use of Spanish with this code, is only applicable to English braille (All versions) 

See Language: Translation Tables and the relevant sub-topic(s) for more specific details. 

 

Layout: Translation Codes: LIFG. 

Keystroke: Alt + 5 
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This menu selection will cause DBT to insert a series of codes which will make the text following 
translate into Grade 1 braille. Any accented letters in the text will be rendered in a form 
appropriate for Latin, Italian, French, or German text appearing 'in an English context'.  

See Language: Translation Tables and the relevant sub-topic(s) for more specific details of 
different languages. 

 

Layout: Character Codes. 

Keystroke: C from Layout menu 

Layout: Character Codes: Letter Sign. 

Keystroke: L from Character Codes menu 

This is a special braille character normally used in Grade 2 to indicate that what follows is an 
isolated letter, as opposed to a word. 

For example, in English Braille, the letter k means "knowledge". If the letter k was proceeded by 
dots 5,6 the reader would know that this means simply the letter k. 

To use this command, place your cursor immediately in front of the letter for which you wish a 
letter sign to precede, and select Letter Sign from the Character Codes Menu. An &+ will appear 
in the print version as show below. In braille the appropriate letter sign will be shown. 

"He did not have any knowledge of &+k, which in computer terms means kilobytes."  

 

Layout: Character Codes: Termination Sign. 

Keystroke: t from character codes menu 

A special symbol (in English braille: dot 6 followed by dot 3) used to terminate the affect of 
capitalization or italics in the middle of a word. It is also used to indicate a Transcriber's Note. 

Use this to add the termination sign to a print or braille file. 

To insert a Termination Sign, place your cursor where you wish the sign to appear and select 
Termination Sign from the Character Codes menu. An &@ will appear in the print version, and 
the appropriate termination sign will appear in the braille version. 
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Layout: Character Codes: Hard Space. 

Keystroke: Alt+F2 

Hard Space will create a space character that cannot break across a line. You will find this 
especially useful in keeping two or more words under the effect of a flush right command. 

Another example of the use of this is where, for ease of reading, you may not want a telephone 
number to be split over two lines. e.g.  

+44 1604  

792777.  

To insert a Hard Space, place your cursor where you want to have a Hard Space, and press 
Alt+F2. The result would be as shown below 

This number must not be split over two lines. e.g. 

+44 1604 792777.  

 

Layout: Character Codes: Group. 

Keystroke: Ctrl + b 

Group is used to treat an entire highlighted block as one word for flush right and other 
commands. Although the effect is the same, grouping is easier than placing a hard space 
between each word in the block.  

Note: Be careful not to group too large a block; even though the text may easily fit on one print 
line, it may require two or more braille lines. 

 

Layout: Line Codes. 

Keystroke: l (as in Lima) from Line Codes menu 

Layout: Line Codes: New Line. 

Keystroke: Ctrl + l ("l" as in Lima) 

Use this to add a code to insert a forced line ending, which is slightly different from the code 
produced by pushing Return. The New Line code only insures that you are on a new line. In 
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other words, using New Line multiple times will not add blank lines to your document in the 
same way as pushing Return. 

 

Layout: Line Codes: Skip Line. 

Keystroke: Ctrl + k 

Skip line will add a code to produce a blank line. 

 

Layout: Line Codes: Suppress Skipped Line. 

Keystroke: Alt + k 

This is normally used when a DBT Style includes a "Skip Line" code which you wish to suppress. 

 

Layout: Line Codes: Centering. 

Keystroke: Shift + F6 

Centering inserts two codes to make the text in between become centered. If you highlight 
text, that text becomes centered on its own line. If no text is highlighted, start typing to place 
text inside the codes, then press right arrow to move beyond the end centering code. 

 

Layout: Line Codes: Flush Right. 

Keystroke: Shift + F7 

Flush right inserts a code to put the next word on the right margin. If you wish for more than 
one word to come under this command, you should put hard spaces between them, or group 
them. 

 

Layout: Line Codes: Flush Right with Leader. 

Keystroke: Alt + F7 

This selection is the same as Layout: Line Codes: Flush Right, except that leader dots are included.  
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Advanced users may wish to customize which codes are inserted by using the Shortcut 
Preferences dialog available through the Global menu. This is the only way to change what 
braille cell is used for the leader dots inserted. 

 

Layout: Line Codes: Tab To Runover Point 

This menu item will insert a pair of codes ([l][run]) which cause DBT to force a "soft return". In 
other words, the next word will be placed at the runover margin; a newline will be forced if the 
current line already has text. 

 

Layout: Line Codes: Single Spacing 

Keystroke: None 

This command inserts a code which cancels the effects of Layout: Line Codes: Double Spacing. 

 

Layout: Line Codes: Double Spacing. 

Keystroke: Shift + F2 

Double spacing inserts a code to treat each line ending as two line endings so that text never 
appears on two adjacent lines, as is common for children's books. 

 

Layout: Line Codes: New Paragraph  

Keystroke: Ctrl + m 

This keystroke has three different behaviors, depending on where the cursor is in a document. 

When the cursor is at the end of a linear style (i.e. at the end of a paragraph), then this style 
ends the style, starts ta new linear style "paragraph" with the same linear style applied, and 
places the cursor within this new empty paragraph. This makes Ctrl+m a very useful shortcut to 
know when typing text directly into DBT. 

When the cursor is in the middle of a linear style, then this style splits the linear style into two 
"paragraphs", each with the same linear style applied. (In this sense, it works somewhat like the 
opposite of Layout: Join Styles.) 
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When the cursor is in text that isn't in a linear style," New Paragraph inserts a code to start a 
new paragraph. For print, a paragraph is normally indicated by a skipped line. For braille, the 
first line is indented. The paragraphing behavior can be modified with special coding. 

Advanced users may wish to customize which codes are inserted by using the Shortcut 
Preferences dialog available through the Global menu. However please note that this will only 
affect what is described in the previous paragrah. 

 

Layout: Left Margin. 

Keystroke: (F4 will select a left margin of 3 cells) 

The left margin menu pulls out a list of numbers from which you can choose the left margin 
setting. Selecting any of these numbers causes DBT to insert a code to set the left margin 
accordingly. The most commonly used left margins are included. For a different number, you 
will need to use the Layout: Code List... dialog. 

Note: If you want to insert a left margin throughout your entire document to make binding the 
document possible, you should generally not use the Left Margin feature described here. Use 
the Document: Embosser Setup dialog to set a binding margin instead. 

 

Layout: Right Margin. 

Keystroke: (Shift + F4 will select a right margin of 6 cells) 

The right margin menu pulls out a list containing the most commonly used numbers for a right 
margin. Selecting any of these numbers causes DBT to insert a code to set the right margin 
accordingly. Other settings can be made by using the Layout: Code List... dialog. 

Note: This feature is intended for use when you want to make a temporary change to the right 
margin. Do not use this feature as a way of reformatting your document for a new paper size. 
For this purpose, use the Document: Embosser Setup dialog to specify a form instead. 

 

Layout: Runover Offset. 

Keystroke: (Ctrl + r will select a runover offset of 2 cells) 
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The runover offset menu pulls out lists containing the most commonly used numbers for a 
runover offset. Making a selection from this list will cause DBT to insert a code into your 
document to change the way DBT formats continuation lines. 

All common settings for a runover offset margin are among the numbers in this pull-out list. For 
other settings, use the Layout: Code List... dialog. 

 

Layout: Math Codes. 

Keystroke: m for Layout menu 

This menu contains many codes related to formatting and translation in Nemeth Mathematics 
notation. Details regarding the use of these codes are given in the Topical How-To Guide, a DBT 
document which is typically installed as C:\Program Files\Duxbury\Duxbury 
10.6\Documentation (English)\dochow.dxp. 

Unless you are an experienced math braillist, you may prefer the "easy way out", and use 
Scientific Notebook to prepare your mathematical material, and import the resultant file into 
DBT. For more details click here: Miscellaneous: Scientific Notebook. 

 

Layout: Page Codes. 

Keystroke: g from Layout menu 

Layout: Page Codes: New Page. 

Keystroke: Ctrl + Enter or p from Page Codes menu. 

New page will insert a code to force a page break, even if plenty of room exists on the current 
page. This is commonly used between chapters of a book. 

 

Layout: Page Codes: New Reference Page. 

Keystroke: Alt + Enter or R from Page Codes menu. 

New reference page will produce a code to show where the page changed in the source 
document. Normally this is used to mark the print pages when creating a braille textbook. After 
using this command, you should type the number of the new reference page, followed by a 
space. Leader dots will appear, with the reference page flush right against the margin. 
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Layout: Page Codes: Block Protect. 

Keystroke: b from Page Codes menu. 

This command causes DBT to put codes before and after any text you have highlighted, so that 
the text will not get split across a page break. 

If no text is highlighted when you select this command, the codes will be placed before and 
after the cursor; any text that you type will be kept on a single page, until you type the right 
arrow key to step beyond the second code. 

For example, to keep a company's address all on one page, you would highlight the address and 
apply block protect. Or position the cursor first, apply block protect, type the address, and then 
hit the right arrow key. 

Of course, if the highlighted text is too long to fit on one braille page, the command cannot be 
honored. 

 

Layout: Page Codes: Vertical Centering 

Keystroke: v from Page Codes menu. 

This option will vertically center text on a page. 

Please note that although this can be used for such things as Title Pages, this is cannot always 
be regarded as the official local method for such pages. 

 

Layout: Set Page Number... 

Keystroke: n from Layout menu. 

The Set Page Number dialog is used to add a code to change the page numbering. Unless you 
insert the code before anything else on a fresh page, the new page number will appear on the 
page FOLLOWING the one in which you inserted the command; be sure to compensate for this. 
You can enter the new number in the text box, and if you wish, use the radio buttons to choose 
between Roman or Arabic numbers. The default is Arabic. 

 

Layout: Header... 

Keystroke: h from Layout menu. 
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Note: Please do not confuse the term "Header" with "Heading". 

The Header dialog is used to create or change the running Header. There are two controls. 

The first control is a text box for the text of the Header. If you are editing a braille document, 
the text box should contain braille. If six-key editing is enabled, chording is used to enter text, 
otherwise you would type in ASCII braille equivalents. If you are working on a print document, 
the text box must contain print; the contents will be translated to braille along with the rest of 
the document. 

The second determines where the Header will appear. You can choose 'No Header' if you wish 
to discontinue an earlier Header. 

 

Layout: Footer... 

Keystroke: f from Layout menu. 

The Footer dialog is used to create or change the running Footer. There are two controls. 

The first control is a text box for the text of the Footer. If you are editing a braille document, 
the text box should contain braille. If six-key editing is enabled, chording is used to enter text, 
otherwise you would type in ASCII braille equivalents. If you are working on a print document, 
the text box must contain print; the contents will be translated to braille along with the rest of 
the document. 

The second determines where the Footer will appear. You can choose 'No Footer' if you wish to 
discontinue an earlier Footer. 

 

Layout: Generate Table of Contents. 

Keystroke: b from Layout menu. 

This option enables automatic generation of a Table of Contents within a Braille document. It 
can produce Braille or Print Page numbers. 

Note: This option is only available when a Braille document is in focus. 

For many transcribers, this is one of the most labor saving of DBT's options. 

But before you even consider using this option, it is vitally important to appreciate that your 
original document must contain appropriate Heading Styles. 
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Also, a common mistake is to confuse a "Heading" Style with a "Header" and/or "Footer" Style. 
Remember, a Heading is contained within the text of the document. A Header (or footer) 
appears at the top or bottom of the page(s) 

With 19 Controls, the dialog may appear daunting, but normally only requires to be set up 
once. They are described in the order in which you would use the Tab key to move through 
them. 

1. Style to use: This is a List Box which currently offers three options for generating a Table 
of Contents. BANA, French or Custom. 
 
If BANA or French is selected, your further choices are severely restricted, because DBT 
follows BANA recommendations for Tables of Contents. You can select what Heading 
Levels are to be included. You can decide what text you want for left, center and right 
columns. That's it! 
NOTE: Unless you specifically wish to use the BANA or French Table of Contents 
Layout, you should select "Custom"  

2. Include Levels One Through: (default is 99) Your document may contain for example, 
DBT Heading Styles from H1. to H3. but you may only want the first two levels, H1. & H2. 
, to appear in the Table of Contents. You would therefore enter 2 in this box.  

3. Center Top Level: (Check Box)  

4. Number Top Level: (Check Box)  

The next three items are grouped together to define a Single Level Table of contents. 

5. Left Margin (Single Level): (Text Box)  

6. Runover Indent (Single Level): (Text Box)  

7. Right Margin (Single Level): (Text Box)  

The next five items are grouped together to define a Multi-Level Table of Contents. 

8. Left Margin for Level 1: (Text Box)  

9. Left Margin Increment: (Text Box)  

10. Runover Indent: (Text Box)  

11. Right Margin: (Text Box)  
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12. Always Use Maximum Runover: (Check Box) 

13. Centered Heading: Chapter  

14. Left Column Heading: Contents  

15. Right Column Heading: Page  

16. Character for Guide Dots: List Box - Choices are: Dot 3, 5 or 6, or dots 3 & 6.  

17. Use: List Box where you can choose either "Braille Page Numbers" or "Print Page 
Numbers".  

18. OK - Button  

19. Cancel - Button  

Note 1: It is essential to have Reference Page Numbers properly used in DBT if Print Page 
Numbers are to be used. 

Note 2: If you create a template from your braille document immediately after generating a 
table of contents, all of the options in this dialog are saved with the template. 

Note 3: In some cases, normally when creating a TOC with a pre 10.5 Template, you may see 
the following message. Answer "Yes" to have DBT correct the problem for you. 

Layout: Picture. 

Keystroke: d from Layout menu 

This menu allows you to insert or realign tactile graphics images produced using separate 
programs.  

Select Add... to insert a picture file at the current cursor position in your document. The picture 
will be centered horizontally on the page.  

When the cursor is resting on a picture, you can use Align Left, Align Center or Align Right to 
change the alignment.  

You can use the backspace or delete keys to remove the picture from your document. 

Resolution: Your "picture" will be produced using closely embossed dots. This setting controls 
how close together the dots are placed.  
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(Hint: it is often easiest to use enable View: Codes to determine for certain that the cursor is 
resting on a picture. The picture will show up as a [gd] code.) 

Note: Not all braille embossers can produce pictures, therefore you should refer to the 
manufacturer if you require further information. 

Warning: If you are using an interpoint (double-sided) embosser, you should be aware that 
you cannot have braille embossed on the back of any whole page containing a picture. You 
should check to ensure the document has embossed correctly. 

 

Layout: Code List... 

Keystroke: F5 or d from Layout Menu. 

The Code List dialog is used to pick a translation or formatting code from the entire library of 
possible codes. The dialog also displays some characters which cannot normally be entered 
directly using the keyboard. 

You can narrow down the codes displayed to certain categories, by checking the categories of 
code you would like to see displayed. Check 'All' to see all codes displayed. 

Choose an appropriate code or character from the list box control in the middle of the dialog. 
Next, if you need to enter parameters to the code, hit the tab key and then enter the 
parameters into the text box. 

To make the most of this dialog, you should be familiar with the DBT CODES QUICK REFERENCE 
document, which describes each code, and the Special Characters topic, which lists all available 
characters. These documents can be accessed through the Help menu. 

 
 

TABLES: (Menu) 

Keystroke: Alt + t 

Presently there are currently only two items in the Table menu. 

The “Create” item will insert a new [htbs] and [htbe] code into your document, so that you can 
enter a table of your own creation. It is enabled only when the cursor is placed outside of any 
existing tables in the document. 
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The “Table Properties” item is enabled only when the cursor is within an existing table. 

Table: Create 

Keystroke - k 

Table type: Allows you to tell DBT about the type of data in the table and the preferred method 
for formatting it. Choices include: 

Unrelated columns - which is for when you have material that should be formatted in columns, 
but is not really a table at all. Often, a vocabulary list will be handled this way. A list is not a 
table, but can be fit more compactly on the page if multiple columns are used. In DBT 11.1, it is 
possible to have DBT handle the formatting automatically by using the table formatter and 
selecting unrelated columns as the table type. One concrete effect of this selection is that there 
will never be any “leader” or “filler” dots between columns. 

Matrix - is an appropriate choice for a mathematical matrix. Other than unrelated columns, this 
is the only choice here that uses the table formatter to lay out text that is not truly part of a 
table. 

Table: [Automatic]: - is the default choice, and is the setting for all tables in a newly-imported 
document. This tells DBT that the material between the [htbs] and [htbe] codes really is table 
data and that DBT is to use its own discretion in choosing the most appropriate layout. 

Table: Columnar - tells DBT that the material is table data and that DBT should format it into 
columns, as is generally done in print documents. Unlike a print document formatter, however, 
DBT will not ever draw boxes around table cells but it will add “leader” or “filler” dots when the 
data for a cell falls short of the full column width. DBT automatically determines all column 
widths for columnar tables. 

Table: Stairstep - tells DBT to format the table data almost like an outline. Each new row starts 
with a new line on cell one. The second cell of each row starts on a new line on cell three. The 
third cell starts on cell five, and so forth. This format makes it fairly easy to scan down the left 
side of a page to find the start of each row. And it can fit fairly large tables, provided that the 
number of columns is not excessive. 

Table: Listed - tells DBT to use a format that repeats the contents of a header column at the 
start of each row and, within each row, repeats the column header (from the table’s first row) 
before placing the text for the row. The format is very useful for large tables that cannot easily 
be formatted in a columnar layout, especially when the data makes it hard to tell one column 
for another in isolation. For example, a table with all numeric data, where all the numbers have 
three digits, might work well in this format. The format does not work at all, however, unless 
there is one row of headers at the top of the table and one column of headers as well. 



Table: Paragraph - tells DBT to use a “fallback” or near “failsafe” layout for the table data. In 
this format, each table row is formatted as a single “paragraph”. A distinct text delimiter is 
placed between the text for adjacent rows. There is a special text delimiter to indicate the end 
of a row. There is also some distinct text used in place of an empty table cell. This format can fit 
a table of essentially any size. However, it requires that all tables be read in one direction only: 
across each row. To fully analyze the table, it is necessary sometimes to carefully count columns 
as one is reading, so that the location of data within the original table is clear. 

Table: Two-page - is like Table: Columnar, but the formatted result is wider and will be placed 
on facing pages. (It makes sense to do this only for double-sided braille printing.) 

X/Y Row/Column swap: tells DBT that it is OK to render the braille copy of the table as if the 
original rows were in fact columns, and vice-versa. In other words, when this is checked, DBT 
may invert the axes of the table. It will do this if that can help the table to fit on a braille page 
where it would not otherwise fit and if the result is still simple to read in the dominant “Reading 
order”. 

The “Total rows:” and “Total columns:” controls are useful only when creating a new table. Fill 
these in to tell DBT how many rows and columns of headers and data you will have. It will then 
add codes to delimit cells [>] and rows so that you can then use arrow keys to navigate through 
the table and enter the data. 

The “Header rows:” and “Header columns:” controls tell DBT how many rows and columns 
hold header labels instead of data. This is useful to ensure a proper formatting result. 

Tables: Properties 

This dialog is identical to The Create Table dialog, except that it permits you to change the 
table's attributes. 

Since your table already exists, the Total Rows and Total Columns fields will be grayed out and 
therefor not editable. 

DOCUMENT: (Menu) 

Keystroke: Alt + d 

DBT's Document menu contains settings that are stored with your document file. The 
document menu is initially set by the Template you pick when you first create or import your 
file. Don't worry about changing settings in the Document menu. The template will not be 
affected and neither will other documents created with the same Template. 

javascript:void(0);


The Document menu also contains commands that allow you to manage Templates, so you can 
preserve all the settings in the menu for later use. 

Document: Embosser Setup... 

Keystroke: Ctrl + F11 

Document: Embosser Setup is a new command in DBT version 10.5. In earlier versions of DBT, 

all embosser setup was done through the Global: Embosser Setup menu. DBT stores Sticky 
Document Information, including embosser setup, with each document. This allows you to 
more easily work with documents intended for different paper sizes, for example. It also means 
that, if you are updating from a previous version of DBT, you should get used to using this 
dialog -- Document: Embosser Setup -- to manage embosser setup on a document-by-
document-basis. 

This dialog is used to tell DBT how to format the current document. If the document is a print 
document, the formatting specified here will be applied only when the document is translated 
to braille. (Users of earlier versions of DBT take note: changes made here will not affect other 
documents.) The formatting details you can specify include the number of lines per page and 
cells per line. If you have an embosser that supports multiple paper sizes, you can also specify 
which paper size should be used for this document. Furthermore, if you have more than one 
embosser, you can specify which one should be used when embossing this document. All of this 
will be stored as Sticky Document Information when you save this document.  

1. The first control is a list of installed embossers. The most important thing you should understand 
about this control is this: the current document will be embossed using whichever embosser is 
highlighted when you click OK to exit the dialog. If you have only one embosser, this isn't usually 
a concern.  

2. A pull-down shows what forms, or paper sizes, are supported by your embosser. The name of 
the form you choose here is stored within the current document when the document is saved. 
So you can be sure that DBT will always format the document in a way that is appropriate for 
the form. (If you do not see the paper size you want, and you know that your embosser will 
support it, plus, you are not afraid of some technical work, click here to learn how to add a 
form.)  

3. Two edit controls allow you to specify how many characters per lines and lines per page. DBT 
automatically fills these in when you choose an embosser and paper size, but you can change 
the values.  

4. Two edit controls allow you to specify the top margin and binding margin for this document. 
Note that the characters per line value given above is in addition to the binding margin, and the 
lines per page value given above is in addition to the top margin. See also Note below regarding 
other constraints.  
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5. Three check boxes may allow you to enable or disable Embossing in Interpoint , Embossing a 
Banner Page, and Interline Print. Which of these options are available depends on the 
capabilities of your embosser. In some cases, enabling Embossing in Interpoint or Interline Print 
might reduce the number of lines that your embosser can fit on a page. DBT checks this for you.  

6. The OK button (or Enter) accepts all settings in the dialog and applies them to the current 
document only. If you have specified impossible values (e.g. 200 characters per line), then DBT 
corrects your values, tells you what has been corrected, and leaves the dialog opened for you to 
check investigate if you wish. If everything in the dialog is fine, then the dialog is closed. 
However, you may be warned if your document format is about to change; this is important 
because you may then want to regenerate a Table of Contents.  

7. The Cancel button is used close the dialog without saving anything. (Note that neither 
document format changes nor embosser list changes are saved if you click Cancel.)  

Read on to discover some ways that you can save time managing braille format settings for 
your documents, or read further on to learn about some things that may go wrong when you 
use Document: Embosser Setup. 

Time-Saving Tips 

Time-Saving Tip #1 

Despite the many controls, you can often get through Document, Embosser Setup using just 
three steps: 

1. Select the embosser to which you want to send the current document.  

2. Select the form (paper size) on which you want to emboss the current document.  

3. Click OK (or hit Enter). DBT automatically sets up your document as is usually appropriate for the 
selected embosser and paper size.  

Time-Saving Tip #2 

Use the Global: Embosser Setup dialog to set up the document format you most commonly 
use. Then you won't have to visit Document: Embosser Setup at all, for most documents. 

Time-Saving Tip #3 

Perhaps Tip #1 isn't working for you. You find that you cannot push OK directly after selecting a 
paper size because, for example, you wish to increase the binding margin and turn off 
Embossing in Interpoint. In this case, set everything the way you want it, make sure that its 
working by embossing the document. Then, create a Template from the document. The 
template will contain all the same Sticky Document Information as the current document. 
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When creating new documents, or importing documents from other applications, you'll just 
need to select your custom template and you'll be all set. 

Common Problems 

Common Problem #1: Confusing Global: Embosser Setup and Document: Embosser Setup 

If you've used versions of DBT earlier than 10.5, just keep in mind Document: Embosser Setup 
changes only the current document, while Global: Embosser Setup changes only the format of 

some documents yet to be created. (This is explained in detail in the help topic for the Global: 
Embosser Setup dialog.) 

Common Problem #2: Forgetting to use OK 

Even if you bring up the dialog just to manage the list of embossers (perhaps to add a new 
embosser), you must push OK in the Document: Embosser Setup dialog itself, or everything 
you've done (e.g. the addition of the new embosser) will be lost. 

Common Problem #3: Pushing OK too soon 

If you bring up the dialog to manage the list of embossers you must also be careful to check 
everything in the Document: Embosser Setup dialog itself before you click OK. Otherwise, you 
might be applying formatting changes without intending to. Remember that clicking OK causes 
DBT to apply all changes to the list of embossers and to apply all changes shown in the 
Document: Embosser Setup dialog itself to the current document. 

Document and Global: Printer Setup... 

Keyboard: Ctrl + F12 for Document, or from p from Global menu. 

It must be emphasised that this option only affects new documents, or those which are pre DBT 
10.5. To make changes to the CURRENT document, you MUST use DOCUMENT: Printer Setup.  

 

When you select this option, the following dialog will be displayed. 

Before making adjustments, be aware that there are two likely situations where you may want 
to "print" a document. (As opposed to embossing it) 

The first is to obtain a copy of your text document, and the second to obtain a print copy of 
your braille document. In the case of the latter, (often used by sighted braille proof readers) 
you need to take special care when setting up the Formatted Page Size. 
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Document: Page Numbering... 

Keystroke: n from Document menu. 

This dialog allows you to determine the positioning of page numbers in your braille document. 

Through five controls, the Page Numbering dialog is used to determine where page numbers 
will appear throughout your document. With the first four controls, you can tell DBT where to 
put page numbers as well as reference page numbers on both odd and even pages. There are 
choices for all corners of the page as well as none. You cannot place both types of page 
numbers in the same corner. For example, if you choose lower right for the reference page 
number on odd pages, you will find that lower right is not available for page numbers on odd 
pages. The fifth and final control is a text box in which you can tell DBT the first page on which 
to start displaying numbers. 

 

Document: Translation Tables 

Keystroke: t from Document menu. 

The translation tables determine the substitution rules used by DBT. Only one table can be 
picked for each document.  

For more details, please see: Language Translation Tables 

Duxbury is constantly working on both revisions to existing tables, and developing new tables. 
These pages should therefore be taken as a general guide, at the time the document was 
written. Each language Topic has a "References, History and Credits" section at the end 
providing details.  

 

Document: Learning Tables 

Keystroke: r from Document menu 

There are a number of approved braille teaching courses available. These courses are designed 
to teach braille in easy stages, adding wordsigns, contractions, punctuation, etc., over a number 
of lessons.  

This feature is in no way a substitute for these courses, but it allows you to produce additional 
braille material for students to help them become more familiar with what has been introduced 
at each stage.  

DBT currently includes 7 courses - BANA (2), BAUK (3) and UEB (2). 
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NLS I.M.B.T. (BANA) 

The first series of "select contractions" steps is based upon the "Instruction Manual for Braille 
Transcribers," (Fourth Edition, 2000) published by the National Library Service for the Blind and 
Physically Handicapped of the Library of Congress. The lesson numbers associated with the 
steps correspond to that document; the contractions are introduced as follows: 

Lesson 4.2: but, can, do, every, from, go, have, just, knowledge, like, more, not, people, quite, 
rather, so, that, us, very, will, it, you, as 

Lesson 4.3: and, for, of, the, with 

Lesson 5: ch, sh, th, wh, ou, st, child, shall, this, which, out, still 

Lesson 6: ar, ed, er, gh, ow, ble, ing 

Lesson 7.2: his, was, were, be, in, enough, en 

Lesson 7.5: con, dis 

Lesson 7.6: com 

Lesson 7.10: good, letter, little, paid, quick, said 

Lesson 8.1: to, into, by 

Lesson 8.2: bb, cc, dd, ff, gg, ea 

Lesson 8.3: about, above, because, below, children, first, great 

Lesson 9.1: day, ever, father, here, know, lord, mother, name, one, part, question, right, some, 
time, under, work, young, character, through, where, ought, there, upon, word, those, whose, 
these, cannot, had, many, spirit, world, their 

Lesson 9.7: according, always, braille, o'clock, perhaps 

Lesson 10.1: ound, ance, sion, less, ount, ence, ong, ful, tion, ness, ment, ity, ation, ally 

Lesson 10.2: across, almost, also, immediate, must, necessary 

Lesson 11 of the Instruction Manual introduces the final group, namely the short-form words: 
after, afternoon, afterward, again, against, already, although, altogether, before, behind, 
beneath, beside, between, beyond, blind, friend, together, could, should, would, either, 
neither, much, such, today, to-day, tonight, to-night, tomorrow, him, himself, its, itself, your, 



yourself, yourselves, herself, myself, oneself, ourselves, themselves, thyself, declare, declaring, 
rejoice, rejoicing, conceive, conceiving, deceive, deceiving, perceive, perceiving, receive, 
receiving 

This last level is not in the "Select Contractions" list, because inclusion of the short-form words 
amounts to full grade 2, which is selected simply by choosing "English/American (Literary)" 
without "Select Contractions". 

TSVBI Clusters (BANA) 

The second graduated contractions series is based upon the "Clusters" defined and used by the 
Texas School for the Blind and Visually Impaired. 

The complete TSBVI "Clusters" sequence is listed below. Note that Cluster 1 is equivalent to 
grade 1, and Clusters 54 and above are equivalent to grade 2. Those clusters that are omitted in 
the menu are marked with an asterisk (*). Apart from Cluster 54, the reason that the others are 
omitted is that they introduce no new contractions nor the letter sign: 

1: a, t, m 

*2: b, g, i 

3: a, that, more, but, go 

*4: capital, period, I 

*5: r, f, n 

*6: x, l, s 

7: rather, from, not 

8: it, like, so 

9: d, do, p, people, k, knowledge 

10: y, you, c, can 

11: h, have, o, question mark 

12: q, quite, u, us, comma 

13: w, will, e, every 



14: v, very, z, as 

15: j, just, and 

*16: (Reading exercises) 

17: mother, father, right, time, exclamation point 

18: lord, some, day, part, name 

19: know, young, here, one 

20: question, under, work, ever, apostrophe 

*21: number sign, numerals 

22: hyphen, numeric dates, letter sign 

*23: comma in large numbers 

24: the, there, braille, ing, him 

25: about, according, after, also, afternoon, afterward 

26: th, this, although, through, across, already 

*27: (Reading exercises) 

28: almost, always, blind, either, neither, ed 

29: of, by, myself, himself, itself, oneself, yourself 

30: had, quick, its, these, cannot, open quote, closed quote 

31: sh, shall, should, would, could, good, paid 

32: tion, er, herself, perhaps 

33: o'clock, was, con, cc, colon 

34: ou, out, ought, today, tonight, tomorrow 

35: for, ch, child, children, character, such, much 

36: ar, ound, above, en, enough 



*37: (Reading exercises) 

38: great, together, little, ow, ance 

39: be, bb, semicolon, spirit 

40: because, before, behind, below, beneath, beside, between, beyond 

41: sion, ble, his, your, friend, letter 

42: less, their, ourselves, yourselves, themselves 

43: with, st, still, first, must, again, against 

44: ount, dollar sign, decimal, cent, many 

45: percent, fraction bar, ity 

46: ence, altogether, immediate, com 

*47: (Reading exercises) 

48: wh, which, where, world, ea 

49: to, ff, in, into, those, said, ong 

50: word, were, gg, parentheses 

51: ness, ment, necessary, ally 

52: dis, dd, gh, ation, ful 

53: upon, whose, thyself 

*54: conceive, conceiving, deceive, deceiving, declare, declaring, perceive, perceiving, receive, 
receiving, rejoice, rejoicing 

*55: dash, ellipsis, asterisk, italics or underline 

*56: double dash, brackets, inner quotes, accent sign, termination sign, degrees 

Braille in Easy Steps (BAUK) 

by John Lorimer (revised by Claire Wilson, 2007) 



Duxbury Levels 

Because three letters are not introduced until Book 7 (j, q, z), but all other letters have been 
learned by the end of Book 4, this would have to be the first Duxbury level, with the three 
missing letters taught specially if they occur. So, the Duxbury levels would look like this: 

Book 4  

(note: letters j, q and z may occur which are not formally taught until Book 7) 

Pre-braille and tracking skills 

The alphabet (j, q and z not formally introduced, but may crop up) 

Wordsigns: but, can, do, every, from, go, have, knowledge, like, more, not, people, rather, so, 
that, us, very, will, it, you, and, of, the, in, into, was, in 

Contractions: and, of, the, ed, in 

Punctuation: full stop, question mark, exclamation mark, comma 

Other signs: capital letter sign (dot 6) 

Book 5 

Contractions: er, ing 

Shortforms: could, good, would 

Punctuation: apostrophe 

Book 6 

Contractions: st, ar, en, ea 

Wordsigns: still, enough 

Composite signs: one, time, there, had 

Shortforms: about, after, again 

Punctuation: Ellipsis 



Book 7 

Letters: j, q, z 

Wordsigns: which, his, just, quite, as, were 

Contractions: wh, ow 

5. after Book 8 

Wordsign: shall 

Contractions: gh, sh 

Shortforms: him, said 

Punctuation: quotation (speech) marks, hyphen 

Book 9 

Wordsigns: out, this 

Contractions: ou, th 

Composite signs: mother, father, some 

Shortforms: across, perhaps 

Book 10 

Wordsigns: child, for, with, be 

Contractions: ch, com, for, with, be, ble 

Composite signs: day, where, -ound, -less 

Shortforms: against, quick 

Other signs: numeral sign, decimal point (dot 2), mathematical comma (dot 3), pound sign (dots 
1-2-3) 

Book 11 

Contractions: bb, cc, dd, ff, gg, dis 



Composite signs: their, word, these, -ong, -ally, -ful, -ment 

Shortforms: although 

Punctuation: dash 

Book 12 

Wordsigns: by 

Contraction: con, 

Composite signs: here, know, ought, right, ever, through, work 

Shortforms: friend, must, your, today, tomorrow, tonight, afternoon, much, such, herself, 
himself, myself, yourself, above, before, below, beneath, should 

Other signs: italic sign, double italic sign, italic closure sign 

Book 13 

Composite signs: -ance, part, name, young, -tion, -ness, -ount 

Shortforms: because, behind, beside, between, beyond, children, great, its, little, afterwards, 
almost, always, first, together 

Punctuation: brackets 

By the end of Book 14, the cmplete contracted braille code should be familiar (see exceptions 
below - which would have to be explained if context did not make the meanings apparent) 

Book 14 

Composite signs: many, world, those, -ation, question, under, upon, -ence, -ity, -sion 

Shortforms: also, already, blind, braille, letter, paid, receive, receiving, themselves, either, 
neither, immediate, necessary 

Other signs: braille letter sign (dots 5-6) 



Not included in this course 

The following rarely used signs have not been taught in Braille in Easy Steps. The pupil is 
warned at the end of Book 14 that they may encounter some of these unfamiliar signs in their 
braille reading, and a list is given. 

Composite signs: lord, character, cannot, spirit, whose 

Shortforms: according, altogether, conceive, conceiving, deceive, deceiving, declare, declaring, 
itself, o'clock, oneself, ourselves, perceive, perceiving, rejoice, rejoicing, thyself, yourselves 

Punctuation: slash, square brackets, inner quotes 

Mathematical signs: plus, minus, multiplication sign, division sign, equals, per centage sign, 
fractions in braille, separation sign 

Other signs: bullet point sign (dots 4-5-6, dots 2-5-6), asterisk (dots 3-5 twice), ampersand (dot 
4, 1-2-3-4-6), accented letter sign (dot 4), Euro sign (dot 4, e) 

Fingerprint (BAUK) 

The "select contractions" step series is based upon the "Fingerprint" course originally 
developed in 1993 by the late Nigel Berry, Lecturer in Braille at the Royal National College for 
the Blind, Hereford, UK, and now published by the RNIB. The contractions are introduced in the 
following units: 

Unit 1: (equivalent to grade 1)  

Unit 4: as, but, can, do, every, from, go, have, it, just, knowledge, like, more, not, people, quite, 
rather, so, that, us, very, will, you  

Unit 5: about, above, according, across, and, after, afterward, afternoon, again, against, st, still  

Unit 6: almost, already, also, although, altogether, always, th, this, was  

Unit 7: be, because, before, behind, below, beneath, beside, between, beyond, were  

Unit 8: ch, child, children, could, either, first, friend, good, great, him, neither, sh, shall, should, 
would  

Unit 9: ar, er, immediate, its, letter, little, much, must, necessary, o'clock, paid, perhaps, said, 
such  

Unit 10: blind, braille, ing, quick, the, today, to-day, together, tomorrow, tonight, to-night, your  



Unit 11: ble, gh, of, wh, which, with  

Unit 12: ed, for, ou, out, ow  

Unit 13: by, enough, his, in (as word sign only), into, to  

Unit 14: cannot, had, many, spirit, their, these, those, upon, whose, word, world  

Unit 15: bb, cc, com, con, dd, dis, ea, en, ff, gg, in (general use)  

Unit 16: character, day, ever, father, here, know, lord, mother, name, one, ought, part, 
question, right, some, there, through, time, under, where, work, young  

Unit 17: ally, ance, ation, ence, ful, ity, less, ment, ness, ong, ound, ount, sion, tion  

Unit 18 (full grade 2 EXCEPT that the letter sign is not used): conceive, conceiving, deceive, 
deceiving, declare, declaring, herself, himself, itself, myself, oneself, ourselves, perceive, 
perceiving, receive, receiving, rejoice, rejoicing, themselves, thyself, yourself, yourselves  

Take Off Reading Scheme (BAUK) 

Take Off is divided into 12 levels, and a group of grade 2 braille signs is taught at each level. It is 
assumed that the following braille signs are already known when a pupil starts using Take Off: 

The alphabet 

All alphabetic wordsigns (excluding k for knowledge) 

Upper contractions: and, the 

Shortforms: good, little 

A small number of grade 2 braille signs are not taught at all in Take Off. These are: 

Afterward (afw) 

Braille (brl) 

conceive (CONcv) 

conceiving (CONcvg) 

deceiving (dcvg) 

lord (dot 5 l) 



oneself (dot 5 of) 

perceive (pERcv) 

perceiving (pERcvg) 

rejoice (rjc) 

rejoicing (rjcg) 

thyself (Thyf) 

The Italics signs and rules are also not covered. 

Take Off 

Series 1 

Upper contractions: for, of, ou, ing 

Wordsigns: out 

Lower contractions: in 

Series 2 

Upper contractions: with, ed, st, ar 

Wordsigns: still 

Lower contractions: to 

Shortforms: him 

Series 3 

Upper contractions: sh, th, er, ow 

Wordsigns: this 

Lower contractions: en 

Composite contractions: day 



Series 4 

Upper contractions: ch 

Wordsigns: child 

Lower contractions: was, into 

Composite contractions: one, some, time, there 

Shortforms: children 

Series 5 

Upper contractions: wh 

Wordsigns: which 

Lower contractions: ea, his, were 

Composite contractions: under, where 

Series 6 

Lower contractions: by 

Composite contractions: name, work 

Final groupsigns: ation 

Shortforms: friend, letter, again, about, your 

Series 7 

Upper contractions: gh, ble 

Lower contractions: bb, cc, dd, ff, gg, enough 

Composite contractions: father, mother, know 

Final groupsigns: sion 

Shortforms: great, together, said, himself, herself, myself, yourself, perhaps, also, its 



Series 8 

Wordsigns: shall 

Lower contractions: be, com, dis 

Composite contractions: cannot 

Final groupsigns: ong, ound, ence 

Shortforms: could, would, today, much, such, afternoon, tomorrow, tonight 

Series 9 

Composite contractions: right, here 

Final groupsigns: ance 

Shortforms: because, behind, should, always, o'clock, after 

Series 10 

Lower contractions: con 

Composite contractions: ever, part, through, many, their 

Final groupsigns: ount, ment, tion 

Shortforms: almost, first, above, quick, across, already, paid, before, beneath, beside 

Series 11 

Alphabetic wordsign: knowledge 

Composite contractions: question, ought, character, spirit, world 

Final groupsigns: less, ness, ful, ity, ally 

Shortforms: declare, deceive, against, immediate, receive, receiving, below, between, beyond 

Series 12 

Composite contractions: young, upon, word, these, those, whose 



Shortforms: according, themselves, must, neither, necessary, ourselves, either, yourselves, 
although, blind, altogether, itself, afterwards 

RNZFB STAR (UEB) 

The "RNZFB STAR" series is based upon the document entitled "STAR -- Order of introduction of 
braille signs," prepared by the Royal New Zealand Foundation of the Blind. The contractions are 
introduced in the following order: 

Level 1.1 Alphabet letter wordsigns: like, can, but, knowledge, it, people, every 

Level 1.3 Alphabet letter wordsigns: very, go, more, us, you 

Level 1.5 Alphabet letter wordsigns: have, rather, do, that, so 

Level 1.7 Alphabet letter wordsigns: from, just, quite, will, not, as 

Level 1.8 Shortforms: about, above, according, also, again, almost, blind, little, either, 
immediate 

Level 1.9 Shortforms: across, already, altogether, braille, could, deceive, deceiving, declare, 
declaring, good, great, him, its, letter, paid, said, receive, receiving, today, together, tomorrow, 
tonight, your, yourselves 

Level 1.10 Shortforms: after, afternoon, afterward, always, friend, himself, myself, necessary, 
neither, quick, rejoice, rejoicing, would, yourself, itself 

Level 2.1 Contractions: and, for, of 

Level 2.2 Contractions: the, with 

Level 2.3 Contractions: st, ar, ing, still 

Level 2.4 Contractions: ed, er 

Level 2.5 Contractions: ou, ow, out 

Level 2.6 Contractions: ch, gh, sh, child, shall 

Level 2.7 Contractions:: th, wh, this, which 

Level 2.9 Shortforms: themselves, herself, against, first, must, perceive, perceiving, perhaps 

Level 2.10 Shortforms: children, much, such, should, although, ourselves, thyself 



Level 3.1 Contractions: en, in (groupsign) 

Level 3.2 Contractions: be (wordsign) were, his, was 

Level 3.3 Contractions: enough, in (wordsign) 

Level 3.4 Contractions: be (groupsign) con, dis 

Level 3.7 Shortforms: before, behind, below, beneath, beside, between, beyond, because, 
conceive, conceiving 

Level 3.8 Contraction: ea 

Level 3.9 Contractions: bb, cc, ff, gg 

Level 4.1 Contractions (dot 5): day, ever, father, here, know, lord, mother 

Level 4.2 Contractions (dot 5): name, one, part, question, right 

Level 4.3 Contractions (dot 5): some, time, under, work, young 

Level 4.4 Shortform: oneself 

Level 4.5 Contractions (dot 5): there, where, ought 

Level 4.6 Contractions (dot 5): character, through 

Level 4.7 Contractions (dots 45): upon, word, these 

Level 4.8 Contractions (dots 45): those, whose 

Level 4.9 Contractions (dots 456): cannot, had, many 

Level 4.10 Contractions (dots 456): spirit, world, their 

Level 5.1 Contractions (dots 46): ound, ance, ount 

Level 5.2 Contractions (dots 46): sion, less 

Level 5.3 Contractions (dots 56): ence, ong, ful, ness 

Level 5.4 Contractions (dots 56) (Fully contracted UEB): tion, ment, ity 



S.A. Syllabus (UEB) 

The "S.A. Syllabus" series is based upon the document entitled "Syllabus -- Order in Which 
Braille Contractions Are Learnt", prepared by Reinette Popplestone for the University of Cape 
Town Disability Unit, for teaching English Braille to students in South Africa. The contractions 
are introduced in the following order: 

Level 1.1 Alphabetic word signs: but, people, can, quite, do, rather, every, so, from, that, go, us, 
have, very, just, will, knowledge, it, like, you, more, as, not 

Level 1.2 Five contractions: and, for, of, the, with 

Level 1.3 Initial-letter contractions with dot 5: day, part, ever, question, father, right, here, 
some, know, time, lord, under, mother, work, name, young, one, there 

Level 1.4 Two related contractions: these, their 

Level 2.1 Short forms: about, good, above, great, according, him, across, immediate, after, little, 
afternoon, letter, afterward, necessary, again, neither, also, paid, almost, quick, already, said, 
altogether, today, always, together, blind, tomorrow, braille, tonight, could, would, either, its, 
friend, your 

Level 2.2 Group signs: gh, ed, er, ow, ar, ing 

Level 2.3 Group signs which also have a word meaning: ch, child, sh, shall, th, this, wh, which, 
ou, out, st, still 

Level 2.4 Initial-letter contractions with dots 45 and 456: upon, cannot, word, had, those, many, 
whose, spirit, world 

Level 2.5 Two lower contractions: en, in (as part-word only) 

Level 3.1 Lower group signs: ea, be (as part-word only), bb, con, cc, dis, ff, gg 

Level 3.2 Lower word signs: be, enough, were, his, in, was 

Level 3.3 The remaining initial-letter contractions: character, through, where, ought 

Level 3.4 The remaining short forms: against, itself, although, yourself, declare, yourselves, 
declaring, themselves, deceive, children, deceiving, should, first, thyself, himself, ourselves, 
herself, because, myself, before, must, behind, much, below, perhaps, beneath, perceive, 
beside, perceiving, between, receive, beyond, receiving, conceive, rejoice, conceiving, rejoicing, 
oneself, such 



Level 3.5 Terminal group signs: ound, ence, ance, ong, sion, ful, ness, tion, ount, ment, ity, less 

Level 4.1 Contractions from pre-unified code: o'clock, ble, com, dd, to, into, by, ation, ally 

Note: Level 4.1 is, naturally, not relevant when Unified English Braille is the basis of the series as 
level 3.5 constitutes fully contracted UEB. 

Document: Hyphen Table. 

Keystroke: h from Document menu 

When converting print to braille, DBT needs to have some set of rules to determine where 
braille hyphens may occur. Only one table can be selected for any given document. 

None is a hyphen table that will not allow braille words to split across lines. 

Dashes is a table that will allow a braille word to split across a line at a dash. 

Dashes and Hyphens is identical to dashes, except that it also allows a braille word to break at 
an explicit hyphen in the text. 

French is a hyphen table that will actively hyphenate French braille words at the ends of lines. 
This table may only be used with the French translation table, and not with any other table. 

Note: The preferred Hyphen Table name can also stored in the DBT document template. If you 
wish to do this, you should open the appropriate Template, apply the above, and re-save your 
Template using the same name. 

 

Document: Add Style... 

Keystroke: a from Document menu 

You can use this menu feature to create your own styles. 

When you select Document: Add Style..., in which you should enter a name for the new style. If 
you do not, warning box will be displayed. 

Unless your new Style is to apply to an entire paragraph, check the box marked "Style can be 
nested within another style." 

You may also select an existing style on which to base the new one. 

You may now enter Beginning Codes and Ending Codes as required. 
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See also: Document: Modify Style... 

 

Document: Modify Style...  

Keystroke: m from Document menu 

The modify style dialog box is used to modify styles that come with DBT, or that you have 
created previously. Changes that you make in this way will affect only the current document 
and any templates that you create from the current document. (It will not affect the template 
from which this document was created.) 

The only enabled controls are a list of existing styles and a few buttons. Select an existing style 
in the list, then click OK or push Enter to proceed to another dialog shown below, where you 
can change the beginning codes and ending codes associated with that style. 

To enter a code, position your cursor where the code is to be placed. Hold down the Ctrl key 
and press the left square bracket. You will now find that a pair of square brackets appears in 
the Beginning Codes: box. Type the appropriate code, in this case ii. You may continue adding, 
deleting or amending code as required. 

When you Enter, or click on the "OK" button, the following prompt will come up (if you have 
actually made any changes.) If you do not wish to save changes, press Esc or click on the "No" 
Button 

From the main dialog, you may use the "Rename style" button instead of the OK button. This 
will cause DBT to prompt you for a new style name, instead of new beginning and ending codes. 

 

Document: Delete Style... 

Keystroke: d from Document menu. 

The Delete Style dialog box is used to remove an existing style from the list of those available 
within the current document. There is only one control: a list of existing styles. 

Be careful not to remove any styles that have been applied in the current document; the 
formatting effects would be lost as a result. 

Note: Using this dialog will delete the style from this document only. The definition of the style 
will remain in any other documents where it is already defined. The style also remains defined 
in the template from which this document was created. 
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Document: Create Template... 

Keystroke: c from Document menu. 

The Create Template dialog box is used to save, for future use, all settings in the Document 
menu, including style additions, modifications and deletions. Text may optionally be stored. 

Templates will also store printer and embosser settings, and from DBT 10.6 and above can store 
custom settings for a Table of Contents. 

There are four controls in the main dialog, plus a OK and Cancel button. 

Create new Template: The first is a text box for the name of the template. If you are replacing 
an existing template, tab to the next field without entering any text. 

Replace Existing Template: This list box contains list of all existing templates for reference. 
After adding a template, it will be available the next time you import a document or create a 
new one. Please note that the Templates are displayed in alphabetical order. 

You may also replace a previously created Template if you wish by highlighting it in this list. 

NOTE: You will not be allowed to replace most default Templates supplied with DBT 

Use customized Word style map: Check this box only if you have created your own customized 
.MWS file to improve imports of Word documents into your template. 

Table of Contents Options: If you wish, you may customize your Table of Contents settings. 
(The default settings will be for the BANA Layout) For more detailed information about TOC 
Options, please see Layout: Generate Table of Contents. 

Word Style Map: If you have checked the above box, you may now highlight one Word Style 
Map from the list. Your own .MWS file will appear in this list only after you've copied it to the 
Templates subdirectory of the DBT installation. 

If you select the OK button, you will then be prompted with the following dialog asking you if 
you wish to include any text in the document as part of the Template. This can be a most useful 
feature if for example, you wished to perhaps create a personalized letter heading Template. If 
you do not wish to include text, press the Cancel button. 

Note: If you use an existing Template Name, you will be warned. This will however allow you to 
replace an existing Template should you wish, and also to modify an existing one. 
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IMPORTANT: If you try to overwrite one of DBT's default Templates, you will receive yet 
another warning dialog. Press the OK button (or Esc) to return to the previous dialog, where 
you should press Cancel (or Esc) to return to the main dialog and type a new Template name. 

Additional Information: 

For more information about mapping Word Styles to DBT Styles may we suggest you begin at 
Word Style Maps. These can be a major long term labor saving feature. 

 

Document: Delete Template... 

Keystroke: l (is in Lima) from Document menu 

The Delete Template dialog box is used to remove a template from the list of those available 
when importing or creating a new document. 

There is only one control: a list of existing templates.  

You will be asked to confirm your choice. 

Note: DBT's own default templates, cannot be removed. You will receive the following warning. 

 

GLOBAL: (Menu) 

Keystroke: Alt + g 

After you have installed DBT for the first time, you will need to attend to a few "house-keeping" 
exercises, such as setting up your braille embosser and ink printer. 

Global: Embosser Setup... 

Keyboard: e from Global menu. 

(Advanced Users - See also Editing the emb.elt file.) 

This module is purely to enable you to set up one or more embossers on your system, and to 
allow you to specify a default embosser for all new documents. If you wish to change the 
embosser or its settings for an individual document, (new or existing) you MUST do this in 
Document: Embosser Setup. 
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The Global: Embosser Setup dialog is used to tell DBT about your braille embosser. You must 
normally have at least one embosser (Brailler Device) set up on your system, but you may now 
have as many devices as you like. See Additional Notes at the end of this topic for more 
information. 

Brailler Device: (Selection/List box) During the DBT installation process, you may have chosen 
to install one or more embossers. If so, they will appear in this list. If the list only contains "(No 
Target Embosser)", and you wish to set one up, tab to the "New" button, and press Enter. 

New: This button will take you to the Embosser Setup: General Tab, which is one of three tabs 
where you may begin the setup process. (If you are setting up a new embosser, may we suggest 
you click on the above link now.) 

** Modify Embosser: Before you click this button, please ensure that you have highlighted the 
embosser you wish to edit in the Braille Device selection list. This button will also take you to 
the Embosser Setup: General Tab. 

** Remove: If you wish to remove an Embosser Device, please ensure it is highlighted in the 
Brailler Device list first, before pressing the "Remove" button. [Note: You cannot remove the 
"(No Target Embosser)" entry. ] You will be asked to confirm that you wish to remove the 
selected embosser as shown below. Press the "Yes" or "No" button as appropriate. 

Note: If you remove any Brailler Device, DBT sets the Brailler Device to "(No Target Embosser)". 
In such circumstances, you will only have the Characters per line and Lines per page options 
available.  

There are however limitations in so much as you may only select between 10 and 160 
Characters per line, and between 4 and 40 Lines per page. 

 

(** The "Modify Embosser" and "Remove" buttons will be disabled if a user will be unable to 
save changes to the configuration. So, restricted users in Windows XP will find that these 
buttons will often be disabled. In Vista, they will often be disabled if a user has not run DBT 
"As Administrator".) 

 

Desired Braille Document Formatting - This section contains 8 controls. However, it is 
important to appreciate that entries here may be constrained by settings in the Global: 
Embosser Setup - Device Settings tab. For example, if you have set up a Top Margin of 2 in 
Device Settings, you cannot have a Top Margin of less than 2 in this section. 

Characters per line: Enter your desired characters per line, excluding the binding margin. 

mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/the_menus/MENU_GLOBAL/global_embosser_setup.htm#Additional_Notes
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/the_menus/MENU_GLOBAL/Global_Embosser_setup_general.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/the_menus/MENU_GLOBAL/Global_Embosser_setup_general.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/the_menus/MENU_GLOBAL/Global_Embosser_setup_settings.htm


Lines per page: Enter your desired lines per page, excluding the top margin. 

Top margin in Lines: Enter your desired top margin in lines. 

Binding margin in characters: Enter your desired margin in characters. 

Now we have three check boxes which may or may not be grayed out. Availability of these 
items is controlled by capabilities of your selected embosser. 

Emboss in Interpoint: This will only be available if your embosser supports Interpoint (or 
double-sided) embossing. 

Banner Page: This is an additional page which is embossed at the beginning of each file your 
emboss giving basic file information. 

Interline Print: This will only be available if your embosser supports Interline Printing or if you 
are using the TranSend SE 

 

If you are satisfied with your changes, press the OK button. If you wish to abort this process and 
return to DBT, press the Cancel button. 

Please note that pressing OK is this main dialog not only confirms any changes made 
to this dialog, but also any made to the General, Devices Settings and Advanced 
dialogs. 

Take special care to ensure that you have highlighted the Brailler Device which you 
wish to be your default for any NEW documents created. 

 

Additional Notes: Remember that DBT's files now contain "Sticky Document Information". In 
simple terms, when you save a file, it also saves a variety of details, such as your Brailler Device. 

Templates also contain this "Sticky Document Information". If you commonly work with two or 
more paper sizes, we recommend that you generate a template for each paper size. 

 

Global: Embosser Setup: General. 

When you select "New" from the Global: Embosser Setup dialog, you will be presented with the 
following dialog. 
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This dialog contains four tabs. "General", "Device Settings" "TranSend SE" and "Advanced". 

Embosser Model: This is a drop-down list containing an alphabetic listing of all supported 
makes and models of braille embosser. Note however that Generic embossers are at the top of 
the list. 

If your embosser is not listed, then select "Generic" if your embosser embosses on just one side 
of the page, or "Generic Interpoint" if it embosses on both sides of the page. 

Setup Name: You may leave this field blank, in which case, DBT will simply use the name of the 
embosser you selected above. However, you may type in a free-format name of your own 
choice. (See Additional Notes for more information) 

Configuration Location: A drop down list with two choices a) The current user, or b) All users of 
this computer. 

Network administrators should be aware that "Current User" essentially stores this 
configuration on the User's Profile. Hence care should be taken if Roving Profiles are in use. If 
you are setting up a model installation for replication throughout a network using a network 
installation image, then you should set the Configuration Location for all embossers to "All users 
of this computer". DBT's installer supports automatic migration of embosser configurations set 
this way, using a network installation image. 

 

Output Options - here you have one choice out of 3 Radio Buttons 

1. Send to Printer: If you have installed your braille embosser as a Windows Device, or to 
use Windows drivers, you should normally find it listed here. (You can use this option 
only if your braille embosser shows up among the printers in Windows' Printers Control 
Panel.)  

2. Write to Port: If your embosser is not listed above, you may select a Parallel Port (lpt#), 
or Serial Port (com#) from the list box.  

3. Write to File: There are occasions when you may wish to braille embossing output direct 
to a file. Normally you should leave this field blank, in which case you will be prompted 
for a file name each time you emboss using this Brailler Device. Otherwise you may 
enter a path and file name as appropriate.  
You should also be aware that if you specify a file name, the file will be overwritten 
without prompting, therefore you should only specify a file name in exceptional 
circumstances.  
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Serial: This section will be grayed out unless you have selected a Serial (com#) device. Enter the 
parameters for Baud Rate, Parity, Data Bits and Stop Bits and Handshaking as required. 

If you are using a Serial Device, please consult your manual or supplier for appropriate details. 

 

Global: Embosser Setup: Device Settings 

When you select Device Settings from the quad-pane window, the dialog may not appear as 
shown in the example below. There is a simple explanation for this. 

What appears is entirely dependent on which Brailler Device you have selected in the General 
tab. 

For many modern embossers, little or nothing appears in this panel. This simply means that DBT 
doesn't need additional information to drive your embosser correctly. 

In the example shown below, we have an Enabling Juliet Pro 60 with the “Left Margin (first 
cell):” set at 1, the "Rightmost cell placement:" set at 40 and the "Top margin setting:" set at 0. 
These are the factory default settings for the embosser that will produce a 40 character line.  

Allow escape codes - checking the "Allow escape codes" check box allows you to temporarily 
override some of your embosser settings using the settings from Document: Embosser Setup 
(Ctrl-F11). 

Interpoint Embossing is Enabled - checking the "Interpoint Embossing is Enabled" check box 
tells DBT that your using an interpoint embosser. This checkbox enables special pagination 
control for interpoint embossers. 

This dialog contains four tabs. "General", "Device Settings", “TranSend SE” and "Advanced". 

In the following example shown below, we have the same Enabling Juliet Pro 60, which is set up 
to “Allow escape codes” and has speech. 

Allow escape codes - checking the "Allow escape codes" check box allows you to temporarily 
override some of your embosser settings using the settings from Document: Embosser Setup 
(Ctrl-F11). 

Manage ET Speaks - checking the "Manage ET Speaks" check box allows you to silence the 
speaking of escape sequences. 

Leave ET Speaks On - checking the "Leave ET Speaks On" check box allows you to force speech 
at the end of a document. 
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Send Seek Top of Form - checking the "Send Seek Top of Form" check box allows DBT to send 
an automatic top of form control to supported embossers. 

This dialog contains four tabs. "General", "Device Settings", “TranSend SE” and "Advanced". 

The remaining three List Boxes, "Output encoding", High punctuation" and "Letter case" 
should only be changed in very exceptional circumstances.  

 

Global: Embosser Setup: TranSendSE 

When you select an Enabling Technologies embosser from the “Brailler Device” list and select 
"Modify Embosser" from the Global: Embosser Setup dialog, you will be presented with the 
following dialog under the “TranSend SE” tab. 

This dialog contains four tabs. "General", "Device Settings" "TranSend SE" and "Advanced". 

Below these tabs is a drop-down combo box containing three items, the first item in the drop-
down “Choose a Supported Printer:” contains an alphabetic listing of all supported makes and 
models of print printers that are supported with TranSend SE. The second item in the drop-
down “Choose a Supported or Compatible Printer:” contains an alphabetic listing of all 
supported or compatible makes and models of print printers that are supported with TranSend 
SE. The third item in the drop-down “Choose any Printer:” contains an alphabetic listing of all 
print printers that are installed on your computer. 

Font: You may select any font installed in your computer for the print output for the selected 
printer. 

Font Size: Selects the size of the print printer font. 

Ink Placement Adjustment: Lets you adjust the physical horizontal and vertical offset from the 
left margin of the print document.  

 

Global: Embosser Setup: Advanced. 

When you select "Advanced" from the Tri-pane window, the following dialog will appear. 

WARNING: Do not make any changes to this dialog unless you know precisely what you are 
doing! 
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With the vast majority of Brailler Devices, you will not require to make any changes to this 
dialog unless specifically advised by either Duxbury Systems Inc. or your embosser 
manufacturer. 

However if you are faced with a device which is unlisted or unknown to DBT, you may find this 
useful in some areas. 

Return to Embosser Setup Topic (or continue at your peril!) 

This dialog contains four tabs. "General", "Device Settings" "TranSend SE" and "Advanced". 

Job Setup - checking the "Use custom job setup" check box allows you to enable "Job start 
codes" and "Job end codes", described below. 

Job start codes: Text that you type here will be sent to the embosser after any setup sequence 
(e.g. escape codes) that DBT normally sends when starting to emboss. The additional text that 
you add to the setup sequence may be used for any purpose. However, it is best to avoid using 
this feature to redefine the form length, the braille cell size, or the interline spacing of the 
braille. Any change to these characteristics will not be recognized by DBT, and so DBT will not 
create a document properly formatted for the page. Text that you type here may be any 
printable ASCII character (including space, but excluding less-than and greater-than), or any of 
the following special sequences:  

 <esc> Escape (ASCII 27)  

 <lf> Line Feed (ASCII 10)  

 <ff> Form Feed (ASCII 12)  

 <cr> Carriage Return (ASCII 13)  

 <ctrl-@> NUL (ASCII 0)  

 <ctrl-A> Control-A (ASCII 1) 
...  

 <ctrl-Z> Control-Z (ASCII 26)  

 <lt> Less-than (ASCII 60)  

 <gt> Greater-than (ASCII 62)  

Job end codes: Text that you type here will be sent to the embosser before any job-ending 
sequence (e.g. escape codes) that DBT sends on its own. Text may contain the same ASCII 
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printable characters and special sequences as are defined for Job start codes. Job end codes are 
often left blank even when Job start codes are used. 

A user of the Gemini embosser might enter <esc><esc>Q to enable double-sized interline print 
and/or <esc><esc>D to enable double-striking of the braille. Note that neither of these changes 
affects the form size or the layout of the braille on the form. 

 

End of line and page - These options control what device Control Codes are produced at the 
ends of lines and pages. 

End of line indicator: Normally DBT will send a CR/LF Control Code at the end of each line. 
However, if you have opted to Write to file, with a view to processing that file on a non-
Windows or non-DBT system, you may make an appropriate selection here. 

End of page indicator: As with End of line indicators, you may wish to select a more suitable 
option here. 

EOL on a full line: Check this box if you wish to add an End of Line Code even when the line 
contains as many braille cells as the embosser will support. Many embossers automatically skip 
to the beginning of the next line in this circumstance, so it can be important to leave this option 
un-checked. 

EOP on a full page: Check this box if you wish to add an End of Page Code even when all 
possible lines contain braille. Many embossers automatically skip to the top of the next page in 
this circumstance, so it can be important to leave this option un-checked. 

Pad lines: Some devices need to see at least a few characters on each line. Checking this box 
will therefore cause spaces to be added at the end of any lines that are blank or very short.  

Prompt for new sheet: Checking this box causes DBT to pause after each page has been sent to 
the Braille Device. This can be useful if for any reason you have to feed each page of material 
manually into the device. 

 

Timing: This is a highly technical area, but basically it controls how long DBT waits after sending 
a text character or control character. It is enabled only when "Write to Port" is selected in the 
General tab. DBT normally maintains Timing values as is appropriate for the device and port you 
select; you should only change these values if you are having extreme difficulty interfacing a 
device. 
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Document and Global: Printer Setup... 

Keyboard: Ctrl + F12 for Document, or from p from Global menu. 

It must be emphasised that this option only affects new documents, or those which are pre DBT 
10.5. To make changes to the CURRENT document, you MUST use DOCUMENT: Printer Setup.  

 

When you select this option, the following dialog will be displayed. 

Before making adjustments, be aware that there are two likely situations where you may want 
to "print" a document. (As opposed to embossing it) 

The first is to obtain a copy of your text document, and the second to obtain a print copy of 
your braille document. In the case of the latter, (often used by sighted braille proof readers) 
you need to take special care when setting up the Formatted Page Size. 

Printer...: (Button or press Alt + p) 

It may seem odd to start at the end of the dialog, but in fact we do need to select an ink printer 
before we can make appropriate changes to the main dialog. This will bring up another dialog 
(not shown here), enabling us to select a printer which is already installed on the system. From 
the Name: drop down list box, select the printer you wish you use for all printing. 

Properties: (Button) This will bring up yet another dialog which shows the Properties for the 
selected printer. This will be a dialog appropriate for the printer selected, and as these vary 
considerably, we suggest you may wish to refer to your printer manual for a detailed 
explanation. 

Network: (Button) If the printer you wish to use is on a Network, this will bring up the standard 
Windows Network Printer dialog appropriate to your operating system. If you are unsure about 
this function, please refer to your system manager or administrator. 

When you have selected your printer, press OK to return to the main Global: Printer Setup 
dialog and proceed as follows: 

Paper 

Size: This is a drop down list box which enables you to select the size of paper to be used for 
printed output. The list of sizes available in determined by the make & model of printer 
selected. 



Source: Some printers allow you to feed paper in a variety of ways. Some also have multiple 
paper trays to enable you to select different types and colour of paper. Again, what is available 
is dependent on the make & model of printer selected. 

Orientation 

Radio Buttons - Portrait or Landscape. 

Margins 

This allows you to enter Left, Right, Top and Bottom margins. 

Formatted Page Size 

You may enter Lines per page and Characters per line here. However - please note the 
following: 

1. DBT uses whatever font and point size you have selected in the Global: Fonts option for its 
printed output. You may therefore have to experiment to ensure that your output fits the 
selected paper size. For example, with 22 point Braille or SimBraille font, you will only get 
around 25-26 lines per page, and 30 - 32 characters per line.  

2. These settings will be ignored if you have checked "Auto-determine point size for printed 
output" in the Global: Fonts option.  

If you are happy with your changes, press the OK button, or to leave without making any 
changes press the Cancel button. 

 

Global: Autosave Options 

Keystroke: a from Global menu. 

By default, Autosave is turned on in DBT and defaults to 5 minute intervals. Essentially this 
feature will save files which you have opened, and made changes to, at pre-determined 
intervals. The dialog which appears as show below is relatively simple, with just three options. 

Enable autosave: is a checkbox. If you do not wish to use the Autosave feature, uncheck this 
box. 

Path for unsaved files: By default, autosaved files will be stored in your My Documents folder, 
within a folder called "DBT Autosaves". If you wish these files to be saved elsewhere, you may 
provide an alternative path. 

Note: "DBT Autosaves" is a Hidden Folder, and cannot normally be seen within My 
Documents unless you have elected to show hidden files on your system. 
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Autosave every (mm:ss): The default setting is 5 minutes, however you may enter a longer or 
shorter period as required. 

 

For details of how to use the Recovery Wizard to recover files, please see the next topic: 
Autosave Recovery Wizard 

 

Global: DBT Autosave Recovery Wizard: 

Should your system fail for any reason while using DBT, next time you run this program, you will 
normally see the Recovery Wizard screen appear. This gives you the option to recover any 
document(s) you had open, but had not saved during your last DBT session. 

Please note that if you open a document, and do not make any changes, it will not be listed. 

The DBT Autosave recovery Wizard dialog will appear next, showing a list of the files which have 
been autosaved. You have a choice of three buttons explained below. Note that focus will 
normally be on the "Open" button. 

Exit: Select this button if you do not wish to proceed. DBT display the following dialog. Click the 
OK button, and DBT will exit. You will see the following dialog advising that The Recovery 
Wizard will be displayed again when DBT is next launched. Click OK or alternativel click Cancel if 
you wish to return to the Wizard. 

Open: This will open all documents in DBT which have been autosaved. To see what has been 
opened within DBT, go to DBT's View Menu, at the foot of which is a list of Active Documents. 

 

Finish: When you click this button, the following warning screen comes up advising you that 
you have not recovered all your unsaved documenst. 

If you click Yes to the above dialog, you will get one last chance. Think carefully before you click 
Yes on the following message! Technical Note: Autosaved files are stored in a hidden folder 
named "DBT Autosaves" within My Documents. You should not make any changes to the files 
within this folder, but be aware that if you are backing up My Documents after a failure, you 
may wish to include Hidden Files. 
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Global: Default Views... 

Keystroke: d from Global menu 

Each setting in this dialog corresponds to a setting in the View menu. When a new document is 
created, by using File, New, importing a document, or translating an existing document, the 
state of the View menu is derived from the settings here. Some of these settings apply only to 
print documents or only to braille documents. Whenever you open a document that was 
previously saved in DBT, the View menu is set as it was when the document was saved. The 
settings in this dialog affect only newly-created documents. 

Any setting here can be changed for an individual document via DBT's View Menu. 

Font for Translated Braille Line: This choice of 3 radio buttons for what is displayed in a line 
displayed at the foot of the screen, and can be "Print", "Braille" or "SimBraille". You can select 
whether or not this line is displayed by default in DBT, or you can toggle it on or off within the 
program with the command Ctrl + F8. 

Show full page in print documents: Check this box if you always wish to see the whole print 
page on your screen. Please bear in mind that what you actually see is largely dependent on 
what your PC's monitor can display. 

Show codes in print documents: Check this box if you wish to display DBT's codes by default. 
This is more useful for experienced users. 

Show translated line in print documents: Check this box if you wish to display the translated 
line at the bottom of the DBT screen. This will then display an appropriate translation of the 
print line your cursor is located on. See Important Note below. 

Default font for braille documents: This choice of 3 radio buttons what is displayed in a line 
displayed at the foot of the screen, and can be "Print", "Braille" or "SimBraille". You can select 
whether or not this line is displayed by default in DBT, or you can toggle it on or off within the 
program with the command Ctrl + F8. 

Show full page in braille documents: Check this box if you always wish to see the whole print 
page on your screen. Please bear in mind that what you actually see is largely dependent on 
what your PC's monitor can display. 

Show codes in braille documents: Check this box if you wish to display DBT's codes by default. 
This is more useful for experienced users. 

Show translated line in braille documents: Check this box if you wish to display the translated 
line at the bottom of the DBT screen. This will then display an appropriate translation of the 
braille line your cursor is located on. See Important Note below. 
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Six key entry in braille documents: Check this box if you wish the default typing mode to be six-
key entry. That is, using the keys f d s and j k l as dots 1 2 3 and 4 5 6 to enter text. (Subject to 
suitable keyboard) 

Important Note: The translated line is provided primarily as a general guide for forward and 
backward translation of literary braille. It should not be assumed as definitive output. 

 

Global: Internationalization 

Keystroke: i (as in India) from Global menu. 

Please take VERY careful note of the tip below!!!!!  

Subject to availability, you may now select a different language interface within DBT. Therefor if 
you select Dansk for example, all your menus and dialogs will appear in Danish. 

In some instances, you may need to perform additional tasks in order to set up Duxbury for 
your own country/locale. You local dealer is best placed to advise you on any necessary 
requirements here. 

Should you change the Braille code for display, you will need to restart DBT for the change to 
take effect. You will also receive the following warning dialog. 

TIP: Try to remember this now - it could save you an anxious 
telephone call! 

If you come in to school one day, to find one of your clever students has played a trick on you, 
and changed language, don't panic. Click on the last but one menu item towards the right at the 
top of the screen. This should bring up what is effectively the Global menu. Go down to the fifth 
item, and click on it. The Internationalization dialog will come up, and hopefully you will be able 
to select your own language. 

(The following shows what it would look like in Russian) 

Global: Fonts... 

Keystroke: f from Global menu 

This dialog allows you to select default screen and printer font and size. 

There are 8 controls in this dialog. 
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1. Print Font: A list Box which allows you to select which font you wish to use when you 
print a DBT document. Note that only fixed space fonts are listed here.  

2. Print font size for screen display: Text Box. Enter the point size you wish displayed for 
screen print matter.  

3. Braille/SimBraille font point size for screen display: Text Box. Enter the point size you 
wish displayed when either Braille or SimBraille font are displayed on the screen  

4. Auto-determine point size for output - Check box. If this box is checked, DBT will 
automatically re-size any ink printed text or Braille. If checked, the next two items will 
not be available to you  

5. Print font point size for printed output: Text Box. Allows you specify the size of font 
used in printed DBT text documents  

6. Braille/SimBraille font point size for printed output: Text Box. Allows you to specify the 
point size of ink printed braille. Note: 24 point is close to actual size  

7. Cancel. Button. Click button or press Esc to exit this dialog without making changes.  

8. OK. Button. Click or press Enter to confirm your changes. The dialog will now close.  

 

Global: View Preferences... 

Keystroke: v from Global menu 

This is a simple dialog which controls four viewing elements. 

Margin bell position: This feature is ONLY available when using 6 key entry with a braille file. 
This feature is much the same as the bell on a Perkins brailler, and indeed you will hear an 
actual Perkins bell sound though your computer's sound card. (Assuming you have one) 

In the illustration above, the sound will be emitted when you reach the 5th last cell on the line. 
To turn the feature off, enter a position of zero. 

See TIPS below for more information. 

Use verbose labels for non-ANSI characters in coded view: This can be an especially useful 
feature, especially when characters appear identical, such as with "Ζ and Z". (Can you see any 
difference?) 

Were we to check this box, when we go into Coded View (Alt + F3) we would see the text 
appear as "{Zeta} and Z" indicating that the first character is the Greek Capital Zeta as opposed 
to a normal capital letter Z. 
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Note that in some cases, you may instead see a DUSCI value. For example ژ (Arabic letter Jeh) 
would appear as {D+E148}. 

Show Cursor Locator - This provides a means of showing where the cursor is located by 
displaying a series of rings round the location of the cursor, and can be very useful when editing 
and translating documents. 

Three check boxes give you options of when the cursor locator will be displayed: 

1. When a document is opened or translated. (Remember that the last cursor location is 
stored with all saved documents. The cursor is also positioned in the translated 
document as close as possible to where it was located in the text document)  

2. When Switching views.  

3. When the Shift key is pressed.  

If you do not wish to see the Cursor locater at all, simply uncheck all three boxes. 

Note: Some communication software such as Microsoft Remote Desktop Connection, requires 
that special cursors be turned off. 

Six-key Key Set: You can use what is called "Six-key Entry" to input braille direct into DBT 
documents. This is a facility which can be very useful when you require a specific permutation 
of dots. Checking this box will enable the use of the fds and jkl keys to represent dots 123 and 
456 respectively. 

However, if these keys are not suitable, or perhaps do not work on your keyboard, you may 
select a different combination here. 

IMPORTANT NOTE: Not all PC keyboards will support Six-Key Entry. However, some will allow 
you to use alternatives such as ewq and op[  

Unfortunately there is no magic solution for keyboards which do not support Six-key Entry. 
However generally speaking, keyboards at the lowest end of the price range are most likely to 
work. 

TIPS:  

1. If you wish to play a different sound, you can replace the "margin.wav" file found in the 
duxbury program folder (normally c:\Program Files\Duxbury\DBT 11.1). It will play your 
wave file instead. You can use any existing wave file of your choosing, but note that you 
MUST rename the file to margin.wav.  
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2. You may wish to adjust the volume of the bell, especially if using a screen reader. This 
can be done through Windows Sound Recorder. (All Programs, Accessories, 
Entertainment, Sound Recorder) Open the margin.wav file, then select Increase or 
Decrease Volume from the Effects menu.  

 

Global: Shortcut Preferences... 

Keystroke: s from Global menu. 

This option should generally be left as shown above. 

It has been provided to resolve a specific situation relating to a particular International version 
of DBT. 

The purpose of this option is to allow for variations in the codes inserted for the various 
shortcut keystrokes listed in the dialog below: 

The defaults for English are: 

Insert for Grade 0 = (Alt + 0) which generates the code [cz] 

Insert for Flush Right with Leader = (Alt + F7) which generates the code [fr;p~".] 

Insert for Computer Braille = (Alt + 3) which generates the code [cb] 

Insert for New Line = (Enter) which generates the code [<] 

Insert for New Page = (Ctrl +Enter) which generates the code [pg] 

If you wish to find out more about what these codes do, please refer to the alphabetical listing 
of codes in DBT Codes Quick Reference and subsequent "Tell me more" buttons. 

 

Global: WordPerfect Importer... 

Keystroke: w from Global menu 

The WordPerfect Importer dialog tells DBT how to import WordPerfect coded files. There are 
seven controls.  
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First is a check box to optionally translate any Courier text into CBC. Use this feature with 
caution; if Courier happens to be the default base font, the entire document may come out in 
CBC instead of grade 2.  

Next is a check box to force a new braille page wherever a hard page break exists in the print. If 
you are highly concerned with paper conservation, leave this option unchecked. Otherwise, 
check the box so that your print and braille formats more closely resemble each other.  

Third is a check box to reduce three or more hard returns in the print so that only one skipped 
line appears in braille. It is not customary to have more than one blank line in braille so you will 
generally want to keep this box checked.  

Fourth is a check box to tell DBT that you wish to indicate print page breaks with a line of dots 
across the page. Be sure to use this feature when producing a braille document in Textbook 
format.  

The next control has four choices for paragraph style. DBT will automatically create a braille 
paragraph (a new line with indent to cell three) whenever it comes across the pattern you 
choose. Choices are (1) None -- DBT formats the braille the same as the print, (2) Skipped Line -- 
DBT converts [HRt][HRt] to a braille paragraph, (3) Newline Tab -- DBT converts [HRt][Tab] to a 
braille paragraph (4) Skipped Line with Tab -- DBT converts [HRt][HRt][Tab] to a braille 
paragraph.  

Next is a text box control to enter a number representing the ratio of braille cells to either 
inches or centimeters. DBT will use this number to honor WordPerfect's Tab and Indent 
commands by converting them into braille characters.  

The last control tells DBT whether the number you set in the previous control is in inches or 
centimeters. Normally you'll want to leave the last two controls at their default values of 0.25 
and Inches, respectively. 

 

Global: Word Importer... 

Keystroke: r from Global menu 

(For more in depth detail, please see DBT's Word Importer Explained) 

The Word Importer dialog allows you to control specific aspects of how DBT handles the import 
of Word. All options except the last are Check Boxes. 

Transcribe Courier to CBC - (Check Box) - Any Word text which is in Courier font will 
automatically have the appropriate Computer Braille Code applied in DBT. 
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Preserve hard page breaks - (Check Box) - DBT will put the New Page code in wherever Word 
has a hard page break. (NOTE: Soft page breaks are ignored) 

Preserve Skipped Lines - (Check Box) - Where there is a Hard Carriage Return on a blank line in 
Word, DBT will also insert a blank line code. (Note: Take care that what appears to be a blank 
line, is actually a blank line, and not "White Space") 

Print Page Breaks: - (List Box) -  

1. Ignore - Page breaks in the Word document will be ignored.  

2. Mark from Word document This will insert "Print Page Indicators" at the appropriate 
point in the document. Care should be used when using this option. These are usually 
only required for documents such as school exercise books, or minutes of a meeting, 
where the print page numbers are often referred to.  

3. Treat hard page breaks as print page breaks - A "Hard Page Break" is one which is 
inserted into a Word document intentionally using the Word command Ctrl + Enter.  

(Note: Many Word authors will use the Enter key to force text on to a new page. This will NOT 
cause a new page in a braille document.) 

4. Use publishers' <ipp no=#> reference page tags - Some publishers are now providing 
electronic files where the print page number is defined within HTML/XML Style tags. If 
this box is checked, DBT will insert appropriate "Print Page Indicators".  

Treat Braille & SimBraille fonts as braille - (Check Box) If you have used these two fonts in your 
Word document, they will be imported into DBT exactly as is. i.e. They will not be translated in 
any way. 

Allow embedded DBT codes, eg. [[*pg*]] - (Check Box) It is now possible to include DBT Codes 
in a Word document, provided they are enclosed as shown here. 

Unknown characters: - (List Box) - This is a List Box. Should the import process not recognize 
any special characters in Word, it will by default place an asterisk in the DBT print text 
document. If you open the List Box, the following will appear. 

The additional choices allow you to replace unknown characters with an asterisk (*), ignore 
them, or to output their value in Unicode. See Troubleshooting: Word - Missing or wrong 
characters in the on-line help files. 

Note: If you are unfamiliar with Unicode characters, and you are encountering problems, please 
contact Technical Support. You might also like to look at the Special Characters Topic. 

mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/POPUPS/Unicode.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/troubleshooting/Word_-_Missing_or_wrong_characters.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/troubleshooting/Word_-_Missing_or_wrong_characters.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/getting_setup_in_DBT/new_users_start_here/GETTING_HELP.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/miscellaneous/Special_Characters/special_characters.htm


Ignore: - There are four check boxes here. 

1. bold - Check this if you do not wish to show bold indicators in your Word document.  

2. italics - Check this if you do not wish to show italic indicators in your Word document.  

3. underline - Check this if you do not wish to show underline indicators in your Word 
document.  

4. language switches - Word can have a nasty habit of automatically adding language 
indicators when you don't want them. Check this to have them ignored.  

 

Global: Formatted Braille Importer... 

Keystroke: b from Global menu 

See also: BRF files - Importing 

The Formatted Braille Importer dialog is used to inform DBT about the dimensions and page 
numbering conventions of the braille files you wish to import. DBT can import BRF files from 
older DBT versions, as well as PokaDot and other braille files. Note that DBT uses these settings 
for import analysis only. In other words, the incoming file will be reformatted to the dimensions 
set in the Global Embosser Setup dialog or template, using the numbering scheme set in the 
Document Menu, regardless of what numbers are filled in here. 

There are 11 Controls in this dialog. 

The Check Box, "Read formatted braille without interpretation". When this is checked, most of 
the other controls on the dialog are disabled. 

Next are two groups of Radio Buttons to tell DBT in what corners it can expect to find braille 
page numbers on even and odd pages, respectively.  

The next two radio controls work the same as the first two, but they refer to the print page, as 
used in Textbook braille format.  

Next are two additional radio groups in which you can tell DBT to where it will find (if any) 
running headers and running footers, respectively.  

The final two groups are text controls to tell DBT the dimensions, in characters, of the 
formatted ASCII braille file. The lines per page is a maximum value (which should be set higher 
than the actual format) while the cells per line should be set for the exact width of the pages in 
your BRF, or equivalent, file. 
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Note: By their nature, formatted (ASCII) braille files are stripped of all format and translation 
codes. To get the file ready for editing, DBT interprets the format and adds codes accordingly. 
Because an interpretive process can go wrong, we recommend, whenever possible, that you 
use the source TXT or WP file instead of the BRF for importing. 

 

Global: Hyperlink Settings 

Keystroke: h from Global menu. 

HELP: (Menu) 

Keystroke: Alt + h 

Help: Help Topics... 

Keystroke: h (from menu) 

You will find that many topics can be accessed directly from DBT's menus and dialogs by 
pressing the F1 key. 

For example, if you were in the dialog for creating a new document, and wanted Help, just tap 
the F1 key, and the appropriate Help topic will be displayed. 

To close Help, hold down the Alt key and tap the F4 key, and you will be returned to your 
previous position. 

 

Help: Translate 

Keystroke: t from Help menu. 

Note: You will require an Internet connection for this feature to work. 

When you select this option, you will be directed to a special web site which will allow you to 
select a language of your choice. Click on the appropriate flag. 

You will then be presented with a similar structure to the Help system you are viewing now, 
and will be able to browse the system in your chosen language. 

Please however be aware that the translation is done by a web based computer program and 
therefore cannot be assumed to be 100% accurate. 



Help: Favorite Topics... 

Keystroke: f (from menu) 

You may find Topics which you wish to refer to on a regular basis. If you add Topics to your 
Topical Favorites in the normal way, you may use this menu shortcut to get to them quickly at a 
later stage. 

 

Help: New in 11.1. 

Keystroke: n from Help menu 

This will take you to the What's New Topic where you will find details of new features in this 
version of DBT which did not exist in previous versions. 

 

Help: Registration... 

Keystroke: r (from menu) 

We cannot stress enough the importance of Registering your copy of the Duxbury Braille 
Translator. Amongst other benefits, this will ensure your eligibility to receive free updates via 
the Internet.  

If you wish to register on line now please click the Registration item in DBT's Help menu. 

If you do NOT have an Internet connection, you may use the form provided at Installation: 
Registration Form. 

 

Help: Check for Updates... 

Keystroke: r (from menu) 

In due course, there may be updates released for DBT. Selecting this option will start your web 
browser, which will in turn go to our Update Web site, where it will advise you if any updates 
are available. 

 



Help: About DBT. 

Keystroke: a from Help menu 

Help: About DBT. 

Keystroke: a from Help menu 

Help: About DBT. 

Keystroke: a from Help menu 

There are three very important items on this screen which you will require if you contact 
Duxbury or your Duxbury dealer for any reason. The Version number and date which may 
follow, and the license number. 

If you are using a screen reader, simply pressing the tab key will allow you to hear the Version 
and License Number. 

Please Note: The Single-user license number "DBT K1234-5678" is purely for illustrative 
purposes. 

If for any reason you require to remove DBT from your system, for example, to install on 
another system, you must uninstall first.  

You should also uninstall DBT if you require to change any hardware on your system. 

Fuller details are provided in the Registration and Activation: Remove DBTtopic. 

 

Word - Top 10 Guidelines 

(For Making Your Documents Braille-Ready) 

DBT includes two Word for Windows add-ins, SWIFT and the BANA Template, which help to 
make transcribers' lives easier when working with Word. 

However not all Word users are "braille aware", nor wish to be. You might wish to print this 
topic out and pass it round colleagues who prepare Word documents. Generally speaking, it will 
not cause extra work, and in fact might help them to use Word more efficiently. 
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Here are 10 very basic rules for making a Word document which will look good and make good 
Braille (and Large Print). 

1: Use Styles  

2: Don't Confuse Headers And Headings  

3: Don't Just Format A Piece Of Text  

4: Use The Minimum Of Styles  

5: Do You Really Need That Image?  

6: Do You Really Need That Table?  

7: Do You Really Need That Text Box?  

8: Don't Use Tabs And Spaces To Position Text  

9: Don't Use The Enter Key Twice  

10: Use Control + Enter to Force a New Page  

1: Use Styles - The Most Important Rule!  

All the Styles you need are set up in Word already: many Heading Styles all the way from 
Heading 1 on down, Normal for your body text, Index Styles, Table of Contents Styles, List 
Styles; these are all available in the Normal template. If you use these Styles, a Word document 
will translate into quite reasonably-formatted Braille. 

When you use Styles, you have the added benefit that when you want to change the font, size 
or emphasis of a Heading, you only need to change the Style once - your changes are then 
applied automatically to every occurrence of that Style in the document. 

2: Don't Confuse The "Header" Style With "Heading" Styles 

A Header Style is used for the document header. This is a piece of text that is repeated at the 
top of every page; it is not a Heading! For Document, Chapter and Paragraph headings, you 
need a Heading Style. If you use a Header Style in the body of a document, Duxbury will not 
import it!  

The picture shows part of a Word document showing both a Header and a Heading: the 
Heading is part of the body text, while the Header is in a box of its own. The Styles dialog to the 

right shows the two styles. 
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3: Don't Just Format A Piece Of Text - Format The Whole Style 

If you think you need a sub-heading, apply one of the lesser heading Styles; don't just embolden 
and change the font size when you're using Normal Style. That said, bold, underline and italics 
are fine for emphasis within a paragraph; they can be translated into the correct Braille code to 
emphasize the text. 

This is a Heading 

This is a Heading which just "looks" like one! 

The lines above show two visually identical-looking lines of text. However one has the Heading 
1 Style applied, and the other is Normal Style text which has had the font size changed and Bold 
applied. They look the same, but only one will come into a Duxbury document as a proper 
Heading. 

 

4: Use The Minimum Of Styles 

Keep your document plain, elegant and readable. Concentrate on content rather than looks. 
Keep to a single topic per paragraph, and resist the temptation to fill your document with fancy 
fonts, size changes, orientation changes and colours. It won't help your readers to understand, 
and it will be lost on the Braille readers - if in fact all the content can be brought into Duxbury in 
the first place. 

And don't mistake pictures of text as real text! WordArt does not translate into Braille, even if it 
looks colourful on the printed page. 

You can make a beautiful document using three Heading Styles and the Normal Style; this 
allows you four fonts and four colours, one for each Style.  

5: Do You Really Need That Image? 

If you must use images, diagrams, plots and graphs, and the information is crucial to all your 
readers, make sure that they can be rendered as tactile graphics - otherwise that information 
will be lost to Braille readers. If you are using the Word drawing and graphics tools, make sure 
that the image is saved into a separate file for rendering as a graphic, and that there is a note in 
the body text to alert the Braille reader to the graphic and its relevance. 

You can add a note to an image easily by putting a descriptive line immediately underneath it: 
this might contain a Figure number that the braille reader can use to refer to the corresponding 
tactile graphic. In the example above, we have used a Text Box to contain the description. In 



this case, the Braille reader might not gain anything from having a tactile rendering of the 
image, but they should know it was there in the original. 

 

6: Do You Really Need That Table? 

Is a table really the only way to represent this information? They can be great visually, but a 
very complex table, or one with a lot of columns, can be impossible to render in Braille; the 
Braille page has, at most, half the carrying capacity of the print page. Try blowing your font size 
up to 22, and see how much of your table is visible. 

If your table is too complex, can you split the information in some way? Can it be rendered in 
text instead? 

Be careful also that you don't embed images into your tables; the information in them is lost to 
the Braille reader. 

7: Do You Really Need That Text Box? 

If you're using a text box to position text on the page, remember that you can do this with 
indent; this will look just as good, and won't cause such problems to the Braille transcriber. 

If you're using the Text Box to mix graphics and text, it's actually an image you're making. How 
will the Braille reader access this information? Can it be rendered as a tactile diagram? Duxbury 
brings in text boxes, but at the point they are placed – which can cause confusion; make sure 
your Text Box is placed in the proper place in the text so that the information flows smoothly, 
and use some extra text to describe the graphical contents. You can include the descriptive text 
inside the Text Box, or - if you have to put the original text Box out of sequence - you can use 
another Text Box to refer to it by Figure number. 

8: Don't Use Tabs And Spaces To Position Text On The Page  

You shouldn't need to use tabs at all; use styles instead, which won't do strange things to your 
Braille layout. Word has an in-built style called Normal Indent. It looks like this: 

This paragraph is Normal Indent Style. 

When this paragraph is imported into Duxbury, it will be treated as if it is formatted in Normal 
Style - it won´t be indented in your Braille file. If you need more indents, set up some more 
Word Styles for larger indents; you do this by choosing Format, Styles and Formatting, and 
clicking New Style. 

9: Don't Press The Enter Key Twice At The End Of Each Paragraph  



For each Style you are using, select Format: Style and click the Modify button. In the Modify 
Style dialog box, select Format: Paragraph. Next, in the Spacing section, change the After box to 
12 (or whatever spacing you want). This will eliminate the need to press the Enter key more 
than once between paragraphs, and will make the work of the Braille producer much easier. 

This is the button to click to show you where all the extra line-breaks are. You only need one at 
the end of each paragraph; if you can see a column of them like this, your styles need a little 
work! 

10: Use Control + Enter to Force a New Page 

The way to begin the next part of your text on a new page is to enter a hard page break. You do 
this by pressing Control+Enter. Duxbury will not preserve this in your Braille document unless 
you set the Word Importer to do so; generally, you will not want to preserve hard page breaks, 
unless you are beginning a new Chapter in a book. 

So if you have another column of paragraph marks (remember the button to click?), backspace 
them into oblivion and press Control+Enter. You will then see a nice clean page break, Like this! 

SWIFT  

SEND WORD (TO DUXBURY) IMMEDIATELY FOR TRANSLATION.  

What does it do? 

SWIFT is a Microsoft Word template that will allow you to send the current document to the 
Duxbury Braille Translator, without having to manually start DBT and use the File Open dialogue 
to load the document.  

It can also send the current Word Document, translated by DBT, directly to the Braille embosser 
with no user intervention required. 

In addition, it can send the current document, translated by DBT, to an ink printer using the 
SimBraille font.  

Version 2 added 3 new commands. 

The ability to format Hyperlinks so that they are brailled according to CBC rules by DBT.  

A “Style Mapper” so that you can customize the way DBT translates user defined Word Styles. 

Also, the ability to undo the changes made by the “Style Mapper”, restoring the settings to 1 of 
2 backups. 



Version 3 added 2 new commands which allow the user to format acronyms and abbreviations 
so that they are brailled correctly by DBT, without changing the appearance of the original 
document. 

Version 3.2 Added one command which can produce a new Word document showing various 
properties of the styles available in the current document 

What’s New in Version 10.7 

Although this version does not contain any new features, some of the existing features have 
been modified and a number of changes have been made to make SWIFT compatible with DBT 
10.7. 

As explained in the “Notes”, above, the template is now named “SWIFT.dot”. If an older version 
of the template is installed, called something like “DBT#.dot”, it will be necessary to remove the 
file as explained later. 

Unlike previous versions, this template does not have a version number. Instead, the Custom 
tab of the File Properties dialogue shows “SWIFT for DBT 10.7”. Selecting the file in Windows 
Explorer, under Windows XP, this information will also be displayed on the status bar. 

The reference to DBT 10.7 is very important as this version of SWIFT will not work with any 
earlier versions of DBT 

As DBT 10.7 stores its templates and .mws files in a “Templates” sub-folder, SWIFT takes 
advantage of this and places its acronym (.acr) files in the same folder. Any .acr files created for 
use with an earlier version of DBT, will need to be manually copied to this folder. 

For the current Word document to be embossed correctly, any changes to the document must 
have been saved. If the document has not been save, SWIFT will now prompt the user to do so. 

DBT cannot import any Word documents that need a password to open them. Any attempt to 
send a password protected document to DBT will cause SWIFT to display a warning message 
and the procedure will be cancelled. 

SWIFT no longer saves the current document as “DBTTemp.doc”, prior to sending it to DBT. 
Instead, it sends the original file. 

As DBT 10.7 supports the use of multiple .mws files, SWIFT’s Style Mapper now displays a list of 
these files. 

The Style Mapper now includes the main 33 DBT styles, and any “User Defined” styles from the 
selected .mws file. 
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Important Notes 

Previously, the Word template was called “DBT#.dot”, where # represented the version OF THE 
TEMPLATE. However, as it is often referred to by the acronym “SWIFT”, the FILE is NOW called 
“SWIFT.DOT”. In case you are wondering, it stands for “Send Word immediately for 
Translation”. 

It is likely that this will be the last version of SWIFT to be produced. Of course, minor changes 
may be made to fix any problems that users discover and to keep the product compatible with 
future versions of DBT. 

Any feedback can be sent either to the Duxbury mailing list, to Duxbury Systems. 

Jan 2011 

 

System requirements. 

 Microsoft Word 2000 or later. (Word 97 may not cause a problem, but this is no longer a 
supported application)  

 Windows XP or later.  

 Duxbury Braille Translator for Windows, version 10.7 or later.  
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Note: This version of SWIFT has not been designed to work with the Duxbury Braille Translator 
version 10.6 or earlier. For DBT upgrade details, please contact Duxbury Systems Inc., or your 
local supplier. 

 

How to install and remove. 

DBT’s Setup program will install SWIFT.DOT into DBT's installation folder. 

DBT itself installs it to each user's Word Startup folder as each user runs DBT. There is no longer 
a need for the user to do this manually. 

To remove SWIFT, or one of its earlier versions, simply navigate to Word’s Startup folder and 
delete the file. Earlier versions will have a name like “DBT#.dot”, where “#” is a single digit 
representing the version number. For example, “DBT2.dot”. 

The location of Word’s Startup folder can vary depending on the version of Windows in use, 
whether the machine has one or many profiles, and whether you performed a default or 
custom installation of Word/Office.  

For example, in the case of a Windows XP single-user system, with a default installation of 
Word, the path is probably: 

C:\program files\microsoft office\office\startup  

In the case of a Windows Multi-user system, with a default installation of Word, the path is 
probably: 

.....\WORD\STARTUP folder for the appropriate user. 

SWIFT in no way makes any permanent changes to MS Word or to Windows. Deleting the 
template from the “Startup” folder will remove “DBT” from the menu bar and remove the 
“DBT” toolbar. 

If you have any doubts about the Startup folder used by Word, please contact your local 
technical support or see Getting Help. 

 

How to use SWIFT 

There are 3 options for running the Duxbury Braille Translator from within MS Word, 5 options 
to control the formatting of the translation, and a Word Styles Lister. These commands can be 
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accessed either from the “DBT” item on the main menu bar or from one of the buttons on the 
“DBT” toolbar. 

If the "DBT" toolbar is not visible, go to the View menu and select Toolbars. Ensure that "DBT" is 
checked. 

Note that the document must be saved before it can be sent to DBT. If the current document 
has not been saved, SWIFT will prompt the user to do so. Pressing “Yes”, will save the 
document and allow the procedure to continue. Pressing “No”, will cancel the procedure. 

Duxbury Braille 

Selecting this command will display the Duxbury Braille Translator’s Import dialogue where you 
can select the required template. The Import Filter will already be set to "Microsoft Word 6 or 
later".  

Press the OK button and the text of the Word document will be displayed in DBT’s print 
window.  

Exiting DBT will return the focus to MS Word. 

Emboss Direct 

This command will open the document in the Duxbury Braille Translator using the users default 
DBT Template, translate the text into Braille, send it to the default embosser, and close DBT 
with no user intervention. 

 

Print Braille 

This command will open the document in the Duxbury Braille Translator using the users default 
Template, translate the text into Braille, send it to the default printer, and close DBT with no 
user intervention.  

For this to work correctly, DBT must be set-up as follows: 

1. In the “Global” menu select “Default Views”. “Default font for braille documents” must be set to 
SimBraille.  

2. In the “Global” menu select “Fonts”. “Auto-determine point size for printed output” must not be 
checked.  

 



Format Hyperlinks 

Note. As DBT 10.6 and later now correctly translates Hyperlinks in a Word document, this 
command should no longer be needed. However, the feature is being kept available for the 
time being. 

This command will modify the font of any text in the document where the style is set to 
“Hyperlink”. This will allow the Duxbury Braille Translator to correctly format the output of 
a Hyperlink using Computer Braille Code (CBC). 

When the “Format Hyperlinks” command is run a warning message is displayed. Select “No” if 
you do not wish to modify the document. 

Selecting “Yes” will cause the font of any Hyperlink to be changed to “Courier”. The Hyperlink is 
still valid and its colour, point size, and underlining are not affected. 

For this change to have the desired affect you need to tell the Duxbury Braille Translator to 
convert Courier text to CBC, as follows. 

1. In DBT, select the “Global” menu.  

2. Select “Word Importer”.  

3. Make sure that “Transcribe Courier to CBC” is checked.  

4. Now press the “OK” button. The setting will be saved for future use.  

 

Style Mapper 

This command allows you to customize the way the Duxbury Braille Translator will respond 
when importing a Word document containing custom styles. 

When the “Style Mapper” is activated a dialogue will be displayed showing a list of available 
Style Maps. These are files stored in DBT’s Templates sub-folder with a .mws extension. In the 
dialogue, the file names will be shown without there extension. Previous versions of DBT used a 
single Style Map called “DBT.mws”. DBT 10.5 has the ability to work with other Style Maps 
created by the user. 

To work with an existing Style Map, simply select the file from the list, and either press the 
“Enter” key or press the “Continue” button. The usual Style Map to use is “DBT”. 



To create a new, empty, Style Map, press the “New” button or press “Alt+n”. A dialogue will be 
displayed asking for the name of the new file. Enter the name and either press the “OK” button 
or just press “Enter”. 

To create a copy of an existing Style Map, first select the map you wish to copy from the list.  

Next, check the “Create Copy” check box. 

Lastly, press the “New” button or press “Alt+n”. A dialogue will be displayed asking for the 
name of the new file. Enter the name and either press the “OK” button or just press “Enter”. 

Once a new Style Map has been created a confirmation message will be displayed. Press the 
“OK” button and the Style Mapper will begin. 

The Style Mapper will start at the top of a document and navigate forward a paragraph at a 
time, until the end of the document. With each new paragraph the Word style is compared to a 
list of those already mapped according to the Style Map in use. 

If the style of the current paragraph is not mapped, a dialogue is displayed. Here the name of 
the unmapped Word style is displayed along with a list of available styles. This list includes the 
following: 

a. The 33 most basic DBT Styles.  

b. “User Defined”. Selecting this and pressing “Enter” or the “Apply” button will display a 
dialogue where the user can type in the name of the DBT Style to be mapped to the 
Word Style. Please make sure that the name is typed exactly and that the style does 
exist in the template to be used when the document is embossed.  

c. A list of those DBT Styles that already exist in the Style Map, other than the 33 basic 
styles.  

Note that this list is not sorted alphabetically. Hence, the 33 basic styles will always be at the 
top of the list and user defined styles will be at the bottom.  

Selecting one of the “DBT Styles” in the list will display a brief description at the bottom of the 
window.  

Press “Apply” to have the Word style mapped to the selected DBT style. As this is the default 
button, keyboard users can just press “enter”. 

Press “Skip” to avoid mapping the current Word style. The Style Mapper will continue 
navigating through the document. The keyboard shortcut for this button is “ALT + s”. 



Press “Cancel” to quit the Style Mapper. Keyboard users can press “ESC” OR “ALT + c”. 

When the Style Mapper has completed the document, a message will be displayed showing the 
number of Word styles that have been mapped to DBT styles. Press “Yes” to add these changes 
to the selected Style Map. 

Pressing “No” will cause the Style Map to remain unchanged. 

Once the Style Map has been updated, the user will be prompted to emboss the document. 
Pressing “Yes”, will send the document to DBT, forcing it to import the document based on the 
settings in the selected Style Map. 

In the event that the Style Mapper comes across a Word Style that is already mapped, but set 
to be “Ignored” a warning message is displayed. 

The warning message will give you the chance to edit the style. Selecting “Yes” will cancel the 
Style Mapper and place the cursor at the beginning of the offending paragraph. If some styles 
have already been mapped then you will be prompted to save the changes first. After editing 
the style, select the “Style Mapper” command again to continue. 

In the event that a document contains a “Text Box” it will not be possible for the Style Mapper 
to complete the document. However, all the text in the main body of the document should be 
mapped; only the text in the text box cannot be accessed with normal cursor navigation.  

When the Style Mapper cannot complete the document for any reason, a warning dialogue will 
be displayed. Those styles which have already been mapped can still be applied. 

 

Restore Styles 

This command gives you the chance to “Restore” the file containing the list of mapped styles to 
1 of 2 previous versions. 

Note that this only applies to the default Style Map "DBT.mws” and not to any other files. 

You will first be prompted to restore from the last backup. A backup file is created whenever 
changes are written to the DBT Style Map. 

Simply select “Yes” or “No”. 

If “No” is selected you will be asked to restore from a backup file which was created the first 
time the “Style Mapper” was used. Under normal circumstances, this will be a copy of the file 
that was originally created when the Duxbury Braille Translator was installed. Again, simply 
select “Yes” or “No”. 



 

Append Acronym 

This command is used to add the current word to an Acronym Table. 

Place the cursor immediately before or within an acronym or abbreviation and select the 
“Append Acronym” command. The acronym/abbreviation must be a single word with no 
punctuation.  

A dialogue box will be displayed containing an edit box, a list box and 2 buttons. 

Although the edit box does permit you to change the acronym, before adding it to the table, 
this should never be necessary. 

The list box allows you to choose an Acronym Table. If no acronym tables exist in DBT’s 
Templates folder, a “Global” table is created. 

Pressing the “Append” button will add the contents of the edit box to the selected table and 
close the dialogue. As the “Append Button is the default, keyboard users can just press “enter”. 

Pressing “Cancel” (or the “Escape” key) will close the dialogue and no changes will be made to 
any acronym tables. 

NOTE: Please take time to study the Acronym Tables Topic. This will help you to determine if 
it is necessary to save the acronym to a table other than Global. 

 

Acronym Tables 

Choosing this command will display a dialogue where you can “manage” your Acronym Tables. 

Again, the list box will display all the Acronym Tables in DBT’s Templates folder. If no tables are 
found, a “Global” table is created. Either press the “Cancel” button (or the “Escape” key) to 
close the dialogue, or select a table and press one of the buttons, as explained below. 

Apply Table 

Pressing the “Apply” button will cause changes to be made to the current document based on 
the contents of the selected Acronym Table AND the “Global” Table. That is to say, the “Global” 
table is ALWAYS applied to the document. If an other table is selected, then it is also applied to 
the document.  
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As the “Apply” button is the default, keyboard users can just press “Enter” after selecting the 
required table. 

The contents of the table(s) are read into an area of memory. This area can hold a maximum of 
1000 entries at a time. Therefore, the total number of acronyms in the Global Table plus one 
other table (if selected) should not exceed 1000. 

A warning dialogue will be displayed asking if you wish to modify the current document. 
Selecting “No”, will cancel the operation and return focus to the document. Selecting “Yes”, will 
start the process. 

The process of modifying acronyms and abbreviations first moves to the start of the document. 
Then it navigates to the end of the document, a word at a time, comparing each word with 
those in the selected acronym table(s). Obviously, for a very large document there could be a 
slight delay while this process takes place. Any time a word matches an entry from the selected 
acronym table(s), its Word Style is changed to “Acronym”. The font is not changed. Hence, the 
documents appearance will not be changed. However, if after the command is complete, you 
move the cursor to a word that has been modified, the Style dropdown in the Formatting 
Toolbar will show “Acronym”. 

When the process is complete, a dialogue is displayed showing the number of changes. Pressing 
“OK”, will return focus to the document and the cursor will be at the beginning. 

If you use the “Style Mapper” command after applying the “Acronym” style, you may be 
prompted to map the Word Acronym style. Simply map it to the DBT Acronym style. See above 
for details. 

Open Table  

Pressing the “Open Table” button (the keyboard shortcut is Alt + o) will display a dialogue 
where you can modify the contents of an existing table.  

The contents of the table are displayed in a list box, in the order in which they were added to 
the table. 

New entries can be added to the table by typing into the edit box. To get to the edit box from 
the list box, press “Shift + tab”. After typing, press the “Add Item” button, or just press Enter. 

The new entry will be added to the end of the list and focus will be placed on the list box. You 
can repeat this process as often as required. 

Existing entries can be deleted by selecting the item in the list, then pressing the “Remove 
Item” button. The keyboard shortcut is “Alt + r”. 



When you have finished making alterations, press the “Close” button, or the “Escape” key. If 
changes have been made, you will be prompted to save the table.  

After Pressing either “Yes” or “No”, focus will return to the “Acronyms Table” dialogue. 

New Table 

To add a table to the list, press the “New Table” button. You will be prompted to enter the 
table name. There is no need to include an extension as “.acr” will be added automatically. 

If a table already exists with the same name, you will be asked if you wish to replace it. 
Selecting “Yes”, will create a new, empty, table. Selecting “No”, will return focus to the input 
box where you can enter a different name or press the “Cancel” button. 

If there is no table with the specified name, then a new, empty, table is created and focus 
returns to the “Acronym Tables” dialogue. The new table will be displayed at the bottom of the 
list. 

Delete Table 

To remove an existing table, select it in the list and press the “Delete Table” button, or press 
“Alt + d”. a dialogue will be displayed asking if you really wish to delete the file. Choose “Yes” or 
“No”. 

Focus will return to the “Acronym Tables” dialogue. 

 

Word Styles Lister 

Have you ever wondered what all the Styles in Word look like and do? 

This command will produce a document showing a list of Word styles with some of their 
properties. 

A new, empty, document will be created based on the current document. So, for example, 
Using the UK version of Word XP with an open document based on the default template, the 
Word Styles Lister will create a new document showing 154 styles and some information about 
their properties. However, if you receive a document from another source, which may well 
contain many user defined or custom styles, the list could be much greater. 

The following is an extract from the resultant file to give you an indication of what is produced. 



WORD STYLES LISTER 

Developed by Techno-Vision Systems Ltd 

Contains 154 styles 

Notes 

The following defaults apply to all styles, except where stated otherwise 
throughout the document. 

Style Type is "Paragraph", except where "(Character)" appears after the style 
name. 

Style is "Built In", except where specified as "User Defined". 

Font: bold is off; italic is off; underline is off; hidden is off; strike through is off. 

Font colour default is "Automatic". Where the colour is 1 of 60 built-in colours, 
the name will be given; for user defined colours, only its numerical value can be 
given. 

"Next Paragraph Style" is only included where it differs from the current 
paragraph style. 

Paragraph Formatting: indentation is 0; outline level is 10 (Body Text); line spacing 
is single; space before is 0 points; space after is 0 points. 

87. Normal 

Font: Times New Roman 12 point 

Paragraph format: alignment is left justified 

88. Normal (Web) 

Based on Normal style 

Font: Times New Roman 12 point 



Paragraph format: alignment is left justified 

89. Normal Indent 

Based on Normal style 

Font: Times New Roman 12 point 

Paragraph format: alignment is left justified; indent is 0.5 inches 

90. Note Heading 

Based on Normal style 

Font: Times New Roman 12 point 

Next paragraph uses Normal style 

Paragraph format: alignment is left justified 

91. Page Number (Character) 

Based on Index 9 style 

Font: Times New Roman 12 point 

92. Plain Text 

Based on Normal style 

Font: Courier New 10 point 

Paragraph format: alignment is left justified; line spacing is 12 points 
(approximately 1.2 lines) 

 

How to remove a previous version. 

Earlier versions of the SWIFT template were called “DBTW.dot”, “DBT2.dot” and “DBT3.dot”. If 
one of the old templates, and this new version, are both in the “....\Word\Startup” folder, then 



Word’s menu bar will either show items for “Duxbury” and “DBT” or two “DBT” menus. Simply 
close Word and remove the old template from the folder. 

 

Getting help. 

Anyone who is already subscribed to the "duxuser" mailing list can place a message on the list 
for help and support with SWIFT. It would be helpful if the word “SWIFT” was included in the 
subject line. Details on how to join the mailing list can be found in DBT's Getting Help. 

 

Word Template (BANA Braille 2010) 

We should stress at the outset that the Word section of the following is only available for 
Word 2000 and newer. 

Although primarily designed for those using the BANA recommendations for the layout of 
braille, there is no reason why the templates cannot be modified for different braille layout 
standards world-wide. 

The templates have been a work in progress since 2000, and were developed by Susan 
Christensen, a well known North American braille transcriber and trainer. 

This topic potentially provides three valuable, labor saving templates. One for Word, and two 
for DBT, although the Word and DBT templates are in fact technically linked as you will discover 
when you read further. 

If Word 2000 or newer is already on the computer when DBT is installed, a new Word template 
called "BANA Braille 2010.dot" should have been added to your Word Templates as shown 
below. For those who used earlier versions of the template, it's important to now use the BANA 
Braille 2010.dot template to take advantage of the latest features. You may leave the earlier 
templates on your computer. 

If the BANA Braille 2010.dot template was not installed, you may either reinstall DBT, (See 
Installation) or copy the BANA Braille 2010.dot file into your Word Templates folder. A backup 
copy of the template is found in Vista and Windows 7 at C:\Program Files (x86)\Duxbury\DBT 
11.1\Templates. 

Additionally you will find DBT includes two templates called, "English (American Textbook DE) - 
BANA" and "English (American Textbook DE) BANA Nemeth". 

mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/getting_setup_in_DBT/new_users_start_here/GETTING_HELP.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Duxbury/DBT%2011.1/Documentation%20(English)/helpfile.chm::/getting_setup_in_DBT/Installation/Installation.htm


Using the Word BANA Braille 2010.dot template to create documents will provide you with a 
file which can be imported into DBT using one of the BANA templates. The Word styles are 
mapped to corresponding DBT/BANA styles. 

Using the BANA Braille 2010 Template explains how the Word template is used. 

DBT Codes in Word (BANA Braille 2010) provides specific information about inserting DBT codes 
in Word. 

Styles List for English (American Textbook DE) BANA & BANA Nemeth Templates (DBT 11.1) 
details the DBT braille styles. 

Word and DBT 11.1 Styles is a table of Word styles and corresponding DBT styles. 

Using the BANA Braille 2010 Template 

Before you begin, it is suggested that you turn on the Style Area in Word. This works in Normal 
View in Word. It displays a column on the left hand side of your document, showing the 
paragraph Word styles in use. Click here if you would like to know how to set this up on your 
system. 

To use the braille template for a new file: 

Word 2000: File | New | BANA Braille 2010.dot 

Word 2002: File | New | (Task pane) New from template | General Templates | General | 
BANA Braille 2010.dot 

Word 2003: File | New | (Task pane) Templates | On my computer | General | BANA Braille 
2010.dot 

Word 2007: Office Button, New, My Templates … | My Templates | BANA Braille 2010.dot (May 
be found in Recently Used group after first time) 

Word 2010: File, New, My templates | Personal Templates | BANA Braille 2010.dot (May be 
found in Recent templates after first time) 

To attach the braille template to a current file: 

If a file has already been created with another template (most likely Normal.dot), it will be 
necessary to attach the BANA Braille 2010.dot template. This can be easily accomplished in one 
of two ways. 
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Word 2000, 2002/XP, 2003 

The best option is to attach the BANA Braille 2010.dot template to the current file. Tools | 
Templates and Add-ins | Document template | Attach | BANA Braille 2010.dot | Open. Make 
sure Automatically update document styles is checked before clicking OK 

Note: It is strongly suggested that after clicking OK that you return to the dialog and uncheck 
Automatically update document styles. 

OR 

Create a new document using BANA Braille 2010.dot. Once the new file is created, go to Insert | 
File, navigate to the file and insert it into the blank document. 

Word 2007, 2010 

The easiest option for access to the Templates and Add-ins dialog is to add it to the Quick 
Access Toolbar (QAT). 

1. Click the down arrow at the end of the Quick Access Toolbar 

2. Click on More Commands 

3. In the Choose Commands from drop down, select All Commands 

4. Select “Templates” from the alphabetical list and click the “Add” button between the two 
lists. This adds “Templates” to the end of the list. The up and down arrows at the right side of 
the screen can be used to move commands within the list. 

5. Click Templates button on Quick Access Toolbar and go through normal routine above of 
attaching the template. 

Toolbars 

There are three braille toolbars. The toolbars appear in the Add-ins tab in Word 2007/2010. 

All buttons have a screentip, which appear when the mouse is held over the button, as long as 
Word is configured to see the screentips. 

Word 2000, 2002/XP, 2003 

Tools | Customize | Options | Other | Show ScreenTips on toolbars is checked. Shortcut 
keystrokes are shown if Show shortcut keys in ScreenTips is checked. 

Word 2007 



Office Button | Word Options | Popular | Top options for working with Word | ScreenTip style: 
“Show feature description in ScreenTips” 

Office Button | Word Options | Advanced | Display | Show shortcut keys in ScreenTips 

Word 2010 

File | Options | General | Use Interface options | ScreenTip style: “Show feature description in 
ScreenTips” 

Office Button | Word Options | Advanced | Display | Show shortcut keys in ScreenTips 

(1) Braille - Styles 

Style names are used for those who may not be as familiar with the actual indent/runover 
required for a particular format. The Numbered menu may be used by those who prefer to 
think of format in terms of the specific indent/runover, or when you don't want any blank lines 
or protection associated with another style used (for example, it may be preferable to use 1-3 
vs. List). 

Styles can be applied a number of ways. These are the most efficient: 

1) Some styles have shortcut keystrokes already assigned, so the style can be applied within the 
document by pressing the shortcut. For example, the shortcut keystroke for Heading 1 is 
Alt+Ctrl+1. Assigned shortcut keystrokes will appear on the appropriate menu (in this case, 
Headings). 

2) Use Hotkeys to access the Braille-Styles menus and styles. Note the underlined letters on a 
menu and also after the menu is open. To access the menu, press Alt+ the underlined letter. 
Once the menu is open, press only the letter that is underlined. For example, to choose the 
Body Text style, press Alt+b, b. If your Word configuration is already using the designated braille 
menu Hotkey, press the Hotkey again to cycle to the braille menu. When cycling through this 
way, it will be necessary to press Enter or Down arrow to open the menu. 

Word 2007/2010: Press Alt and follow the shortcut keys provided) Press Ctrl+Shift+s to activate 
the Style drop down box on the Formatting toolbar. Start typing the style name, and once 
available, press Enter.  

Word 2007/2010: 

4) Use the mouse to select the desired style from the Braille - Styles toolbar. 



In most cases, the style names in the menus will appear slightly different than what is seen in 
the style box, style list, and/or Style Area. The style is the same, but the menus are configured 
for spaced style names and additional information. 

When typing, styles with subentries/hierarchies can be changed via keystrokes. Select the first 
level, and after pressing Enter, use Alt+Shift+Right arrow to move down to the next level. 
Alt+Shift+Left arrow will move up a level. Some keyboards seem to be sticky for using 
Alt+Shift+Left arrow and may require pressing the keystroke again to activate it. This keystroke 
will only move as many subentry levels as indicated on the menu. Contents, Exercise, Glossary, 
Index, Verse Play, and Poetry work with this keystroke. Exercise 1 will immediately move to 
Exercise 2 after Enter is pressed. Stairstep is configured to automatically move to the next level 
with Enter. 

Contents, Exercise, Glossary, and Index have a style that must be used when there is no 
subentry - for example, Exercise 1 of 1 Level. When there is a subentry, use the style with 
number to allow for correct importing into DBT. For example, for a 2 level exercise format, use 
Exercise 1 with Subentries and Exercise 2. (See sample file: exercise.doc) 

Note: The List style is used for each item in a list. DBT will correctly enclose the entire list in a 
single DBT List style. 

(2) Braille Character 

This toolbar includes character styles, the styles for page numbers, and DBT Codes. 

T# - Textbook Reference Page Number (Alt+Return) - Places the print page number at the right 
margin in the .doc file. 

▲#▲ - Embedded Textbook Reference Page Number (Alt+Ctrl+Shift+t) - Apply to print page 
numbers that happen mid-paragraph. 

Other page Numbers (Alt+1) - These items help control other page numbering situations (such 
as combined page numbers). Show/Hide (Ctrl+*) must be active. See DBT Codes in Word for 
more information. 

Reset (Ctrl+Space) - Used when typing. This ends the character style and returns to the format 
of the paragraph style in use. 

CBC - CBC-Inline (Alt+Ctrl+Shift+c) - Text using this character style will appear in blue Courier 
New font. This is equivalent to DBT's BANA CI-CBCInline style, and DBT's compinline style. Note: 
For proper mapping to DBT, make sure DBT's Global | Word Importer | Transcribe Courier to 
CBC is unchecked. 
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= - Exact translation (Alt+Ctrl+Shift+e) - Anything in this character style will appear in the 

Simbraille font (assuming the font is installed), and will import and translate into DBT without 
making any changes, if DBT is set up accordingly. Do not check DBT's Global | Word Importer | 
Treat braille and simbraille fonts as braille. The style will take care of treating the font as braille. 

For an expanded explanation of the above, see Global: Word Importer... 

G... - Guide Dots (Alt+Ctrl+Shift+d) DBT will automatically insert the guide dots in DBT when this 
style is applied to the page numbers in a table of contents. 

GW - Guide Word (Alt+Ctrl+Shift+w) Apply this style to glossary entry words and DBT will insert 
the guide words on the last line of the braille page. See GW-GuideWord for more information. 

L# - LineNums (Alt+Ctrl+Shift+n) Apply to prose and poetic line numbers. (See sample file: 
linenums.doc) 

U - Uncontracted (Alt+Ctrl+Shift+u) Apply to any word(s) that should be uncontracted. 

F - French (Alt+Ctrl+Shift+f) 

G - German (Alt+Ctrl+Shift+g) 

I - Italian (Alt+Ctrl+Shift+i) 

L - Latin (Alt+Ctrl+Shift+l) 

S - Spanish (Alt+Ctrl+Shift+s) (Word 2007/2010 Note: This is the toggle keystroke for the Styles 
window when the BANA template is not attached. You may wish to change the Spanish 
keystroke so you can continue to use the Styles window shortcut key.) 

DBT Codes (Alt+2) - These items help control specific translation situations. Show/Hide (Ctrl+*) 
must be active. See DBT Codes in Word for more information. 

Page Setups (Alt+3) - These items set up Special Symbols, Transcriber's Notes, and Contents 
pages, along with making sure the preliminary pages and text pages are handled correctly. 
Show/Hide (Ctrl+*) must be active. See DBT Codes in Word for more information. 

(3) Braille Nemeth 

NOTE: Use this toolbar only if the document is a math document using Nemeth code. 

N# - Nemeth Reference Page Number (Alt+Shift+Return) 
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▲#▲ - Embedded Nemeth Textbook Reference Page Number (Alt+Ctrl+Shift+m) - Apply to 
print page numbers that happen mid-paragraph. 

Other page Numbers (Alt+4) - These items help control other page numbering situations (such 
as combined page numbers). Show/Hide (Ctrl+*) must be active. See DBT Codes in Word for 
more information. 

Nemeth - Menu includes Directions and Exercise paragraph styles. It is necessary to use the 
Directions and Exercise styles on this menu for DBT to import and translate the document 
correctly. Literary Context, Linear Math, Technical Notation and TN-Nemeth (Embedded) 
character styles are also included on this menu. 

Nemeth Codes (Alt+5) - Menu includes specific DBT codes to help control common Nemeth 
translation. Show/Hide (Ctrl+*) - must be active. See DBT Codes in Word for more information. 

Emphasis (Alt+6) - Menu includes a variety of Nemeth italic and bold character styles. 

DBT Codes in Word (BANA Braille 2010) 

An improved feature with DBT 10.7 was the ability to insert DBT codes within a Word 
document. This allows even greater control for preparing a file for braille translation. Many of 
the common codes have been placed on menus for easy access. Because the codes may be 
intrusive for general editing and printing, these codes are set up as hidden text. (It doesn't 
matter if the codes are hidden or normal text.) To see the codes, it will be necessary to work 
with non-printing formatting marks turned on by clicking Show/Hide (Ctrl+*) on the Standard 
toolbar. The codes appear in plum colored text and a faint dotted underline. If you would like to 
see only the hidden text without seeing the rest of the non-printing formatting marks, navigate 
to Tools | Options | View and check Hidden text (Alt+t o, View, Alt+i). Those who use screen 
readers will find this second option preferable. 

Word 2000, 2002/XP, 2003 

Hide Your Codes 

Embedding a DTB Code in a Word document adds text which is not wanted by regular sighted 
readers. It can also cause unwanted reformatting of the document itself. Here are some tips 
which will solve these problems. 

"Hidden" text is quite an easy produce in Word.  

First, complete your document, remembering to use Styles, etc., as recommended. 

You should now turn on Word's Show/Hide feature by clicking on its Toolbar icon as shown 
below. This looks like a backward facing capital letter P with a double vertical stroke. 
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(If you are a screen reader user, please click here and see the note below) 

You will now find your document showing additional information such as small dots between 
words indication spaces, and paragraph marks which look like the backward letter P you have 
just clicked on. The following illustrations first show text with Show/Hide off, and then with it 
on. 

In the "Effects" section, check "Hidden". In this example, we have also selected a red Font Color to make our 
Hidden text stand out. Click on O.K. 

Now click on Word's Show/Hide icon in the Toolbar. Note how your "Hidden"`text has 
disappeared. 

Important Note for Screen Reader Users: 

If you use the Show/Hide feature in Word, your screen reader is liable speak every space and 
paragraph mark in the document. You should therefore go to Word's Tools, Options, and in the 
View Tab, under Formatting marks, make sure that "All" is uncheck, and "Hidden Text" is 
checked. 

When you wish to Hide text, return to this dialog, and uncheck "Hidden Text". 

 

Use AutoText 

These instructions are for Word 2003. 

There are a couple of issues to keep in mind before you start. 

1) Decide if you want the AutoText entries in a specific template other than normal.dot. The 
simple way of creating AutoText entries will automatically include them in your normal.dot 
template … even if you working in a different template at the time. 

2) Activate the AutoText toolbar by going to Word's View menu, Toolbars, and checking 
"AutoText". 

Now take a look at the drop down list. 

You can specify a category for your entries based on the paragraph style you use when first 
setting this up (described below). If you don’t create a special category, it will likely end up in a 
Normal category (if Normal is the paragraph style you are using during the process). 

If you are using a special template, use that template while creating the AutoText entries. Our 
recommendation is to type in all the DBT codes you want to include first. (Suggestion: 
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Additionally create an “empty” code, [[*__*]]. The __ can easily be replaced with a code not 
included in the AutoText entries.) 

Also format them as you desire … using a character style with hidden text and a special color is 
the suggested approach. To have all the codes appear in a single AutoText category other than 
the current paragraph style name, select all of your codes and then create a new paragraph 
style by pressing Ctrl-Shift-S and typing the name you want (such as Codes, DBT, Braille, etc.) … 
this is the category where the AutoText entries will be placed. (See example below)  

Now you are ready to begin adding the codes to AutoText. For best results, make sure you have 
non-printing characters turned ON. 

1. Select the first code. DO NOT include spaces or paragraph marks. If you include the 
paragraph mark, the entry will be inserted as a separate paragraph. 

2. To add to normal.dot: Press Alt-F3. The Create AutoText box will pop up with the code 
inserted. It is suggested that you change this to a meaningful name. 

Press Enter. It’s now included in the AutoText list. If you have your AutoText Toolbar still active, 
you’ll see that it is assigned to the category based on whatever the paragraph style was used 
for your entry. Continue this procedure for the rest of your codes. 

3. To add to specific template: After selecting the code, go to Insert | AutoText | AutoText. 
Select your template in the Look in drop down. Make sure you've renamed the entry if desired. 
Click Add. Now it is only added to that template. Continue this procedure for the rest of your 
codes. 

 

Points to note: 

Entries were typed first and as shown. Formatting was applied afterwards. Note the space after 
the code. Descriptions may be added if desired. 

BEFORE starting to enter Autotext entries, a Word Paragraph Style called "Braille" was created, 
based on Word's "Normal" Style. This was then applied to the whole document. 

Next, a word Character Style was created (We called it "Braille Code"). In this example, we have 
chosen a 12 point Courier New Bold Font, colored red to make it stand out in our text. We have 
also checked "Hidden" under Font effects. (Click here to see Word's Format: Font dialog for this 
example.) 

Finally the "Braille Code" Character Style was applied to the Codes themselves. 
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The following describes further optional refinements. 

Place AutoText Entries on a Menu 

You can add a menu to a current toolbar, or create a new toolbar and add menus to that. 

New Toolbar: Right click toolbar area and select Customize (OR go to View | Toolbars | 
Customize OR go to Tools | Customize). On the Toolbars tab, click New. Give the toolbar a name 
and select the template if you want it in a different template than normal.dot (presumably you 
are working with a document using that template) … and then click OK. The new toolbar will 
probably be floating next to the dialog box. You can leave it there for now or drag it to the 
toolbar area. 

New Menu: You’re still working in the Customize dialog, but now choose the Commands tab. If 
you are working in a specific template, make sure you choose it from the Save in drop down. At 
the bottom of the Categories list on the left is New Menu. Select that and you’ll see New Menu 
pops into the Commands list on the right. Click on New Menu in the Commands list and drag it 
to the toolbar of choice. That will put a new entry on the toolbar called New Menu with a drop 
down arrow. New Menu will be enclosed in a black outline … right click on it and give it a new 
name. If you want to access it using a hotkey, put & in front of the letter of choice. It’s nicer if 
you can choose a letter not already used with other menus but that’s not always easy. 

The Customize dialog MUST stay open throughout this entire process, as it’s the only way you 
can create and modify the menus. 

To add AutoText entries to the menu: Go back to the Commands tab in the Customize dialog, 
and look for AutoText towards the bottom of the Categories list. Select that. All the AutoText 
entries will be listed in the Commands list. Select the entry you want and then drag it to the 
new menu. The first entry may be a little tricky, but you need to get a small box to expand from 
the bottom of the menu, and then drop the AutoText entry. Once again, you can right click on it 
and modify the name or add the & to a letter if you wish. 

Shortcut keystrokes: To assign keystrokes to any or all of your AutoText entries, click the 
Keyboard button at the bottom of the Commands tab. If you are working with a special 
template, select it in the Save changes to drop down. Now choose AutoText from the 
Categories list and then the specific entry from the Commands list. Try various keystrokes in the 
Press new shortcut key box until you find one that’s not assigned (or one you don’t mind 
reassigning from a feature you don’t use). Click Assign. After shortcut keystrokes are assigned, 
you’ll see them listed in your new menu. If you don’t see the shortcuts listed on your menu, go 
to the Options tab on your Customize dialog and make sure Show ScreenTips on toolbars and 
Show Shortcut keys in ScreenTips are checked. 



Before you exit Word, you will likely be prompted about saving changes to your template. 
Obviously you want to agree. 

 

Using DBT Codes in Word 

This may on the face of it appear to be a fairly technical topic. Indeed to some extent it is. 
However, it may be useful in cases where transcribers prefer to use Word for Windows. 

In order to fully understand this topic, you should be familiar with DBT's Codes as described in 
the Codes Topics. To use the AutoText method mentioned here, you should also be 
comfortable with working in Microsoft's Word for Windows. 

It is possible to insert or embed DBT Codes into Word Documents. All that is required is that 
you enter the Code into the Word document between a double left square bracket and an 
asterisk, and an asterisk and a double right square bracket. [[*code*]] 

For example, the Code used in DBT to skip one a line is [sk1]. To put this Code in Word, type 
[[*sk1*]]. When you then import you file into DBT, you will find the Code you typed in Word, 
has become a regular DBT Code, and in this example, will skip a line in braille. 

This method is fine for relatively basic Coding, but has two drawbacks. First, it may be 
considered rather cumbersome to type, and second it does alter the appearance of your Word 
Document, with the added possible side-effect that the pagination may be altered. 

However, you can "Hide" this extraneous text. Moreover, you can use one of Word's less used 
features, AutoText, to create a list of Codes you wish to use on a regular basis. 

 

Word Style Map (MWS File) 

When DBT imports a file from Word for Windows, it will recognize any default Styles applied to 
the text in Word, and apply appropriate DBT Braille Styles. 

For example Word's "Heading 1" Style, will become DBT's "h1." heading Style in DBT.  

This potentially gives you tremendous control over how imported Word documents are 
formatted, and can save you literally hours of work. 
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If a document contains User Defined Word Styles, DBT won't know about them. You can 
however use a utility called SWIFT, which may already have been installed on your system in 
Word, to map User Styles to DBT Styles. 

Details for using SWIFT are available in DBT's main Help system. 

 

If you are following BANA braille formatting and rules, you may alternatively use the "Braille" 
Template in Word, which may be installed on your system. See the Help Topic called "Word 
Template (BANA Braille 2006)" for a full explanation. 

 

Experienced users may however prefer to create and maintain their own Word Style Map files, 
which are containing in the c:\duxbury\templates folder, and have the file extension ".mws". 
For details on how these files work, please see "Editing the ".mws" file" Topic. 

Using .mws files with DBTWin 

By J. R. Westmoreland 

This document describes the basic instructions you will need to use the .mws files as part of the 
DBTWin program. 

The .mws file is used to control the substitution, or mapping, of MS-Word styles to DBTWin 
styles. This translation is controlled, and modified by, the instructions contained in the .mws 
file. 

The .mws file consists of two parts: Comments, which can be used to describe the files use and 
other documentation. And Mapping Elements, which tell DBTWin how to do the importing from 
MS-Word styles to the corresponding styles in DBT. 

The Comment Lines are lines that begin with a number sign "#". The rest of the line is ignored. 
These lines can contain anything you wish. It is a good idea to use the comments to describe 
the function of the file and other items that might be necessary for some one else to know if 
they need to modify the file later. 

The Mapping Elements are used to specify the name of the MS-Word style, its type, and the 
name of the DBT style to which this MS-Word should be mapped. It can also contain additional 
instructions that control how the DBT style is handled and other attributes. 

The rest of this document will describe the format and parameters of the mapping elements. It 
will also talk about the limitations of the .mws file. 
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The general format of the mapping element is: 

<type> "<MSWord-style-name>" 

{ 

<parameter> = <value> 

… 

} 

We will now discuss each of the parts of the mapping element. 

<type> 

The type of the mapping element. This item has one of the following values: User which 
indicates that the MS-Word style is a user defined style. These are all styles that are not part of 
those defined by default in MS-Word. Please see the list of Built-in styles at the end of this 
document. Built-In are the default styles as defined by Microsoft as part of Word. Also, Built-In 
styles are those that will have their names change based on your locale for Word. In general, it 
is a good idea to try User first and if that fails then try Built-In. 

<MSWord-style-name> 

This is the name of the style defined in Word. This name should match the word style name in 
spelling as well as case. This item, as well as all other items in this file, is case sensitive. 

The opening and closing braces "{" and "}" are used to group the parameter and value pairs 
together for the MS-Word style name described above. 

Now we will discuss each of the name/value pair items that can be placed in side the body of 
the mapping definition. The body is the information that is enclosed in the braces. 

MappedName = “<DBTStyleName>” | none 

The value of this parameter is the DBT style name. If this name has a dot "." At its end, like the 
"para." Style, you must drop the "." From the name. E.g., "para." Would become "para". You 
can also use the value "none" to indicate that there is not a style mapping for this MS-Word 
style. Note: the DBT style name must be surrounded with double quotes. 

MappedNameInNote = "DBTStyleName" 



This keyword is used only for Footnote Reference and Endnote Reference styles. In these cases, 
the MappedName keyword specifies the name of the DBT style used where the reference 
appears in the body of the document, and the MappedNameInNote keyword specifies the 
name of the DBT style used where the reference appears within the footnote or endnote. 

Ignore = Always | IfBlank | IfOrnamental 

This parameter is used to leave out a paragraph from the import. It can take the following 
values: Always which can be used to eliminate a paragraph from the document being imported 
such as print-only items like header and footer. IfBlank which is used to eliminate blank 
paragraphs. IfOrnamental used to eliminate paragraphs whose contents are just lines of 
characters like dashes "-", or asterisks "*", etc. 

AggregateForward = Always | Never | IfSameName | IfSameCategory 

AggregateBackward = Always | Never | IfSameName | IfSameCategory 

These keywords are used to check the next and previous paragraphs and determine their 
treatment relative to the current paragraph style mapping. It can have the following values: 
IfSameName which will aggregate the paragraphs into a single block of the specified style. 
Always which indicates that the paragraph should always be aggregated in to the current style. 
Never that indicates that the paragraph should never be aggregated to the current style. This 
means that the paragraph will always be imported into a DBT linear paragraph style 
independent of the style being used before or after it. IfSameCategory which is only applicable 
if you have a "Category=Index" or "Category=TOC" item in the map element body. 

Level = <LevelNumber> 

This keyword is the DBT style level that should be applied to the mapped style. The mapped 
style is the style specified in the MappedName parameter. The value of this parameter is a 
number that indicates the level. 

Note that Level is most often useful when a series of paragraphs is aggregated. The 
combination of these three properties, Level, AggregateForware and AggregateBackward is 
intended to bridge the gap between the way the designers of Word conceived of styles and the 
way Duxbury did. 

Category = None | TOC | Index 

This parameter is used to specify the category of the mapping. The Category parameter can 
have one of three values at this time. They are: TOC - indicating that this table of contents, 
Index - indicating that this is an index, or None - indicating that there is no category. 



IgnoreEmphases = Never | InDef 

This parameter is used to tell DBT how to handle emphasis indicators. The two possible values 
to this parameter are: Never - emphasis used in the style will be shown in braille - and InDef - 
DBT will ignore emphasis that is part of the style definition, but show emphasis that has been 
added to characters within the style. 

DisableInToc = True | False 

This can have one of two values True or False. False is the default. When set to True, this causes 
a style to be ignored when it occurs in a Word table of contents. E.g., not mapped to a DBT 
style. Word makes hyperlinks out of table of content entries. This parameter can be used to 
avoid putting table of content entries into computer braille. 

IgnoreCentering = True | False 

This parameter can be set to True or False. False is the default. Normally, DBT looks upon 
centering of a paragraph (or line) in a Word file as significant. Users generally want centered 
lines in the print document to be centered in braille. However, when this flag is set to True, the 
text that is set in that style will not be centered in DBT even if the user centers it in the Word 
document unless it is part of the DBT style. 

IgnoreSuperscript = True | False 

This parameter can be set to True of False. False is the default. This is typically set for character 
styles. When set to true, DBT will omit [ps] and [pe] codes to indicate that the text is 
superscript, if the superscripting is part of the style definition. 

IgnoreContents = Always | IfBlank | IfOrnamental 

This parameter is similar to the Ignore parameter. It takes the same values as the Ignore 
parameter. The difference being that while Ignore will lose the start and end tags this 
parameter will lose the contents rather than the tags. 

Now that we have finished the discussion of the format and parameters, with their values, of 
the .mws file let's talk about some good practices when you decide to modify these files. 

The prime rule is: "Make sure you backup the file you want to modify. If you don't you WILL be 
sorry." 

Remember that there are limitations to what you can do with the .mws file even though it is a 
very powerful tool. 



List of Built-In Styles 

Normal 

Heading 1 

Heading 2 

Heading 3 

Heading 4 

Heading 5 

Heading 6 

Heading 7 

Heading 8 

Heading 9 

Index 1 

Index 2 

Index 3 

Index 4 

Index 5 

Index 6 

Index 7 

Index 8 

Index 9 

TOC 1 

TOC 2 

TOC 3 



TOC 4 

TOC 5 

TOC 6 

TOC 7 

TOC 8 

TOC 9 

Normal Indent 

Footnote Text 

Annotation Text 

Header 

Footer 

Index Heading 

Caption 

Table of Figures 

Envelope Address 

Envelope Return 

Footnote Reference 

Annotation Reference 

Line Number 

Page Number 

Endnote Reference 

Endnote Text 

Table of Authorities 



Macro Text 

TOA Heading 

List 

List Bullet 

List Number 

List 2 

List 3 

List 4 

List 5 

List Bullet 2 

List Bullet 3 

List Bullet 4 

List Bullet 5 

List Number 2 

List Number 3 

List Number 4 

List Number 5 

Title 

Closing 

Signature 

Default Paragraph Font 

Body Text 

Body Text Indent 



List Continue 

List Continue 2 

List Continue 3 

List Continue 4 

List Continue 5 

Message Header 

Subtitle 

Salutation 

Date 

Body Text First Indent 

Body Text First Indent 2 

Note Heading 

Body Text 2 

Body Text 3 

Body Text Indent 2 

Body Text Indent 3 

Block Text 

Hyperlink 

Followed Hyperlink 

Strong 

Emphasis 

Document Map 

Plain Text 



E-mail Signature 

Normal (Web) 

HTML Acronym 

HTML Address 

HTML Site 

HTML Code 

HTML Definition 

HTML Keyboard 

HTML Preformatted 

HTML Sample 

HTML Typewriter 

HTML Variable 

Table Normal 

No List 

1 / a / i 

1 / 1.1 / 1.1.1 

Article / Section 

Table Simple 1 

Table Simple 2 

Table Simple 3 

Table Classic 1 

Table Classic 2 

Table Classic 3 



Table Classic 4 

Table Colorful 1 

Table Colorful 2 

Table Colorful 3 

Table Columns 1 

Table Columns 2 

Table Columns 3 

Table Columns 4 

Table Columns 5 

Table Grid 1 

Table Grid 2 

Table Grid 3 

Table Grid 4 

Table Grid 5 

Table Grid 6 

Table Grid 7 

Table Grid 8 

Table List 1 

Table List 2 

Table List 3 

Table List 4 

Table List 5 

Table List 6 



Table List 7 

Table List 8 

Table 3D effects 1 

Table 3D effects 2 

Table 3D effects 3 

Table Contemporary 

Table Elegant 

Table Professional 

Table Subtle 1 

Table Subtle 2 

Table Web 1 

Table Web 2 

Table Web 3 

Table Grid 

Table Theme 

 

 

Mathematics 

A great deal of work has gone into the difficult subject of braille mathematics. 

Moreover it is not a subject which can be covered easily, since it does require a knowledge of 
mathematics as well as mathematical braille. 

Additionally one needs to know how to use at least one of two software products - MathType 
and/or Scientific Notebook. 

http://www.dessci.com/en/products/MathType/
http://www.mackichan.com/index.html


And as a final warning, never was the saying "Rubbish In - Rubbish Out!" more true. 

MathType 

If you are familiar with Microsoft Word for Windows, you may also know of "Equation Editor" 
which allows you to insert basic mathematical material into a Word file. 

MathType is a more advanced (but low cost) version of Equation Editor which enables you to 
enter equations into Word documents. 

Word files containing MathType equations may then be opened in DBT in the usual way, and 
translated into braille. 

A 30 day fully working demonstration version is available for download from: 
http://www.dessci.com/en/products/MathType/trial.asp 

Scientific Notebook 

This product creates its own files containing both text and mathematical material. It is possibly 
slightly more advanced, which in turn is reflected in the cost. 

Scientific Notebook files will be recognized as such when you open them in DBT. 

A 30 day demonstration version is also available from: 
http://www.mackichan.com/licensing.net/dnloadreq.aspx 

Product Support 

Please note that the general use and support for these products is generally provided by the 
developer and not Duxbury Systems. Inc. 

Issues relating to import and braille translation however can be addressed to Duxbury. 

MathType™ 

NOTE: You should use MathType Version 6.7a with this version of DBT 11.1 (SR3). 

MathType is a relatively low-cost add-on for Word for Windows which enables mathematical 
formulae to be inserted into Word for Windows documents. It is produced by Design Science, 
Inc.. Word documents containing MathType equations can be opened in DBT, and translated 
into mathematical braille. 

However, It must be stressed that the preparation of mathematical material should only be 
done by those with a good knowledge and understanding of mathematics. 

http://www.dessci.com/en/products/MathType/trial.asp
http://www.mackichan.com/licensing.net/dnloadreq.aspx
http://www.dessci.com/en/
http://www.dessci.com/en/


Modern day mathematical editors make extensive use of Unicode for many mathematical signs. 
Unfortunately, visually, many signs appear alike or similar. Unfortunately also we have become 
used to using purely the PC's keyboard for inputting many arithmetical or mathematical 
characters.  

 

For example, two times two equals four, is often shown as: "2x2=4". 

In correct mathematical input it should appear as "2×2=4". 

(And if you are still wondering what the difference is, it is the x which, in the second example is 
× a proper multiplication sign.) 

Fortunately MathType's features allow you to easily select the correct characters, provided of 
course you know what you require. 

WARNING  

All favours of Word in common use, allow you to embed either fonts used, or entire character 
sets. 

HOWEVER, this does NOT apply to fonts within embedded MathType Equations. 

MathType installs certain fonts specific to itself which Design Science refer to as, "our exclusive 
Euclid™ math fonts". Consequently users should be warned about sharing files with others who 
do not have MathType installed. Some users may be lucky if they have a wealth of more 
complete Unicode character sets installed, but this tends to be the exception in our (UK) 
educational system 

The short term (sighted only) solution is to create a PDF and pass that around. However that 
rather defeats the purpose of sharing work. 

The short term answer is to advise the installation of the MathType 30 day fully working demo 
software. 

Longer term, $57 (or around £40 in real money!) is not a serious "budget breaker" given the 
benefits all round. 



Scientific Notebook 

(This topic should really not be under Word, since Scientific Notebook creates its own files. 
However as it covers a means of producing mathematical braille, we have placed it here for 
completeness.)  

This is a popular product in many areas which essentially produces LaTeX files. 

A 30 day demonstration version may be obtained from: 
http://www.mackichan.com/licensing.net/dnloadreq.aspx 

The files produced by Scientific Notebook may be imported into DBT and translated 
accordingly. 

Choosing your Math Braille Tables 

In many cases, you do not need to adapt or alter anything within DBT to enable you to produce 
math braille. However, if you are using DBT with one of the many new languages which have 
been added from version 11.1 onwards, please initially refer to the relevant topic listed within 
Help: Language Translation Tables to determine which Math Code will be used by default. 

In Duxbury DBT 11.1, there are 4 translators which handle technical (mathematics and science) 
symbols. 

These are: 

-- English UEB translators for UEB braille 

-- English translators for British or BAUK mathematics braille 

-- French translators for standard French mathematics braille 

-- North American English translators for Nemeth mathematics braille. 

Technical Information 

The following details require a sound knowledge of copying and renaming files within 
Windows, and may involve special permissions. DO NOT under any circumstances attempt the 
following unless you are 100% confident in what you are doing, and have the authority to do 
so! 

Detailed Instruction 

These instructions tell you how to do a single step, so that for all future file importations into 
DBT 11.1, your choice of math translators is used. 

http://www.mackichan.com/licensing.net/dnloadreq.aspx
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Regardless of what braille translator you choose for literary (Afrikaans through Zulu), your 
choice of technical translator will be used for technical material. 

Thus you can have Finnish literary braille with French braille math, or Hindi literary braille with 
Nemeth Code math, etc. 

Duxbury Systems is aware that there are many other math braille systems. 

There are systems for German, Spanish, Italian, Hebrew, Russian, and Chinese (and more), but 
these are not available for mathematical equations (at least not yet!). 

Please note that these instructions do not tell you how to use MathType, or how to prepare 
math files. Other documentation tells you how to prepare math files. 

Also note that this method changes the braille mathematics system in use at the moment of file 
importation. If you import 12 files into DBT, and then perform this procedure, your 12 files will 
remain unchanged until you re-import them from the source file into DBT again. 

By the way, to accomplish this task, we are using a scrub table (global replace) and are using a 
feature of DBT 11.1 called "table switching", which allows for switching between braille 
translation tables in the middle of a document. This is a new and powerful feature of DBT 11.1 

Objective 

What is the objective of this procedure? To pick one file in the DBT 11.1 directory and to 
rename it to (use bold) altmath.sbt. This is easy to do on Windows XP, but harder on Windows 
Vista or Windows 7 since they are usually write protected to avoid unauthorized changes to 
software. 

The four files we supply are: 

altmath_Nem.sbt -- for Nemeth Code math braille  

altmath_UEB.sbt -- for UEB math braille  

altmath_UK.sbt -- for British or BAUK math braille  

altmath_FR.sbt -- for French math braille 

Your task is to pick one of these, and just change its name to altmath.sbt. 

Step by Step Instructions 

1) DBT 11.1 needs to be installed on your machine. 



2) Go to the Start Menu or your Desktop and pick Computer or My Computer. 

3) Select (open) the C:\ Drive or the drive where you have installed Duxbury DBT 11.1. 

4) If both Program Files and Program Files (x86) exist, select (open) the Folder Program Files 
x86. 

5) If only Program Files exists, Select (open) the Folder Program Files. 

6) Open the Directory Duxbury. 

7) Open the Directory DBT 11.1. 

8) You should see the four altmath files in the alphabetical list of files. 

9) Highlight the one you want to be your permanent selection for technical (mathematical) 
braille. 

10) Right click (or press Shift+F10) to select options for your highlighted file name. 

11) Select Rename. This opens a thin black box around the name and highlights the text up to 
the period. 

12) For Vista (and possibly Windows 7), you may need to supply credentials to prove you have 
the right to alter the software. This is appropriate since we are doing something similar 
to installing software. 
Depending on your status (administrator or unprivileged user), you may have to prove 
to the computer that you have the right to be making a change. 

13) Either type the 7 letters {bold} altmath; or click to get the cursor just left of the period and 
back space over 3 or 4 characters. 

14) Whatever method you choose, the file name should now be altmath.sbt 

15) Up arrow, or click elsewhere to leave the "Rename" box. 

16) Close the My Computer Window. You are done. 

17) To test, launch DBT 11.1, import a technical file, and translate into braille. Your non-
technical material should be unchanged. Your technical material should be using the 
new system. 

18) These instructions are designed to be easy to follow. If you are more sophisticated, you may 
prefer to make use of "copy" instead of "rename". 



This may make it easier to keep track if you anticipate switching between different technical 
translators. 

Codes, Styles and Templates 

At first glance this may appear to be a complex set of three Topics. Likewise, they may also 
appear to be in the wrong order. 

If you initially understand what Templates are, and how they can save you work, you will be 
well on your way towards adding your own Styles to make Templates of your own do what you 
want. 

Similarly, if you understand what a Style is, and also how they can save your work, you will be 
even further down the road towards creating braille documents more efficiently. 

There are many Codes in DBT; over 200, in fact. We have therefore tried to group these into 
categories relating to how a document is constructed beginning with basic Page Codes, 
Margins, Page Numbering, Headers and Footers, etc.. 

You may even come across Codes in existing documents, and wonder what they do. Hopefully 
you will find the DBT Codes Quick Reference table at the end a useful cross reference. 

Although occasional references are made about officially recognized braille authorities, such as 
the Braille Authority of North America (BANA) or the Braille Authority of the United Kingdom 
(BAUK), we have not tried to cover local requirements or recommendations unless they 
specifically affect an individual Code. 

We have not attempted to cover mathematical or technical braille codes here since these are 
highly specialized, and often the subject of considerable localization. 

Codes 

The first golden rule is that for most of your general literary work, you can define the layout of 
your braille document through DBT's menus. 

The second golden rule with Codes is to try and avoid them wherever possible. 

The third golden rule is to accept that this section is far from complete, but hopefully will point 
you in the right direction. 

However, there are occasions when you need to do something really special. 
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Codes can be broadly categorized as translation codes and formatting codes. Formatting codes 
are supported in all DBT documents. Support for translation codes varies by translation table. 
See Language Translation Tables for documentation about translation tables and the formatting 
codes each supports. 

This can be a rather technical section, so enter it with caution. 

SPECIAL NOTE: Codes used in these topics will be displayed in Courier New font, and appear 
red. ALL DBT codes are contained within square brackets. However, it should also be noted that 
Codes are inserted into your text in a special way, described in the Manually Inserting and 
Amending Codes Topics. 

Layout 

The Codes in DBT basically affect the final layout of the braille document, the key word being 
"layout". Just as corporations and companies have their own corporate designs for their 
documents, so braille follows layout conventions recommended by the braille authority for 
individual countries. Similarly major braille producers may even have a "Corporate Style" which 
determines the way they lay out braille documents. 

In the main, DBT will do an excellent job of formatting braille documents, but you should always 
try an follow any local recommendations. 

Codes - What do they do? 

All Word Processors use some form of Code, which may or may not be hidden to the user, to 
determine how something is displayed. An obvious example is where we want to make a word 
appear bold. 

The following line shows what is actually "hidden" behind the word "bold" in the previous 
paragraph. 

<SPAN STYLE="font-weight : bold;">bold</SPAN> 

DBT is no exception, except that its codes relate to how the Braille is formatted. 

For example, if we were to write, "In English Braille the letter k is a Word-sign for 
knowledge.",w e would not want the word "knowledge" to be translated to "k". 

We would therefore use the code [g1] to tell DBT NOT to translate the word, and [g2] to 
continue in Grade 2 Braille. 

"In English Braille the letter k is a Word-sign for [g1]knowledge[g2]."  

Code Basics. 
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A code is a special character (or group of characters) in a document that will not appear in the 
final output. The EFFECTS of the codes WILL appear. Codes are added to your document 
whenever you use the Layout Menu to produce a translation or formatting effect. 

In DBT, you can opt to see the codes by going to the View Menu and selecting Codes. (Or 
alternatively Alt + F3)  

Codes are surrounded by square brackets. For example, in a coded view, you might have: 

A[SK1]B[SK1]C  

which would cause the output to appear as follows: 

A 

B 

C 

Viewing codes can help track down formatting or translation errors. Without codes showing, 
your view is WYSIWYG and the effects of the codes are usually apparent. For further help with 
the syntax of the codes, see Help: Code and Style Reference or Help: Codes Quick Reference.  

Viewing Codes in DBT 

To view Codes in DBT, hold down the Alt key and press F3. This is what is called a "Toggle" 
command, and therefore pressing Alt + F3 again will turn Coded View off. 

STYLES 

Styles are possibly one of the least understood aspects of both Word Processing and braille 
transcription, yet they can save a great deal of time when used properly. 

What is a Style? 

In visual terms, a Style usually affects the general appearance of Text in a document. It can also 
be used in other ways, for example, to add a Page Break before a Chapter Heading. 

What else is a Style useful for? 

There are many useful things. For example, if you want to create a Table of Contents 
automatically, it is best to use "Heading" Styles contained in your document. 

How can using Styles save me time? 



By being able to make changes to the Style itself. All occurrences of that Style in your document 
will therefore change. This is obviously quicker than changing say 30 individual Chapter 
Headings.  

Why are Styles important? 

If you look closely at the text here, you will see that there are three different appearance of 
font. At the top of the page is the Word "Styles" in a large bold font with lines above and below. 
This is a Style called "Heading 1". Each question asked here is in a smaller bold font, and these 
use a Style called "Heading 5". The rest of the text is in a Style called "Normal". 

But why are Styles important in DBT? 

A Style tells DBT how to lay out the braille on the page. For example, a main heading in braille 
usually starts on a new page, is centered, and has a blank line after it, where sub-headings are 
usually not centered, but begin at the 5th braille cell on the page. Normal text paragraphs begin 
with two blank cells, and do not have any space in between as printed paragraphs often do. 
(Note: Page layout in braille can vary according to the recommendations of the appropriate 
National braille authority). 

Templates - The Basics 
(Revised 1st November 2005) 

Even if you are familiar with Templates in earlier versions of DBT, you should read on. 

"Templates" can be one of the most time saving aspects of producing documents, and especially braille 

documents. 

WHY? Because a template can be set up to remember your personal or corporate preferences. 

Moreover, templates can also store text, such as that of a letter heading, for example. 

A template will basically store five main things. 

1. Device and device settings used.  

2. Styles.  

3. Any required text.  

4. A Word to DBT Style Mapping file.  

5. Table of Contents settings.  



You can create as many Templates as you wish, but you cannot modify any of the Templates supplied 

with DBT. However you can save these templates with a different name, and then modify the saved 

Template. 

Any Template can be marked as your default for all new documents. 

You can also "hide" Templates you do not use. 

The following dialog appears as you create a new document: 

Document Type: The first section of the dialog consists of two radio buttons, Print & Braille. 
You can use the shortcut keys Alt-p or Alt-b to select which type of document or Template you 
wish to open. 

Document Settings Template: This is initially a list of all Templates which are supplied with 
DBT. When you first run DBT, all the available templates will be displayed in this list. If this is the 
first time you have run this part, you may wish to consider which Templates you wish to use, 
and which will be your most commonly used or default Template. 

Mark Template as Default: (or m) This is a button which allows you to select one Template 
from the list which will become your default selection when you open a new document. Click 
this button or press Alt-m to make the selection. 

Hide Template: (or h) If you only work with one or two Templates, you may wish to Hide those 
you do not use. Select a Template from the list, and click this button or press Alt-h to hide it. 
(Note: This button's Title can change as described below.) 

Show Hidden Templates: This check box allows you to reveal all Templates which have 
previously been hidden. When checked, as you move up and down the "Document Settings 
Template:" list, the title of the previous button will change from "Hide Template" to "Show 
Template Always", depending on whether or not you have previously hidden a Template. You 
can press Alt-h to hide, or Alt-s to show the template. 

If you are happy with your selection, click the OK button to continue, or the Cancel button to 
abort the process and return to DBT. 

Troubleshooting 

From time to time, problems happen. In this section, we have outlined a few of the more 
common technical support issues which arise on a regular basis. 

If you don't find a solution to your problem, do not worry, help is always at hand in various 
forms as described in the Getting Help Topic. 
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Characters missing or "wrong" on the DBT Screen 

If you are importing Scientific Notebook files, or perhaps working with mathematical symbols, 
you may at times notice that some characters are missing, or have possibly changed when 
viewed in DBT's text editor. 

This is quite normal, and you will usually find the translated braille output is correct. 

Common Problems 

Braille Printers. 

Q: I've just got a new PC, and installed my Braille Embosser and DBT onto it. Now I'm getting 
"rubbish" Braille being printed.  

A1: In most cases, this is due to the Parallel Port setting in the computer's BIOS not being set to 
SPP or Standard Parallel Port. However, the most recent models of Index embossers (i.e. those 
with USB & Network ports) require ECP/EPP. Contact a local technician if you are not sure about 
altering the BIOS. 

A1: If running the embosser through a Serial connection, make sure that you have the correct 
cable, and that the settings on the PC and Printer, such as Baud rate, Stop Bits, etc., are the 
same on both. 

Q: My Braille embosser was working fine until I installed a new ink printer. Now I'm getting 
"rubbish" Braille.  

or  

Q: My Braille embosser was working fine until I installed a new ink printer. Now my braille 
embosser won't work at all.  

A: The chances are that you have set-up DBT in Global/Embosser Setup to print direct to a 
printer port such as LPT1. In Windows, go to Settings, Printers, and Add New Printer. Under 
Printer Manufacturers select "Generic", and under Type, select Text Only. Now run DBT, go to 
the Global menu, then Embosser Setup, and under Windows devices, select the Generic/Text 
Only printer which you have just installed.  

Q: I've an Index Basic Braille embosser, and suddenly all the text is no longer formatted as it 
appears in DBT.  

A: Someone has switched the printers format switch to the "REF" or Reformat Position. There 
are four switches on the top left of the printer. Make sure the switch second from the left is 
pressed down at the front. 
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Q: My printer is missing dots, cells, or groups of cells. (Or generally, "acting up").  

A: It may be that the printer itself is faulty. Refer to the manual for the printer, and perform a 
"Test Print" or "Self Test". If the problem exists with this test, then it is almost certainly the 
printer which is at fault. 

Q: Sometimes my embosser decides to print rubbish at random intervals. 

A: This can be due to using an excessively long Parallel cable, or one of dubious quality. Use a 
shorter cable (ideally no longer than 10 feet or 3 Meters) or replace it. 

Printer Drivers. 

Q: I don't have any Windows Drivers for my Braille printer  

A: In general there are no such drivers. Install a Generic/Text Only printer. In DBT's Global - 
Embosser Setup, under Windows Device, set to this printer. 

An exception to this are some Index printers which were introduced at the end of 2002. Please 
contact your local supplier for further information. 

Formatting Problems. 

Q: My Double-sided printer is only printing Single-sided.  

Or  

Q: I'm getting unwanted blank lines or blank pages.  

A: This is usually because of a difference between your printer's settings and DBT's. For 
example, DBT set to 29 characters per line, and the printer set to 28. As a general rule, always 
set DBT's Line and Page Length to one less than the printer is set to. 

Missing Text. 

Q: I have a very large document, and am unable to print it out without large chunks of text 
going missing.  

A: This is usually caused either by your Braille Printer not having sufficient "Buffer memory", or 
not "Handshaking" correctly with your computer. The Braille printer manufacturer may be able 
to advise you on whether you can solve the problem locally, or perhaps if you require a printer 
firmware upgrade. Alternatively, try printing the document in smaller sections. (As a VERY 
rough guide, if your printer has say 100k of Buffer Memory, you should get away with sending 
about 80 to 90 pages at a time.) 



Braille View. 

Q: When I Translate a file, and look at it in Braille view, some of the Braille appears to be 
wrong, yet when I emboss it, all is well.  

A: It is probable that your Page View is wrong. Go to DBT's Global Menu, and select 
"Internationalization". Braille Code for Display should normally be "North American English", 
unless advised otherwise 

Why can't I see the shortcut letters? 

If you are using Windows 2000 or above, you may have noticed that you don't always see the 
underlined letter in menu or command names such as File, Edit. 

One way to make them appear is to press the left hand Alt. key (usually found to the left of the 
space bar) Tap it again and they disappear. 

To turn them on permanently, proceed as follows: 

1. Right click on the Desktop background.  

2. Choose Properties.  

3. Choose the "Appearance" tab in the Display Properties dialog that pops up.  

4. Click on the "Effects" button.  

5. Un-check the last checkbox ("Hide keyboard navigation until...") shown in the illustration below..  

6. Click the OK button.  

Word - Auto Formatting 

One of the problems many users experience, is Word making changes within the text which 
they did not expect. (e.g. we type "6 March 2002", and it becomes, "6 March 2002-03-21") 

We cannot re-write the Word manual here, but the following may help to point you towards 
making some helpful changes. 

AutoFormat: 

When you select Word's Format menu, and choose AutoFormat..., you will be presented with 
the following screen: 

If you now select the Options... button, a further screen will be displayed. Select the AutoText 
Tab, and the following dialog will appear. 



Note the Check Box at the top of this screen called, "Show AutoComplete tip for AutoText and 
dates". If it is checked, Word is inclined to make all manner of changes, including the example 
of the date change mentioned above. 

Now select the "AutoFormat as You Type" Tab. If you have ever wondered why things like 
Smart Quotes suddenly appear in your document, the following screen will perhaps explain 
why. 

Word - Backward Compatibility 

If you are handing documents from many outside sources, it usually pays to keep up to date 
with the latest version of Word for Windows. However, this can cause a problem if you need to 
send files to someone who has an older version than you have. 

You can save individual files in another format by going to the File menu and selecting Save As 
instead of Save. You can then select what File Type: you wish to save as. (See illustration 
below.) 

It is also possible to set the default File Saving option in Word to just about anything Word can 
save as. If you go into Tools, Options, then navigate to the "Save" Tab, you will find there a List 
Box which lets you automatically save all files in another format, other than the current version 
of Word. 

Word - Missing or wrong characters 

WARNING: This is a highly technical topic relating to strange characters which may appear in 
DBT after importing a Word file. You will require an understanding of Unicode and how 
Windows characters are coded. 

If you find that an imported Word document contains strange characters, we would advise re-
importing the Word file, having first ensured that DBT's Global: Word Importer is set to produce 
the "Output Unicode value" of "Unknown characters:". (Shown below) 

You will now find after importing the file that any character which DBT does not recognize, 
might appear as follows: 

Chapter One (U:25b6) Introduction  

In this example, the Word file contains a bullet type character called, "Black right-pointing 
triangle". With over 40,000 possible Unicode characters, and in a table which is constantly 
being added to, it is impossible to map all these to Braille in DBT. 

The following explains how such unusual characters may be mapped to braille characters. 

WRDUNI.TXT FILE FORMAT 
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Duxbury Systems, Inc. 
November 30, 2001 

PURPOSE 

The wrduni.txt file controls the mapping of Unicode and other specialized font characters into 
DUSCI characters when the Duxbury Braille Translator (DBT) imports a Microsoft Word file. 

Unicode is an international character encoding standard; see http://www.unicode.org on the 
World Wide Web for details. 

Within the Windows system, specially encoded single-byte fonts may also be used instead of 
double-byte Unicode for characters that cannot be expressed within the Windows standard 
single-byte (Latin-1) font. 

DUSCI is the internal multi-byte character encoding standard that is used within DBT. It is based 
upon Unicode but the encoding method is different. Whereas Unicode characters are always 
two bytes in length, DUSCI characters may be 1 or 2 bytes in length (and may theoretically be 
extended to 3 or more bytes if necessary to accommodate more characters in the future). The 
complete listing of currently assigned DUSCI characters codes, together with the corresponding 
Unicode code values, is given in the "Character List" document, under "Help" in DBT. 

GENERAL CHARACTERISTICS AND ORGANIZATION 

The wrduni.txt file itself is a simple "ASCII text file." WordPad, or any other editor which can 
naturally edit plain-text files, can be used to edit the file. When finished, be sure to save it back 
as plain text, not as a WordPad file nor in the format of Word nor any other word-processor 
program. 

The file consists of a set of "sections," each section corresponding to the first byte of the 
Unicode value being mapped or a set of special font names. 

In the first case, that is when mapping Unicode values, the section is headed by a line 
containing an asterisk and the initial byte value in hexadecimal, for example: 

*1e  

precedes the line(s) detailing the mappings for all Unicode values whose first byte has 
hexadecimal value 1e. 

In the second case, that is when mapping special single-byte font values, the section is headed 
by a line containing "*00:" and then a list of the font names that follow the same mapping. If 
there is more than one font name, they are separated by vertical bars (|), for example: 

http://www.unicode.org/
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*00: Afallon|Cwrwgl|Heledd|Padarn|Teifryn  

would head a section detailing mappings for certain Welsh fonts -- namely Afallon, Cwrwgl, 
Heledd, Padarn, and Teifryn. Note that the font name(s) must be spelled exactly as they appear 
in the system font list, including capitalization and any punctuation that is part of the name. 

Following the last section only, there should be a line containing just a single asterisk; this line 
marks the end of the file. 

CHARACTER MAPPING LINES 

Each line within a section gives the mapping for a single imported character. The mapping may 
yield one or several characters in DUSCI. 

In the case of Unicode characters, the line begins with the value of the second byte of the 
imported character, in hexadecimal, followed by a colon and a space. Recall that the value of 
the first byte is given by the header line for the current section. 

The mapped-to value or values then follow, either by giving the character(s) directly (if such 
characters are ASCII characters other than a vertical bar [|]) or by giving the code sequence 
expressed as three-digit decimal values each preceded by a vertical bar. 

In the case of special single-byte font characters, the line begins with the hexadecimal code 
value, a colon and a space. The mapped-to value(s) are then expressed in the same manner as 
for Unicode characters. Note that any unmapped characters are treated the same as if they 
were in the Windows standard (Latin-1) font, which corresponds to the first page (i.e. section 
"*00") of Unicode. That means it is necessary only to map those characters that are encoded 
differently from the standard font. 

Some examples of detail mapping lines follow: 

1. 1. In Unicode, hexadecimal value 00c7 corresponds to the Latin capital C with cedilla. That 
character in DUSCI is encoded as a single byte, decimal value 128. The appropriate mapping line 
is 
c7: |128 
within the "*00" section.  

2. In Unicode, hexadecimal value 00a3 corresponds to the British pound-sterling currency sign. 
That character in DUSCI is encoded as a two-byte sequence, decimal values 245 and 35 
respectively. The appropriate mapping line is 
a3: |245|035 
within the "*00" section.  

3. In Unicode, Greek capital gamma is encoded with hexadecimal value 0393. That character in 
DUSCI is a two-byte sequence, decimal values 226 and 67 respectively. The appropriate mapping 



line is 
93: |226|067 
within the "*03" section.  

4. In the Welsh "Afallon" font, small w with dieresis is encoded with hexadecimal value be. That 
character in DUSCI is a two-byte sequence, decimal values 185 and 53 respectively. The 
appropriate mapping line is 
be: |185|053 
within a "*00: ..." section listing the Afallon font (see example of heading line given above).  

5. In the Vietnamese "VNI-Times" font, the code value e4 is for a "combining" character including a 
circumflex accent and a dot below (tone mark). Those are two separate combining characters in 
DUSCI, each with two bytes -- decimal values 227 and 50 for the first, 227 and 83 for the second. 
The appropriate mapping line is 
e4: |227|050|227|083 
within a "*00: ..." section listing the VNI-Times font.  

Miscellaneous 

This section contains items which do not quite have a specific place, but which we felt were of 
possible interest to DBT users. Just for fun, we've included an item of Spelling Checkers. It might 
read correctly, and even spell check correctly, but is it correctly spelled? 

Braille-Build 

This program is installed with DBT to allow you to rebuild the TrueType Braille and SimBraille 
fonts. You would typically need to rebuild these fonts only if you wish to change the dot 
diameter of the braille font, usually for sign production, or if you have changed the 'display 
code' setting in the Global: Internationalization... dialog. 

You might also use Braille-Build in the production of tactile graphics using swell paper such as 
"Flexipaper" where a braille fonts has been used in the diagrams. Because of the nature of the 
process, braille dots of normal size "spread", and so it is necessary to reduce the diameter of 
the printer dot - but NOT the actual cell dimensions - prior to using the Tactile Image Enhancer 
or fuser. 

The following example shows a 22 point normal sized braille dot, and below it one that has 
been reduced to 50%. Notice that while the size of the dot has been reduced, the cell itself 
remains the same size. 

Dot Diameter: Enter a percentage value by which to reduce the dot from its normal size. (As a 
general rule, 80% is sufficient for Flexipaper.) 
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Spacing: This is a drop down selection box where you have a choice of California, Marburg 
Large, Marburg Medium or Normal. 

Code page: This is a drop down selection box where you have a choice of Code Pages available. 

Type: This is a drop down selection box giving you a choice of Braille or SimBraille font. Note in 
the following example that Simbraille contains shadow dots to indicate dots which as NOT 
normally raised. 

Use custom font name: Check box which, if selected, makes the following text box available 

Font name: If you wish, you may give your font an appropriate name. If you do not check this 
option, your font will be called either "Braille" or "Simbraille". 

Finally when you click on the Save button, you will be asked where to save the font. This will 
bring up the standard Windows Save As dialog.  

DO NOT save your font to the \windows\fonts folder. Save it to another folder, or to a floppy 
disk or CD. 

You may Install your font in the usual way appropriate to your operating system. 

DBT from the DOS Command Window 

A Command Line Interface is an older way of automating program output. A more modern way 
to automate program output is with an API (Application Program Interface). DBT has both a 
Command Line Interface and an API. 

DBT can be run at the Command Line. 

Here is an example: DBTW /braille:Romeo constitution.htm<Enter> 

Here is the syntax: 

Usage: Program Path 

[/help] 

[/print | /braille:Embosser Name | /simulate | /brf:<name> | /prf:<name>] 

[/Pagesize:<rows>x<columns>] 

[/Copies:nn] 

[/Template:<name>] 



[/wordstylemap:<name>] 

[/RemoveEmbosserInfo | /RemovePrinterInfo /RemovePageInfo] 

[/dumpstyles:<name>] 

[files] 

Some carriage returns to make this readable. The brackets indicate that this material is 
optional. The vertical bar (|) means you can choose between options (print output, braille 
output, simulated braille, braille file, or print file) 

Some options, such as RemovePageInfo have been added to help generate "generic 
documents" for wide distribution. Some of these options have been added to aid the process of 
writing the documentation to DBT. 

/RemoveEmbosserInfo -- Removes the embosser information embedded in the document(s), 
including all settings in Document, Embosser Setup. Saves the result(s) back in-place. Exits if no 
further processing is required. 

/RemovePrinterInfo -- Removes the ink printer information embedded in the document(s), 
including all settings in Document, Printer Setup. Saves the result(s) back in-place. Exits if no 
further processing is required. 

/RemovePageInfo -- Combines the effects of /RemoveEmbosserInfo and /RemovePrinterInfo. 
Note that it isn't actually possible to use the two separate switches together; /RemovePageInfo 
is *required* if you want strip both printer and embosser information from a document. 

/dumpstyles:<name> -- Writes the styles definitions for a document into the specified "dump" 
file. The behavior of the switch is undefined if more than one document file is specified after 
this switch. After this switch is processed, DBT will exit if there is no further processing to be 
done. 

/dumpstyles_xml:<name> -- This works just like /dumpstyles, except that the "dump" file is an 
XML format. 

Braille math made easy.  

DBT WIN prints advanced MATH TO BRAILLE!  

If you are doing mathematics, you will want to use Scientific Notebook (SN) and take advantage 
of Duxbury's LaTeX importer. Create and print your print or large print math. Save the file. Then 
open your Scientific Notebook LaTeX file and go to braille. Here are some examples of math 
equations followed by the associated Nemeth (American math) braille:  
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"SPATIAL MATH " is out of this world with DBT.  

In summary, you will create a blank print document and enter everything but your math. Then 
translate to braille and enter your math information directly utilizing the number pad!  

1. Ctrl + n to open a new print document  

2. Choose print document and press enter. You should now be in a blank print file.  

3. Alt + l (l as in Lima) to open the layout menu  

4. M to open the math code menu  

5. enter key, this will put you in "technical context". In English this means you are working 
on a Nemeth document.  

6. Type in all your text etc leaving some blank space for your math problems. When 
finished...  

7. CTRL+T to translate your print file into braille.  

8. Put your NUM LOCK on. Then use the number keys, space bar, and function keys to 
enter your math.  

Hint #1 you will want to use the "3" key to get your dot 2,5 lines  

Hint #2 if you go to VIEW and choose full page you get a better idea of the layout of the math 
on the full page while you are keying it in.  

Hint #3 you can use search and replace to replace multiplication and division signs with dot 
product, cross product, line between dots division sign as you please.  

Six-Key Entry (Customizing) 

This allows you to use six keys on your regular PC Keyboard, plus the space bar, to input braille 
directly to DBT. 

If necessary, you may change the keys used for six-key braille entry. 

You might for example wish to use the CXZ BNM keys instead of FDSJKL 

Note: the sequence above represents dots 321 456 - specifically in that order. 



The method for changing this has changed from 10.6 and above and is now done through the 
Global: View Preferences dialog 

SPELLING CHECKERS 

BEWARE OF SPELLING CHEQUERS. 

Ewe may think yore spell chequer has it rite but you should awl weighs be ware of miss steaks. 
Try copying this text into yore own won and sea what ewe find. 

The moral being that ewe should awl ways try to be care full with proof reading. 

Print To Moon Translation 

Functional Summary.  

The English Moon tables support print-to-Moon translation for three English literary grades 
(grade two, which is the default, grade one, and grade "one-half" [fully spelled]). 

What Is Moon? 

The following comes from the Moon Instruction Manual: 

Moon is a tactile medium which uses raised characters to represent normal print characters. 
There are two levels of Moon, which we call Grades One and Two. Grade Two is basically the 
same as Grade One, but with the addition of some abbreviations not found in Grade One—this 
is the only difference... 

Wherever possible, Moon follows print conventions with regard to punctuation and spacing 
between characters and words... 

Characters used in Moon... 

There are 26 Moon symbols which correspond to the 26 letters of the alphabet: 

How To Use DBT's Print To Moon Translation Facility. 

1. Begin a new print document, selecting either "English Moon) - basic" or "English Moon - basic no 
capitals" as the Template..  

2. Type text into your document as you normally would.  

3. Use the existing formatting styles and codes to format your Moon document.  

4. Use the special Moon codes to translate your document to Moon  
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5. Translate to moon by selecting "File: Translate" or pressing Ctrl + t.  

6. Although you have translated to Moon at this point, you will see braille on the screen. You may 
have better results by selecting "View: Print Font" from the menu or pressing Ctrl+F5.  

7. You may now emboss the Moon to an Enabling Technologies embosser set to Moon Mode (or 
equivalent).  

Vista and Windows 7 Issues 

November 2010: 

The following topics attempt to address some issues that have been found during our tests. 

Activation  

Adding Embossers  

Creating Templates  

Shared Printers  

Upgrading  

Please note that the requirement in some cases to "run as administrator" is one which is 
imposed by the operating system itself. 

 

Activation 

In order to activate DBT, it is almost always necessary to run DBT as administrator. 

To do this, right click on the DBT Desktop icon, or the DBT item in All Programs, and select "Run 
as administrator". You may be prompted with a dialog asking you to enter an appropriate 
Username and Password. 

NOTE: There is one exception to this in 11.1: if you check the box to run 11.1 as the installation 
wizard ends, it will now do the "run as administrator" for you. (If you have UAC enabled, you 
will still need to confirm and possibly supply login credentials to do this.) 

Adding Embossers 

Defining embossers "For all users of this computer" will require you to run as administrator. 
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If you attempt to define an embosser for all users, and are not an administrator, you will get an 
error message to that effect. 

Creating Templates 

Creation of new Templates will require you to "run as administrator" 

Device in Use 

If you are using a USB pen drive or other form of external storage you should always use the 
"Safely Remove Hardware and Eject Media" option in Windows. 

If you have been importing files into DBT containing MathType equations, it is possible that 
when you go to eject the media, you will get the following message that the device you wish to 
remove is currently in use, and are advised to close any programs that might be using this 
device, then try again. 

This is usually because although you may appear to have nothing else running, the MathType 
Server is still running. 

Locate the MathType Server icon in the System Tray, right click on it, and select "Exit". You 
should now be able to eject the media in the normal way. 

Shared Printers 

By default, Printer and File sharing is passworded.  

This can make sharing a printer (or embosser) a somewhat tedious process. 

Go to Vista's Network Control Center and turn off "Passworded Sharing". Bear in mind the 
possible security issues here. 

Upgrading 

It is recommended that you remove DBT (See Remove DBT) before upgrading your operating 
system to avoid possible re-activation issues. 

This is not always necessary, but is nevertheless advisable. 
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End User License Agreement (EULA) 

IMPORTANT Read this carefully before using this product. This End-User License Agreement 
("EULA") is a legal agreement between you (either an individual or a single organization) and 
Duxbury Systems, Inc. ("Duxbury") for the Duxbury software program that accompanies this 
EULA ("Software"), which includes any associated media such as CDs and documentation. An 
amendment or addendum to this EULA may accompany the Software. You agree to be bound 
by all terms of this EULA by installing, copying, or using the Software. If you do not agree, do 
not install, copy, or use the Software; you may return it to your place of purchase for a full 
refund within ninety (90) days of purchase. 

Ownership of the Software 

1. The Software is owned by Duxbury and is protected by United States copyright laws, by laws 
of other nations, and by international treaties. Duxbury retains ownership and all rights not 
expressly granted to you by this EULA. The software may include materials developed by third 
parties, which retain the copyright on those materials. 

Grant of License 

2. Duxbury grants to you the right to install and use the Software according to the class of 
license, as follows: 

2a. Single-user license Duxbury grants to you the right for one natural person, on one 
computer, to use the Software at any one time. You may install the Software on up to two (2) 
computers, and at different times different people may use the Software, but at any one time 
only one natural person may be using the Software, on one computer. If any computer on 
which the software is installed is connected to the Internet or any other network that permits 
any form of automatic access to the Software’s functions, it must not be configured so as to 
allow such access by the general public or in any event by more than five (5) distinct natural 
persons, in total, during any 24-hour period. 

2b. Multiple-user (organizational) license Duxbury grants to you, the licensee organization, the 
right for the designated number of natural persons to use the Software at any one time. Such 
use must be substantially for the purposes of your organization. You may install the Software 
on multiple computers, but only up to the designated number of users; in no event may the 
Software be in use by more than the designated number of natural persons, nor on more than 
that same number of computers, at any one time. If any computer on which the software is 
installed is connected to the Internet or any other network that permits any form of automatic 
access to the Software’s functions, it must not be configured so as to allow such access by the 
general public or in any event by more than twice the designated number of distinct natural 
persons, in total, during any 24-hour period. 

Restrictions on Use and Transfer 



3. You may not copy the Software or any part, except for the installations within the grant of 
license, except for one (1) additional copy solely for backup or archival purposes, and except for 
specific third-party materials which may be copied and distributed as specified above and 
additionally more broadly if the author’s terms are followed. A list of these third-party 
materials, with the authors’ copyright statements and specific copying permissions is provided 
in the file Copying.chm, which can be viewed after installation.  

4. You may permanently transfer the license to use the Software and accompanying materials 
(including the most recent update and all prior versions) if you retain no copies and the 
transferee agrees to be bound by this EULA. Such a transfer terminates your license. You may 
not rent or lease the Software or otherwise transfer or assign the right to use the Software. You 
must notify Duxbury in writing of the transfer and identify the transferee, who must also accept 
this EULA. If any of these requirements are not met then the transfer shall be deemed null and 
void. 

5. You may not reverse engineer, decompile, or disassemble the Software. 

6. Mandatory registration and activation: There are technological measures in the Software 
that are designed to assist both Duxbury and you to keep usage of the Software within the 
terms of this EULA. You may not be able to exercise your usage rights after a certain period of 
time unless you register and activate your copy of the software in the manner described during 
the launch sequence. You may also need to reactivate the software if you modify your 
computer hardware or move the software to another computer. Duxbury and its successors will 
use registration and activation data only in the normal course of business with you directly or 
through dealers, and will not disclose such data to other parties except as required by courts or 
agencies of law enforcement. 

7. This EULA applies to updates, supplements, or additional components or services of the 
Software that Duxbury may provide to you or make available to you after you obtain your initial 
copy of the Software, unless they are accompanied by separate terms. 

8. To use Software identified as an upgrade, you must first be licensed for the software 
identified by Duxbury as eligible for the upgrade. After installing the upgrade, you may no 
longer use the original software that formed the basis for your upgrade eligibility, except as 
part of the upgraded software. 

Limited Warranty 

9. Duxbury warrants that the Software will perform substantially in accordance with the 
accompanying documentation for a period of 90 days from the date of your receipt of the 
Software. Any implied warranties on the Software are limited to 90 days. Some jurisdictions do 
not allow limitations on duration of an implied warranty, so the above limitation may not apply 
to you. 



10. Duxbury disclaims all other warranties, either express or implied, including but not limited 
to implied warranties of merchantability, fitness for a particular purpose, and non-
infringement, with respect to the software and the accompanying written materials. This 
limited warranty gives you specific legal rights. You may have others, which vary from 
jurisdiction to jurisdiction. 

11. Duxbury's entire liability and your exclusive remedy shall be, at Duxbury's choice, either (a) 
return of the price paid or (b) replacement of the Software. Any replacement Software will be 
warranted for the remainder of the original warranty period or 30 days, whichever is longer. 

12. This Limited Warranty is void if failure of the Software has resulted from modification, 
accident, abuse, or misapplication. 

13. Conversion between print and braille is not an exact science in most circumstances, and all 
software is likely to contain faults despite careful preparation. You therefore understand that 
the output of a fully automatic conversion cannot be assumed to be correct, and that it is your 
responsibility to undertake whatever measures, such as proofreading by a qualified person, 
that may be appropriate to assure the quality of output that is necessary in a given situation. In 
no event will Duxbury be liable to you for damages, including any loss of profits, lost savings, or 
other incidental or consequential damages arising out of your use or inability to use the 
software. Because some jurisdictions do not allow the exclusion or limitation of liability for 
consequential or incidental damages, the above limitation may not apply to you. 

14. Third-party material is included with additional restrictions of warranty and damage claims 
against the original authors and contributors other than Duxbury Systems, Inc. The file 
Copying.chm, which is installed with the Software, explains which of the following two 
restrictions applies to each piece of third-party material: 

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS 
[INCLUDING DANIEL VEILLARD] BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

And: 

THIS SOFTWARE IS PROVIDED “AS IS” AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. THE AUTHORS AND CONTRIBUTORS ACCEPT NO 
RESPONSIBILITY IN ANY CONCEIVABLE MANNER. 

Other Terms 



15. This Agreement is governed by the laws of the Commonwealth of Massachusetts, USA. 
Venue for any disputes arising out of this agreement shall be the courts of said Commonwealth 
of Massachusetts. 

16. This EULA (including any addendum or amendment to this EULA included with the Software) 
is the entire agreement between you and Duxbury relating to the Software. If any provision of 
this EULA is held to be void, invalid, unenforceable or illegal, the other provisions shall continue 
in full force and effect. 

17. If you have any questions concerning this Agreement or wish to contact Duxbury for any 
reason, please write Duxbury Systems, Inc., 270 Littleton Road, Unit 6, Westford, MA 01886 
USA or call 1-978-692-3000. 

18. U.S. Government Restricted Rights The Software and documentation are provided with 
Restricted Rights. Use, duplication, or disclosure by the Government is subject to restrictions 
set forth in subparagraph (c)(1) of The Rights in Technical Data and Computer Software clause 
at DFARS 252.227-7013 or subparagraphs (c)(1)(ii) and (2) of Commercial Computer Software - 
Restricted Rights at 48 CFR 52.227-19, as applicable. Supplier is Duxbury Systems, Inc., 270 
Littleton Road, Unit 6, Westford, MA 01886. 

19. The authors and contributors of third-party materials included in the Software have in cases 
disallowed that Duxbury Systems, Inc., and you in turn, should use their names in advertising 
and promotions. Restrictions apropos to each third-party component are described within the 
Copying.chm, which is installed with the Software. You must review the restrictions within 
Copying.chm before using the name of an author or contributor of third-party material included 
with this Software in materials intended for advertising this Software or for promoting the sale, 
use, or other dealings with it. 

20. The parties hereto confirm their express wish that this contract, as well as all other 
documents related hereto, including notices, be drawn up in the English language only and 
declare themselves satisfied therewith. Les parties aux présentes confirment leur volonté 
expresse de voir la présente convention de même que tous les documents, y compris tous avis, 
si rattachant rédigés en langue anglaise seulement et s'en déclarent satisfaits. 

 

 

 

 

 




